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 Introduction

Data Editor is a key component of the Fujitsu NetCOBOL Data File Tool Set.  Data Editor lets you create, update and browse data files, viewing them
 as they appear to your COBOL programs. Data Editor is fast, intuitive and friendly, helping you make your updates with a minimal effort.

 Because Data Editor lets you see the data using the same structure as your COBOL programs, it is easy to set values to test particular conditions in
 your programs.  Data Editor is therefore an important part of any testing process.

Export Regulation

Exportation/release of this document may require necessary procedures in accordance with the regulations of your resident country and/or US export
 control laws.

Trademarks

Trademarks and registered trademarks used in this online manual are:
- NetCOBOL is a trademark or registered trademark of Fujitsu Limited or its subsidiaries in the U.S.A. and other countries or in both.

- Microsoft, Windows, Windows Server, Visual C++, and Visual Basic are the registered trademarks of Microsoft Corporation in the U.S.A. and
 other countries.

- Other company names and product names are the trademarks or registered trademarks of the respective companies.

 Abbreviations

In this online manual, each product is abbreviated as follows.

Microsoft Windows - All releases >> "Windows"

Copyright 1994-2015 FUJITSU LIMITED



Purpose and Benefits

Testing is a key part of system development to ensure software quality and reliability. Major parts of the testing process are the creation of test data and
 the analysis of output data files. The purpose of the Data Editor is to provide prompt and accurate support for both test data creation and the analysis of
 test results.

Benefits

 - Greater efficiency in creating test data.
 - Greater efficiency in verifying test results.



Data Editor Design

Data Editor is designed with field-sensitive screen displays and an easy to use user interface.

Field Sensitive Screen Displays

Data Editor uses COBOL record descriptions to display data field-by-field, in formats that correspond to the COBOL item definitions.  This makes it
 easy to recognize the contents of each record, to enter new values, and to confirm existing values.

Easy-to-use User Interface

Data Editor lets you view the data in two ways: a Record Format View, which displays each item of a single record on separate lines, and a Table Format
 View, which displays each record on a single line. Within these views, you can select which items are displayed. You can focus on the data that is
 important to you and examine and update test data quickly and easily.



Detailed Features

The following files formats can be manipulated by Data Editor:

File Types and Organization Available Operations

Sequential files conforming to standard
 COBOL specifications

Create, Add, Update, View

Line Sequential files conforming to standard
 COBOL specifications

Create, Add, Update, View

Indexed files conforming to standard
 COBOL specifications

Create, Add, Update, View

Relative files conforming to standard
 COBOL specifications

Create, Add, Update, View

General files (sequential files and fixed files) Create, Add, Update, View

Major Functions

This section describes the main functions used to manage data files in Windows.

Analyzing Record Formats from COBOL Definitions, FILE Definition Statements, and Layout Definition Files

You can analyze record formats from COBOL data defintions or from the Layout Definition File (a file created and used by the NetCOBOL Data Tools). 
 This function saves the user from having to make definitions using control statements, record definition statements, etc.

Automatically Saving File-Related Information

You can automatically save information on files such as the COBOL definitions or the Layout Definition File, and the items selected to be displayed. 
 The information does not need to  be input again for a file that has been edited or viewed at least once.

Selectively Extracting Data

When an existing file is opened, you can select the records to be edited using one of the following three options:
  All Records
  All records are available for editing.
  Selected Range
  A range of records is available to be edited using the physical order of the records (e.g. records 20 through 30).
  Data Condition
  A subset of records is available for editing, selected by tests based on data item values.

Support for Various Character Sets

Data Editor supports the display/edit/print of data in the following character code systems:

 Supported code
 systems:

ASCII Data

EBCDIC Data

Unicode Data

Data Edit Screen Views

The user can switch to either of the following data editing views:
  Record Format View
  Allows the user to view and edit records and update selected data items.  Also allows the user to insert, add, copy, or delete a record.
  Table Format View
  Allows the user to view multiple records in a table format view and update selected data items.

Select Items Function

The user can select a data item to be edited, or the user can switch the COPY clause record format.  One of the following four functions can be set:
 Switching Record Formats
 If a COPY clause file contains multiple data items at the 01 level, the user can switch between formats.
 OCCURS Clause Expansion
 If a record selected by switching record formats contains an OCCURS clause, the data item can be expanded to as many pieces as there are arrays before
 they are displayed or updated.
 Select Items
 Allows the user to select the items to be edited (or verified) from the list of data items contained in the selected record, and to specify group items.
 Switching to the Redefinition Attribute
 Allows the user to switch an item that specifies REDFINES to the redefining data attribute.



Hexadecimal Edit

Allows the user to view and edit data using hexadecimals, and to view and input data according to the specified data attribute.

Save to New Data File

Allows the user to save a data file being edited (extracted) to another file. The record type and file organization of a new file will be the same as the
 source file.

Data Converter Linkage Function

If Data Converter is installed, the user can convert data being edited into CSV, XML, or another code/file organization data file and output it. The user
 can also import either CSV or XML format files and display them in the edit view.

Test Data Generation Function

Test data can be generated automatically by specifying data generation conditions for each data item.  The following data generation options are
 supported:
   Insert/Append
   Insert or append automatically generated data records.
   Copy
   Replicate the current record with the option to modify current values with automatically generated data.
   Replace
   Replace the value of a specific data item throughout a range of records with automatically generated data.

Print Function

Allows the user to print data being edited as shown in the table format view, and print data together with a header or footer or hexadecimal value of data,
 etc. This function also allows you to check the print image in a preview screen.

Search Function

The following search functions are provided:
   Searching for Data
   Allows the user to find a specific character or numeric data in one item, or find data using hexadecimals.
   Searching for an Item
   Allows the user to specify an item name so that it will be displayed at the top of the edit screen.  This function is very useful when many items are
 involved.

Replace Function

Allows the user to replace data that matches specified character-strings or hexadecimal data.

Drag and Drop Function

The user may indicate the data file to be manipulated by dragging and dropping the data file into the Data Editor Initial View.

Execution by Specifying a File Name

Allows the user to activate the Data Editor by specifying a data file name from the command line.
 For example, activating Data Editor from the DOS prompt:
 C:\Program Files\Fujitsu NetCOBOL for Windows\Datatools\DataEdit.exe ..\Samples\DataTools\Data1.dat

Backup Function

Allows the user to save a backup copy of a data file to another folder prior to editing it.

Binary Access

Allows the user to access sequential and fixed length files other than COBOL files. This function is available even if COBOL is not installed.



File Menu

The File menu commands are explained below:

New Data File

   Creates a new data file.

     Enabled in: Initial View

Open Data File

    Work with an existing data file or specify a new data file.

     Enabled in: Initial View

Save as Data File

   Displays the Save As dialog so that you can specify a file name. The data is saved to the data file when the Save button in the dialog box is clicked.

     Enabled in: Record Format View, Table Format View

Save and Close Data File

   Displays a dialog box confirming the number of updates, additions, and deletions made to the file. Clicking OK in this dialog saves your changes,
 closes the file, and returns you to the Data Editor Initial View.

     Enabled in: Record Format View, Table Format View

Close Data File

   If no updates have been made, the file is closed and you are returned to the Data Editor Initial View.
    If updates have been made, a message box is displayed asking you to confirm that you do not want to save the updates.

     Enabled in: Record Format View, Table Format View

Setup Print Page

   Allows you to set various options for printing.

     Enabled in: Record Format View, Table Format View

Preview

   Allows you to check the print image on screen.

     Enabled in: Record Format View, Table Format View

Print

   Prints the data being edited as shown in the Table Format View.

     Enabled in: Record Format View, Table Format View

File List

   Lists the names of the last five data files opened in Data Editor.

     Enabled in: Initial View

Exit

   Exits Data Editor. If updates have been made, a message box is displayed asking you to confirm that you do not want to save the updates.

     Enabled in: Initial View, Record Format View, Table Format View



Record Menu

The Record menu commands are explained below:

Undo

   Undoes updates to the current record. Undo can only be used while the edited record is displayed. Once you move to another record, you can no longer
 undo the updates.

     Enabled in: Record Format View

Insert

   Displays a dialog allowing you to specify the number of records to be inserted in front of the currently displayed record. You can insert records whose
 values were set previously using the automatic generation function.

     Enabled in: Record Format View of sequential/line sequential file operation

Append

   Displays a dialog allowing you to specify the number of records to be added at the end of the file. You can append records whose values were set
 previously using the automatic generation function.

     Enabled in: Record Format View of sequential/line sequential file operation

Add

   Add one record. After the key or relative record number is input, the record is placed in the appropriate position in the file.

     Enabled in: Record format screen of index/relative organization file operation

Copy

For Sequential and Line Sequential Files

    Allows you to specify the number of copies to be made of the current record, and the location in the file at which to insert those copies. If you enter
 zero as the copy location, the copies are added at the end of the file. You can copy records whose  
    values were set previously using the automatic generation function.

For Indexed and Relative Files

    Makes one copy of the current record. After the key or relative record number is input, the record is placed in the appropriate position in the file.

     Enabled in: Record Format View

Delete

   Marks the current record for deletion.  Records marked for deletion can be retrieved using the Restore function.

     Enabled in: Record Format View

Restore

   Restores the current record marked for deletion.  Only one record can be restored at a time.

     Enabled in: Record Format View



Edit Menu

 The commands in the Edit menu are as follows:

Hexadecimal Edit

    Edit the data item in hexadecimal format. The data item at the current cursor position is displayed for editing.

     Enabled in the Record Format View and the Table Format View.

Unicode Edit

   Edit the data item using Unicode.  Unicode characters can be displayed and input if the Unicode font set is installed and specified.

    Enabled in the Record Format View, and Table Format View if the character code of the data file is Unicode.

Generate Item Values

   Update the specified data item with a generated value using the data generation function.

    Enabled in the Record Format View and the Table Format View.



Locate Menu

The Locate menu commands are explained below:

Previous Record

   Displays the record before the current record.

     Enabled in: Record Format View

Next Record

   Displays the record after the current record.

     Enabled in: Record Format View

Record Number

    Allows you to enter the number of the record to be displayed.

     Enabled in: Record Format View

First Record

   Displays the first record.

     Enabled in: Record Format View

Last Record

   Displays the last record.

     Enabled in: Record Format View

Search

   Finds data matching a character string or numeric value among specific items.

     Enabled in: Table Format View

Search for Hexadecimal Data

   Finds data matching the specified hexadecimal number.

     Enabled in: Table Format View

Previous

   Searches data before the cursor position. This command searches for the value specified in the Search function or the Search for Hexadecimal Data
 function, but does not search the current cursor data.

     Enabled in: Table Format View

Next

   Searches data after the cursor position. This command searches for the value specified in the Search function or the Search for Hexadecimal Data
 function, but does not search the current cursor data.

     Enabled in: Table Format View

Search for Item Name

   Moves the cursor to the first record of the selected item name.

     Enabled in: Table Format View

Replace

   Compares data values in the Search Item Name to the Search character string, and replaces matching values with the replacement string.

     Enabled in: Table Format View



Hexadecimal Data Replacement

   Searches the specified item, and replaces hexadecimal data that matches the Search Hexadecimal Data entry with the replacement hexadecimal data.

     Enabled in: Table Format View



View Menu

The View menu commands are explained below:

Table Format

   Switches the view of the data from Record format to Table format. When there are more records than can be displayed on the screen, Data Editor
 displays the current record at the top of the window.

     Enabled in: Record Format View

Record Format

   Switches the view of the data from Table format to Record format. Data Editor displays the record that had been selected in the Table Format View.

     Enabled in: Table Format View

Font

  Displays the font configuration dialog box. Data Editor uses the selected font for the data and item information in the main window.

     Enabled in: Initial View, Record Format View, Table Format View

Screen Format

   Displays a sub-menu of screen elements that you can switch off or on. Click on the element to switch its display on or off. A check mark by the element
 indicates that it is being displayed. The switchable elements are:
       - Level Number
       - Description
       - Offset
       - Toolbar
       - Status Bar
       - Hexadecimal Edit bar

     Enabled in: Initial View (Toolbar, Status Bar), Record Format View, Table Format View (Level number is excluded)

Select Items

  Displays a dialog to select which data items are displayed and edited. The following display selections are available:
       - Which record format to use
       - Whether OCCURS items are expanded or collapsed
       - Which items to display
       - Which descriptions to use when there are REDEFINE alternatives.

     Enabled in: Record Format View

Key Information

   Displays record key information. This command can be selected only for an indexed file.

     Enabled in: Record Format View, Table Format View



Options Menu

The Options menu commands are explained below:

Environment Setup

   Displays the Environment Setup dialog for configuring the Data Editor environment. The items you can configure are:
     - Default folders for saving the data files and for storing work files.
     - Work environment options such as the characters inserted for null data, the default edit mode, and the display of a message on Add and Copy
 functions.
     - Whether to create backups
     - Options for Data Editor COBOL source analysis
     - Code conversion options
     - Display options for the maximum width of table items and whether to suppress leading zeros.

     Enabled in: Initial View

Link to Data Converter

- Import
     CSV format and XML format files can be imported using Data Converter.
 - Export
     Data can be exported in CSV, XML, or Data File Format, or another code/file organization.

     Enabled in: Record Format View, Table Format View



Help Menu

The Help menu commands are as follows:

Data Editor Help

   Displays the Online Manual contents.

     Enabled in: Initial View, Record Format View, Table Format View

About Data Editor

   Displays the Data Editor version number and copyright information.

     Enabled in: Initial View, Record Format View, Table Format View



Overview of Using the Data Editor

The following steps provide an overview of how to edit files using the Data Editor.

1. Start Data Editor
    Starting the Data Editor

   Click the Data Editor icon.

2. Set up the Environment
    Configuring the Data Editor Environment

   Set up the Data Editor environment.

3. Specify the Data File

    Enter a new file name, select an existing data file, or select from a list of recently opened files.

4. Select/Setup the Data File Details
    Selecting and Setting Up Data Files

   Set up or update the edit mode, format information, data file information, extraction, etc. corresponding to the data file specified in step (3).

5. Edit/View the Data

   Use Record Format View or Table Format View to view or edit the data. The following functions are accessed on this screen:

 - Save and Close Data File
 - Print Data
 - Insert/Add/Copy/Delete Record (Record Format View only)
 - Hexadecimal Edit
 - Generate item values
 - Search/Search for Hexadecimal Data/Search item name (Table Format View only)
 - Replace/Replace Hexadecimal Data (Table Format View only)
 - Screen Format Switch
 - Display by Item Select/Select of edit data item (Record Format View only)
 - Import/Export of data by Linking to Data Converter

6. Save or Discard the Data

   Use Record Format View or Table Format View to exit with or without saving the changes made in your edit session.

7. Exit from Data Editor

   Exit from Data Editor. You can exit from the Record Format View or the Table Format View.



Starting and Exiting the Data Editor

  To start or exit the Data Editor:

Start by double-clicking a data file

   You can start by double-clicking a data file in Windows Explorer if you have associated Data Editor to the data file type beforehand using the Tools >
 Folder Options > File Types dialog box.

Exit

  To exit Data Editor, select Exit from the File menu.  If data has been changed, a message is displayed asking whether to save the changes.
   Data Editor can also be exited as follows:

Mouse  Click the close icon X in the upper right corner of the Data Editor window.

Keyboard  Press Alt + F4



Configuring the Data Editor Environment

  To configure the Data Editor environment:

Set Procedure

1. Select Environment Setup from the Options menu.
 2. The Environment Setup property sheet is displayed.
 3. Specify the desired options in the Environment Setup property sheet.
 4. Click OK.

Environment Setup Properties

   You can configure the following Data Editor environment items:

       - Folders

       - Work Environment

       - Backup

       - COBOL Library Analysis Method

       - Code Conversion

       - Display Format



Selecting and Setting Up Data Files

When you open a data file, you need to specify the edit mode, data format information, file structure information, and the extraction
 conditions. Instructions for using the Select Data File and Data File Setup dialogs are provided in the following topics:

       - For data files used with Data Editor for the first time

       - For data files previously used with Data Editor



Creating New Files

To create a new file:

1. From the File menu select New Data File.  The Open dialog box is displayed.

2. Enter the name of the file to be created.  Click OK to display the Data File Setup dialog box. Note: If the name of an existing data file is entered, the
 Select Data File dialog box is displayed. Click the Data File Setup button only if a setting needs to be changed. Otherwise, go to step 4.

3. Click on Analyze Library to specify and process the COBOL record description. Enter any other required File Information and click OK. Data Editor
 displays the Select Data File dialog box.

4. Leave the default selection Add in the Select Data File dialog box and click OK.

5. Data Editor displays the Record Format View. Add the first record, and then use the Record Menu to add more records.

6. Save your changes by selecting Save and Close Data File from the File menu.



 Updating/Adding/Deleting Existing Files

To update/add/delete an existing file:

1. In the Initial View, select Open Data File from the File menu. Data Editor displays the Open dialog box.

2. Enter the name of the data file to be updated, added, or deleted, and click OK. The Select Data File dialog box is displayed. If this is the first time the
  data file has been opened in Data Editor, the Data File Setup dialog box is displayed. After the data file information is entered in this dialog box, click
 OK to go to the Select Data File dialog box.

3. Select Update in Data File Edit Mode, and click OK. If you are not authorized to edit the data file, the Update and Add edit modes are disabled, and the
 View mode is automatically selected.

4. The Record Format View is displayed.

5. When all edits of data are completed, select Save and Close Data File from the File menu to save the edited data.



Adding Records to Existing Files

To add records to an existing file:

1. In the Initial View, select Open Data File from the File menu. Data Editor displays the Open dialog box.

2. Enter the name of the  data file and click OK. The Select Data File dialog box is displayed. If this is the first time the data file has been opened in Data
 Editor, the Data File Setup  dialog box is displayed. After the data file information is entered in this dialog box, click OK to go to the Select Data File
 dialog box.

3. Select Add in Data File Edit Mode, and click OK. If you are not authorized to edit the data file, the Update and Add edit modes are disabled, and the
 View mode is automatically selected.

4. The Record Format View is displayed. Add the first record, and then use the Record Menu to add more records.

5. Save your changes by selecting Save and Close Data File from the File menu.



Browsing Existing Files

To browse records in an existing file:

1. In the Initial View, select Open Data File from the File menu. The Data Editor Open dialog box is displayed.

2. Enter the name of the  data file and click OK. The Select Data File dialog box is displayed. If this is the first time the data file has been opened in Data
 Editor, the Data File Setup dialog box is displayed. After the data file information is entered in this dialog box, click OK to go to the Select Data File
 dialog box.

3. Select View in Data File Edit Mode, and click OK. If you are not authorized to edit the data file, the Update and Add edit modes are disabled, and the
 View mode is automatically selected.

4. The Table Format View is displayed, where the data can be viewed.

5. To return to the Initial View, select Close Data File from the File Menu.



Printing a Data File

 To print a data file:

1. In the Initial View, select Open Data File from the File menu. The Open dialog box is displayed.

2. Enter the name of a Data File to be printed and click OK. The Select Data File dialog box is displayed. If this is the first time the data file has been
 opened in Data Editor, the Data File Setup  dialog box is displayed. After the data file information is entered in this dialog box, click OK to go to the
 Select Data File dialog box.

3. Select Update or View in Edit mode of the data file, and click OK. If you are not authorized to edit the data file, the Update and Add edit modes are
 disabled, and the View mode is automatically selected.

4. The Record Format View is displayed if Update was selected. The Table Format View is displayed if View was selected.

5. From the File menu, select Setup Print Page. Change settings as required, and then click OK.

6. To check the print image on the screen, select Preview. Click the Close button in the tool bar to exit the preview screen.

7. From the File menu, select Print to displaye the Print dialog box. Set the printer, print range, and number of copies, and then click OK.

8. The printer prints the data.



Editing Files as Binary Data

 You can use the editor to access files that do not have a COBOL structure, or for which you do not have the COBOL record descriptions. The function
 treats the files as if they were sequential, fixed length format files.

 This function can be used in environments in which COBOL is not installed.

Setup Procedure

The setup procedure is as follows.

 1. Select Options from the menu bar, and select Environment Setup from the pull down menu. 
  2. The Environmental Setup property sheet is displayed.
  3. Set Binary Access as the Access Method in the Work Environment tab.
  4. Click the OK button.

Operational Procedure

 Other functions operate the same as they do in COBOL data files.



Record Format View - Overview

The contents of each record are displayed, one item per line, and records can be added, updated, or deleted in this view. Record Format is the default
 view for the Add and Update modes.

Operation possible by Record Format View

   Record Format - Supported Functions

   Key operation explanation (Record Format View)

Screen Image

Status (below Toolbar)

    Indicates the status of the displayed record as follows:

Status Explanation

blank   When no changes have been made to an existing record, the status is blank.

 Update   Displays when the record has been modified.

 Insert   Displays when the record has been inserted.

 Add   Displays when the record has been added.

 Delete   Displays when the record has been deleted.

Record Length (below Toolbar)

   Displays the length of the selected record. When a variable-length data file is selected, records can be added to it.

Record Number (below Toolbar)

   Displays the number of the selected record and the total number of records in the file.

Hexadecimal Edit (below Toolbar)



   The hexadecimal representation of data can be edited. The number of bytes in the selected data item and the byte position of the cursor are also
 displayed.
    Note: When the Data Editor is initially started, the Hexadecimal Edit field does not display. To display it, select Screen Format from the View menu
 and enable Hexadecimal Edit bar.

Level No

   Displays the level number of each data item in the COBOL library file or Layout Definition File in hierarchical order. When the items to be displayed
 are selected using the Select Items dialog, the level numbers displayed reflect the original hierarchy. 
   They do not show the relationship between items if they are not actually related in the record definition.

Item Name

   Displays the names of the data items as defined in the COBOL library file or Layout Definition File.

Description

   Displays the attribute of each data item defined in COBOL library file or Layout Definition File in simplified form. See  Data Descriptions Formats

Offset

   Displays the offsets of the items from the beginning of the record in COBOL library file or Layout Definition File.

Data

   Displays the data contents of each item. Data in this field can be  edited. The following items can be displayed:
- Numeric Items and Display Formats
- Alphanumeric Items and Display Formats
- Floating-point Items and Display Formats
- Boolean Items and Display Formats
- Character Code Conversions



Editing Data Items (Record Format View)

 To edit data in the Record Format View: 

1. Display the record to be changed by selecting any of the following from the Search menu: Previous Record, Next Record, Record Number, First
 Record, or Last Record; or by clicking on the corresponding tool button.

2. Click on the data item to be changed. The Tab key, Shift + Tab key, and Enter key can also be used to select a data item.

3. If a data item is changed and another data item is selected, the changes to the first data item are saved.  Changes are also saved if another menu item is
 selected. Changes can be discarded by pressing the Esc key before leaving the field or selecting another menu item.



Editing Hexadecimal (Record Format View)

 To edit hexadecimal data:

1. Display the record to be changed by selecting any of the following from the Search menu: Previous Record, Next Record, Record Number, First
 Record, or Last Record; or by clicking on the corresponding tool button.

2. Click on the data item to be changed. The Tab key, Shift + Tab key, and Enter key can also be used to select a data item.

3. Select Hexadecimal Edit from the Edit menu, or right-click anywhere in the Data area and select Hexadecimal Edit from the pop-up menu. The cursor
 moves to the Hexadecimal Edit field.

  Note: When the Data Editor is initially started, the Hexadecimal Edit field does not display. To display it, select Screen Format from the View menu and
 enable Hexadecimal Edit bar, or click on the View/Hide hexadecimal edit bar tool button.

4. Edit data in the Hexadecimal Edit field, and press the Enter key to save your changes. The data in the Record Format View is displayed in ASCII code.
 You can discard changes by pressing the Esc key before moving the cursor to another field.

Note:  Input only those code values that are appropriate to the selected code system. See the Precautions for Display and Operations.



Editing Unicode (Record Format View)

 To edit Unicode in the Record Format View:

1. Display the record to be edited by using: Record Number, First Record, Previous Record, Next Record, or Final Record in the Locate menu, or by
 using the corresponding toolbar button.

2. Select the data item you wish to edit.  You can use the keyboard to select the content of the data item to be edited by using the Tab key, Shift + Tab
 key, or Enter key.

3. Select the Unicode Edit command from the Edit Menu. The Unicode Edit dialog box is displayed.  This command can also be executed from the
 context menu displayed by right-clicking the mouse.

4. Modify data using Unicode numeric codes. Save changes pressing the Enter key after all changes are completed.   Click the Select Font button to
 change the display font in the Select Font dialog box.  Data is displayed in ASCII in the Record Format View.  The dialog box can be closed without
 saving changes by pressing the Esc key.

Only numeric codes appropriate to the target code system should be input.

Note:  See the Precautions for Display and Operations.



Undo Changes (Record Format View)

 To undo a change in the Record Format View: 

1. Select Undo from the Record menu, or click the Undo button in the toolbar.

2. The data is restored to its former state.

Note:  See the Precautions for Display and Operations.



Inserting, Adding Records (with null data) (Record Format View)

 To insert or add records with null data in the Record Format View:

1. Select a record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or by
 clicking on the corresponding tool button.

2. From the Record menu, select Insert (sequential/line sequential), Append (sequential/line sequential), or Add (index/relative organization). You can
 also use the Append tool button.

For Sequential/Line sequential organization, the Record dialog box is displayed.

2-1. Specify the record number where the record is to be inserted or added.

2-2. Leave Generate item values unchecked.

2-3. Click OK.

3. The contents of the first added record(s) are displayed, and can be modified.

Note:  In the Update Mode, the record added using Append (sequential/line sequential) is always added at the end of an existing record.



Inserting, Adding Records (Generating Data Automatically) (Sequential/Line Sequential) 
 (Record Format View)

 To insert or add records with automatically generated data in the Record Format View: 

1. Select a record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or by
 clicking on the corresponding tool button.

2. From the Record menu, select Insert or Append. You can also click the Append tool button. The Record dialog box is displayed.

2-1. Specify the record number where the record is to be inserted or added.

2-2. Check the Generate item values checkbox and click the Details button.

2-3. The Data Generation dialog box is displayed. Specify the generation method of each item, and click OK.

2-4. The Record dialog box is displayed. Click OK.

3. The contents of the first added record(s) are displayed and can be modified.



Copying Records (Normal) (Record Format View)

 To copy records in the Record Format View:

1. Select a record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or by
 clicking on the corresponding tool button.

2. Select Copy from the Record menu; or click on the Copy Record tool button.

For Sequential/Line sequential organization, the Copy Current Record dialog box is displayed.

2-1. Specify the position where the copy record is to be inserted.

2-2. Specify the number of records to copy.

2-3. Leave the Generate item values checkbox unchecked.

2-4. Click OK.

3. The contents of the first added record(s) are displayed and can be modified.



Copying Records (With automatic data generation) (Sequential/Line Sequential) (Record Format View)

 To copy records using automatically generated data in the Record Format View:

1. Select a record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or by
 clicking on the corresponding tool button.

2. Select Copy from the Record menu; or click on the Copy Record tool button. The Copy Current Record (Sequential/Line sequential) dialog box is
 displayed.

2-1. Specify the position where the copy record is to be inserted.

2-2. Specifies the number of records to copy.

2-3. Check the Generate item values checkbox and click the Detail button.

2-4. The Data Generation dialog box, is displayed. Specify the generation method of each item, and click OK.

2-5. The Copy Record dialog box is displayed. Click OK.

3. The contents of the first added record(s) are displayed and can be modified.



Deleting Records (Record Format View)

 To delete records in the Record View Format:

1. Select the record to be deleted (or the first record to be deleted, if multiple records are to be deleted) using any of the following from the Locate menu:
 Previous Record, Next Record, Record Number, First Record, or Last Record; or by clicking on the corresponding tool button.

2. Select Delete from the Record menu; or click on the Delete Record tool button. 
     For sequential/line sequential organization, the Record dialog box is displayed.

2-1. Specify the number of the record to be deleted.

2-2. Click OK.

3. The deleted record is selected, but can no longer be modified. It is displayed in the Record Format View until the data file is updated.



Restoring Deleted Records (Record Format View)

 To restore deleted records in the Record Format View:

1. Select the record to be restored using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or
 Last Record; or by clicking on the corresponding tool button.

2. Select Restore from the Record Menu. The deleted record is restored.



Replacing Data in One Item with Automatically Generated Data. (Record Format View)

 To replace data in a single item with automatically generated data in the Record Format View:

1.  Select Generate item values from the Edit menu.

2. The Item value update by Generation dialog box is displayed.

2-1. Specify the data item name to be replaced in the Auto-Generation Information field.

2-2. Select a format Type in the Format Information section.

2-3. Specify other information in the Format Information section as needed.

3. When all of the settings have been specified, click OK.

4. The updated data is displayed in the Record Format View.



Altering Record Lengths in Variable Length Files (Record Format View)

 To alter the record length of records added using the Insert, Add, Append and Copy functions:

1.  Confirm that the Record Length field located below the toolbar is enabled. If it is disabled, the record length for this record cannot be changed.  If the
 field is enabled, click on it.

2. Change the record length and press Enter.

Valid values for the record length range from 1 to the maximum record length. The maximum record length was specified in the Record Length field in
 the Data File Setup dialog box when the environment was initially set up.



Linking to the Data Converter (Import Function)

 A CSV-format file or a XML-format file can be read into a file being edited.

An importable CSV-format file must meet the following conditions. A file described in any other format will cause an error when imported.

Item Format

Delimiter Items are separated with commas ( , )

 Quotation
 Marks

 Data is expressed in one of these two ways:
 1) No quotation marks are used on character or numeric items.
 2) Each character item is enclosed in double quotes, but the numeric items are not enclosed in double quotes. Example: "data1", 1,
 "data2", 2, "data3", 3

An importable XML-format file must be in a format supported by Data Converter. A file described in any other format will cause an error when
 imported. Install Fujitsu XML Library (version 2.3 or later) on your computer before importing XML-format files.

Note: See the Precautions for Display and Operations.

Operation Procedure (Import)

1. In the Record Format View or Table Format View, select Link to Data Converter from the Options menu, or click the Link to Data Converter tool
 button. 

2. The Linking to Data Converter dialog box is displayed.

2-1. Select Import.

2-2. Select CSV Format or XML Format for the Output Data Format.

2-3. Specify the record number where the imported data is to be inserted.

2-4. If the Output Data Format is CSV Format, select the type of quotation mark that will be used in the imported data from the Quotes field drop-
down menu.

2-5. Enter the full path of the output file in the Specify Output Data File field. You can use the Browse button to specify a file.

2-6. If the Output Data Format is XML Format:

 - If a layout definition file has been created by Data Converter, select Existing File in the XML Layout Definition File section. 

 - If Data Converter did not create a layout definition file, select New in the XML Layout Definition File section. Enter the full path of the layout
 definition file or click the Browse button to specify a file. In the layout definition file, the input should be XML format and the output should be
 Data File format.

3. When all settings are complete, click the Data Converter button.



Saving Changes (Record Format View)

 The Record Format View displays the edited work file. To save any changes to the data file:

1. Select the Save and Close Data File from the File menu, or click on the Save and Close data File button in the toolbar.

2. The Confirm Update dialog box is displayed. The number of records updated, added, and deleted are displayed. Verify that you want to save those
 updates. Check the Save Select Items checkbox if you want to save the items that were specified using the Select Items function.

3. Click OK to save the updates and return to the initial Data Editor screen.



Discarding Changes (Record Format View)

 The Record Format View displays the edited work file. To discard any changes that have been made:

1. Select Close Data File from the File menu, or click on the Close Data File button in the toolbar.

2. If you made changes to the file, Data Editor displays a message "Data has been updated. Do you want to save the changes?".

3. Click the No button to discard your changes. The file is closed, and the initial Data Editor screen is displayed.



Displaying Data in Hexadecimal (Record Format View)

 To display data in hexadecimal format in the Record Format View:

1. Select the record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or
 by clicking on the corresponding tool button.

2. Click on the data item to be viewed. The Tab key, Shift + Tab key, and Enter key can also be used to select a data item.

3. Select Hexadecimal Edit from the Edit menu, or click on the View/Hide hexadecimal edit bar toolbar button, or right-click anywhere in the Data area
 and select Hexadecimal Edit from the pop-up menu. The Hexadecimal Edit bar is displayed.

Note: When the Data Editor is initially started, the Hexadecimal Edit field does not display. To display it, select Screen Format from the View menu and
 enable Hexadecimal Edit bar.

4. The Hexadecimal Edit field displays the content of the data item in hexadecimal.  Press the Enter key or the Esc key to exit.

Note: The content displayed depends upon the code system in use. See the Precautions for Display and Operations.



Exiting (Record Format View)

 To exit from the Record Format View:

1. Select Close Data File from the File menu, or click on the Close data file tool button.

2. The file is closed, and the initial Data Editor screen is displayed.



Display a Specified Record

 To display a specific record:

1.  Select the record using any of the following from the Locate menu: Previous Record, Next Record, Record Number, First Record, or Last Record; or
 by clicking on the corresponding tool button. 

 2.  The Specify Record Number dialog box is displayed if the record is being selected using the Locate > Record Number menu item or the Specify
 Record Number tool button.

1-1. Specify the record number to be displayed.

1-2. Click OK.



Selecting Items to Display

 Data items can be selected using the Data Editor Select Items function or by using the OCCURS phrase.

About the Display after Item Select

 Items are displayed in the Record Format View and the Table Format View according to the settings in the Select Items dialog box, which is accessible
 only from the Record Format View.

Select Items is not normally used in the following circumstances:

Screen Format Type Displayed Item Item which can be edited

Record Format View
 Table Format View

Record/Group Item/Basic
 Item
 Basic Item

Basic Item Only
 Basic Item Only

 When the OCCURS phrase is used, all items of the array, (1)-array (maximum value), are selected.

The redefine item has not been selected.

Item Select Procedure

1. In the Record Format View, choose Select Items from the View menu, or click the Select Items tool button.

2. The Select Items dialog box is displayed.

2-1. Select the record  in Record Format if more than one record is to be displayed.

2-2. Select Show OCCURS Items if the OCCURS items are to be expanded.

2-3. Select the data items to be displayed and edited in Select Items to be Displayed.

3. When all of the settings have been completed, click OK.



Linking to the Data Converter (Export Function)

 Edited data can be exported into CSV, XML, Data File Format, or another code / file organization data file. You can use the Select Items function to
 export only specific items. If no specific items are selected, all basic items will be exported.

Note: See the Precautions for Display and Operations.

Operation Procedure

1.  In the Record Format View or Table Format View, select Link to Data Converter from the Options menu, or click the Link to Data Converter tool
 button. 

2. The Link to Data Converter dialog box is displayed.

2-1. Select Export.

2-2. Select an Output Data Format.

2-3. If the Select Items function is in use and Data File Format is the selected Output Data Format, the section Select Items Processing is enabled.

2-4. If the Output Data Format is XML Format:

 - If a layout definition file has been created by Data Converter, select Existing File in the XML Layout Definition File section. 
  
 - If Data Converter did not create a layout definition file, select New in the XML Layout Definition File section. Enter the full path of the layout
 definition file or click the Browse button to specify a file. In the layout definition file, the input should be XML format and the output should be
 Data File format. 

3. When all settings are complete, click the Data Converter button.

4. Close the Link to Data Converter dialog box, and start the Data Converter. Refer to the Data Converter online manual for directions on operating Data
 Converter.



Setting Up the Print Page

  To configure the Print Page Settings:

How to use Print Function

1. Select Setup Print Page from the File menu.
 2. The Setup Print Page dialog box is displayed.
 3. Set the items in the property sheet.
 4. Click OK.

Setup Print Page Property Sheet

   The following describes the items that can be set in Setup Print Page.

       - Setup Data Editor

       - Page

       - Margin

       - Header/Footer



Previewing File Printing

Print Preview Function

 The Print Preview function allows the user to check each page of the print image on the screen. The print image displayed in the preview is based on
 settings in Setup Print Page.

Note: See the Precautions when Printing.

Screen Image

Operations of Print Preview

1. Select Preview from the File menu, or click the Print Preview tool button.

2. The Preview screen will be displayed. The buttons have the following functions:

Print Prints the data as shown in the preview screen.

Previous Displays the previous page.

Next Displays the next page.

Zoom In Displays the print image one step larger than the current size.

Zoom Out Displays the print image one step smaller than the current size.

Close Exits the preview screen and returns the user to the Table Format View/Record Format View.

3. To return to the edit screen, click the Close button.



Printing Files

Print Function

 This function prints data as it is shown in the Table Format View, according to the settings of the Setup Print Page dialog box.

 To preview the printed format of a data file before printing, see Previewing File Printing.

Note:  See the Precautions when Printing.

Explanation of Form Appearance

       Print File (Showing record items)

       Print File (Showing record items, with hexadecimal values)

       Print File (No record items)

       Print File (No record items, with hexadecimal values)

Print Procedure

1. Select Print from the File menu,  or click on the Print tool button.

2. The Print dialog box is displayed.

3. When all settings are complete, click OK.

4. Data printing will begin.



Other Functions (Record Format View)

Save to a Data File

 To save the current data in another data file:

1. Select Save as Data file from the File menu,  or click the Save as Data file tool button.

2. The Save As dialog box is displayed. Specify the file name and click OK.

 Switch to Table Format View

 To switch the data edit screen from the Record Format View to the Table Format View:

1. Select Table Format from the View menu, or click the Table format view tool button.

2. The display is switched to the Table Format View.

Select Font

Specifies the font of the characters in the Data Editor view. The default setting is MS Sans Serif 8 point.

1. Select Font from the View menu.

2. The Font dialog box is displayed. When you have modified the font settings, click OK.

Note: See the Precautions for Display and Operations.

 Change the Display Format

Selects the items to display on the Data Editor screen. Screen items include data item columns Level Number (Record Format View only), Description,
 Offset; and Data Editor general features Toolbar, Status Bar, and Hexadecimal Edit Bar.

1. Select Screen Format from the View menu.

2. Enable (check) or disable (uncheck) each screen item in the Screen Format drop-down menu by selecting it.

Key Information Display

 If the file displayed in Data Editor is an indexed file, record key information can be displayed.

1. Select Key Information from the View menu.

2. The Key Information dialog box is displayed.

Version Information

 To view the version number and copyright information for Data Editor:

1. Select About Data Editor from the Help menu.

2. The Version Information screen is displayed.



Table Format View - Overview

 In this view, each record of each item is displayed in a table format. Only existing records can be updated, and records cannot be added or deleted.  The
 Table Format View is the default view mode.

Possible Operation

   Table Format - Supported Functions

   Key operation explanation (Table Format View)

Screen Image

Item Name (below Toolbar)

   Displays the name of the item of the currently selected cell.

Data Display Area (below Toolbar)

   Displays the contents of the currently selected cell.

   Note:  See the Precautions for Display and Operations.

Hexadecimal Edit (below Toolbar)

   The hexadecimal representation of data can be edited using this field.

Item

   Displays the names of the data items as defined in the COBOL library file or Layout Definition File.

Desc

   Simplifies and displays the attribute of each data item defined in COBOL library file or Layout Definition File.

 - Data Descriptions Formats

Offset

   Displays a relative position from the beginning of each item of the COBOL library or Layout Definition File.



Status

   Displays the update status of each record as follows:

Content of Display Explanation

blank No change has been made.

 Update An existing record has been changed.

 Insert A new record has been inserted.

 Add A new record has been added (appended).

 Delete A record has been deleted.

Data Contents

   Displays the data contents of each item.  Select the cell containing the data you wish to edit, and then click on the data edit area to edit the value.
- Numeric Items and Display Formats
- Alphanumeric Items and Display Formats
- Floating-point Items and Display Formats
- Boolean Items and Display Formats
- Character Code Conversions



Editing Data Items (Table Format View)

The operation procedure is as follows.

1. Click on the item to be changed.  Change the item and press the Enter key. The Status of the item changes to Update. You can also change the item in
 the upper part of the screen by selecting the item and then clicking in the upper (label) part of the table. You can use the mouse, the Tab key, the Shift +
 Tab keys, the Enter key, and the Ctrl key plus an arrow key to move between fields.

2. If the contents of a field are changed and the cursor is moved to another field, the changes to the first field will be saved.  Changes are also saved when
 a menu command is executed. The original  data in a field can be restored if you press the Esc key.

Note:  See the Precautions for Display and Operations.



Editing Hexadecimal (Table Format View)

 To edit hexadecimal data in Table Format View:

1. Click on the content of the data item to be changed. 

2.  Select Hexadecimal Edit from the Edit menu, or right-click anywhere in the Data area and select Hexadecimal Edit from the pop-up menu. The cursor
 moves to the Hexadecimal Edit field.

Note: When the Data Editor is initially started, the Hexadecimal Edit field does not display. To display it, select Screen Format from the View menu and
 enable Hexadecimal Edit bar, or click on the View/Hide hexadecimal edit bar tool button.

3.  Edit data in the Hexadecimal Edit field, and press the Enter key to save your changes. The data in the Table Format View is displayed in ASCII code.
 You can discard changes by pressing the Esc key.

Note: Input only those code values that are appropriate to the selected code system. See the Precautions for Display and Operations.



Editing Unicode (Table Format View)

 To edit Unicode in the Table Format View:

1. Click on the data item you want to change. 

2. Select Unicode Edit from the Edit Menu. The Unicode Edit dialog box is displayed.  This command can also be executed from the context pop-up
 menu by right-clicking the mouse. This command is executable even when the cursor is in the Edit control in the upper part of the screen.

3. The content of data is displayed using Unicode numeric values. Updates are saved when the Enter key is pressed, and the dialog box will close.  Click
 the Select Font button to change the display font in the Select Font dialog box.  The content of data on the Table Format View is displayed in ASCII. The
 dialog box can be closed without saving changes by pressing the Esc key.

Only numeric codes appropriate to the target code system should be input.

Note:  See the Precautions for Display and Operations.



Replacing data in one item with automatically generated data (Table Format View)

 To replace data in a single item with automatically generated data in the Table Format View:

1. Select Generate item values from the Edit menu.

2. The Item value update Generation dialog box is displayed.

2-1. Specify the data item name to be replaced in the Auto-Generation Information field.

2-2. Select a format Type in the Format Information section.

2-3. Specify other information in the Format Information section as needed.

3. When all of the settings have been specified, click OK.

4. The updated data is displayed in the Table Format View.



Saving Changes (Table Format View)

  The Table Format View displays the edited work file. To save any changes to the data file:

1. Select the Save and Close Data File from the File menu, or click on the Save and Close data File button in the toolbar.

2. The Confirm Update dialog box is displayed. The number of records updated, added, and deleted are displayed. Verify that you want to save those
 updates.

3. Click OK to save the updates and return to the initial Data Editor screen.



Replacing Particular Data Values (Table Format View)

Replace Function

Retrieves the specified character string in the edit data and replaces it with another specified character string.   The comparison is done as converted into
 the display format according to the specified data item attributes.
 The data is retrieved and replaced one data item at a time.

Note:  See the Precautions for Display and Operations.

To Replace a character string:

1. Select Replace from the Locate menu of Table Format View.

2. The Replace dialog box is displayed.

2-1. Specify the data item to be retrieved in Retrieval Item.

2-2. Specify the character string to be retrieved in Retrieval Character String.

2-3. Specify the replacement character string in Replacement Character String.

2-4. If the data item to be retrieved is an alphanumeric character attribute, set the Case-sensitivity.

2-5. Select a Retrieval Direction.

3. When all of the selections are completed, click the Next button, and the retrieval begins.  When existing data matches the selection criteria, the record
 and the data item are highlighted and the edit screen is displayed.

4. To replace the retrieved character string, click the Replace button.

5. To continue replacing retrieved data, click the Replace button.  
     Click the Next button to not replace the data item and go to the next matching item. 
     To replace all character strings that match the selection criteria, click the Replace All button.



Replacing Particular Hexadecimal Data Values (Table Format View)

Replace Function for Hexadecimal Data

Retrieves the specified hexadecimal value in the edit data, and replaces it with the specified value.  Data items are compared based on the hexadecimal
 value. The data is retrieved and replaced one data item at a time. 

Note:  See the Precautions for Display and Operations.

To Replace hexadecimal data:

1. Select Hexadecimal Data Replacement from the Locate menu of the Table Format View.

2. The Replace Hexadecimal dialog box is displayed.

2-1. Specify the data item to be retrieved in Retrieval Item.

2-2. Specify the hexadecimal data to be retrieved in Retrieval Hexadecimal Data.

2-3. Specify the hexadecimal data to be replaced with Replacement Hexadecimal Data.

2-4. Selects Retrieve Direction.

3. When all of the selections are completed, click the Next button, and the retrieval begins.  When existing data matches the selection criteria, the record
 and the data item are highlighted and the edit screen is displayed. 

4. To replace the retrieved hexadecimal data, click the Replace button.

5. To continue replacing retrieved data, click the Replace button.  
     Click the Next button to not replace the data item and go to the next matching item. 
     To replace all hexadecimal data that match the selection criteria, click the Replace All button.



Discarding Changes (Table Format View)

  The Table Format View displays the edited work file. To discard any changes that have been made:

1. Select Close Data File from the File menu, or click on the Close data file button in the toolbar.

2. If you made changes to the file, Data Editor displays a message "Data has been updated. Do you want to save the changes?".

3. Click the No button to discard your changes. The file is closed, and the initial Data Editor screen is displayed.



Displaying Data in Hexadecimal (Table Format View)

 To display data in hexadecimal format in the Table Format View:

1. Click on the data item to be viewed. The Tab key, Shift + Tab key, and Enter key can also be used to select a data item.

2. Select Hexadecimal Edit from the Edit menu, or click on the View/Hide hexadecimal edit bar toolbar button, or right-click anywhere in the Data area
 and select Hexadecimal Edit from the pop-up menu. The Hexadecimal Edit bar is displayed.

Note: When the Data Editor is initially started, the Hexadecimal Edit field does not display. To display it, select Screen Format from the View menu and
 enable Hexadecimal Edit bar.

 3. The Hexadecimal Edit field displays the content of the data item in hexadecimal.  Press the Enter key or the Esc key to exit.

Note: The content displayed depends upon the code system in use. See the Precautions for Display and Operations.



Exiting (Table Format View)

 To exit from the Table Format View:

1. Select Close Data File from the File menu, or click on the Close data file tool button.

2. The file is closed, and the initial Data Editor screen is displayed.



Searching for Data Values

Search Function

Searches the data being edited for a specified character string or numeric value. The comparison is performed according to the attributes of a specified
 data item,  and is based on data converted to the display format.

Note: See the Precautions for Display and Operations.

Search Procedure

1. In the Table Format View, select Search from the Locate menu.

2. The Search dialog box is displayed.

2-1. Type the character string to be searched for in the Search Character String field. Click the down arrow to view and select from previous searches.

2-2. If the character string to be searched for is alphanumeric, check the Case-sensitive checkbox.

2-3. Type the data item to be searched in the Search Item Name field. Click the Browse button to select from the available items.

2-4. Select a Search Direction. Search Backward searches from the current cursor position to the beginning of the file. Search Forward searches from
 the current cursor position to the end of the file.

3. When all Search settings are complete, click OK.

4. If matching data is found, the edit screen displays the record with the matching data item at the top.  If matching data is already displayed on the
 screen, the cursor is relocated to the matching data, and the screen is not scrolled.

5. To continue searching for matching data, select Previous or Next from the Locate menu. The search value will be valid until the Table Format View is
 closed, or another search value is entered, or Search for Hexadecimal Data is selected from the Locate menu.



Searching for Hexadecimal Data Values

Search hexadecimal data

Searches the data being edited for a specified hexadecimal value.  Unless the user specifies a search data item, all data extracted or edited will be
 searched. If  Select Items has been specified, only the selected data is searched.

Note:  See the Precautions for Display and Operations.

Searching for Hexadecimal Data

1. In the Table Format View, select Search for Hexadecimal Data from the Locate menu.

2. The Search the hexadecimal data dialog box is displayed.

2-1. Type a hexadecimal number to be searched for in the Hexadecimal Data field.

2-2. If only a specific data item is to be searched, check the Specify Search Item checkbox,  and enter a data item name in the Search Item field. Click
 the Browse button to select from the available items.

2-3. Select a Search Direction. Search Backward searches from the current cursor position to the beginning of the file. Search Forward searches from
 the current cursor position to the end of the file.

3. When all settings are complete in the Search the hexadecimal data dialog box, click OK.

4.  If matching data is found, the edit screen displays the record with the matching data item at the top. If matching data is already displayed on the
 screen, the cursor is relocated to the matching data, and the screen is not scrolled.

5. To continue searching for matching data, select Previous or Next from the Locate menu. The search value will be valid until the Table Format View is
 closed, or another search value is entered, or another command is selected from the Locate menu.



Searching for an Item Name

Search for Item Name

Displays the specified data item at the top of the screen.

Note:  See the Precautions for Display and Operations.

Search for Item Name Procedure

1. In the Table Format View, select Search for Item Name from the Locate menu.

2. The Select Item dialog box is displayed.

2-1 Click on an item in the Select Item list, or enter the item to be searched for in the Specify Item Name field.

3. When all settings are complete in the Select Item dialog box, click OK.

4. If matching data is found, the edit screen displays the record with the matching data item at the top.  If matching data is already displayed on the
 screen, the cursor is relocated to the matching data, and the screen is not scrolled.



Other Functions (Table Format View)

Save to a Data File

 To save the current data in another data file:

1. Select Save as Data File from the File menu,  or click the Save as Data file tool button.

2. The Save As dialog box is displayed. Specify the file name and click OK.

 Switch to Record Format view

 To switch the data edit screen from the Table Format View to the Record Format View:

1. Select Record Format from the View menu, or click the Record format view tool button.

2. The Record Format View is displayed.

 Select Font

Specifies the font of the characters in the Data Editor view. The default setting is MS Sans Serif 8 point.

1. Select Font from the View menu.

2. The Font dialog box is displayed. When you have modified the font settings, click OK.

Note: See the Precautions for Display and Operations.

 Change the Display Format

Selects the items to display on the Data Editor screen. Screen items include data item columns Description, Offset; and Data Editor general features
 Toolbar, Status Bar, and Hexadecimal Edit Bar.

1. Select Screen Format from the View menu.

2. Enable (check) or disable (uncheck) each screen item in the Screen Format drop-down menu by selecting it.

Key Information Display

 If the file displayed in Data Editor is an indexed file, record key information can be displayed.

1. Select Key Information from the View menu.

2. The Key Information dialog box is displayed.

 Version Information

 To view the version number and copyright information for Data Editor:

1. Select About Data Editor from the Help menu.

2. The Version Information screen is displayed.



Using the Sample Data Files

 To use the sample data provided with the Data Editor:

1. Select Environment Setup from the Options menu. The Environment Setup dialog box is displayed.

 2. Click on the COBOL Library Analysis Method tab. Make the following settings and then click OK:

 3. In the Initial View, select Open Data File from File menu. The Open dialog box is displayed.

4. Select the sample data file (Data1.dat) in the Samples\DataTools folder in the installation directory, and click Open. The Data File Setup dialog box is
 displayed.

5. Click the Setup button in the Data File Setup dialog box. The Specifying Format Files dialog box is displayed.

6. Specify the sample COPY clause file (Data1.cbl) in the Samples\DataTools folder in the installation directory, and click Open.

 7. The analysis confirmation message is displayed. Click OK. The Data File Setup dialog box is displayed.

 8. Verify the following settings in the Data File Setup dialog box, and click OK.



 9. The Select Data File dialog box is displayed.

 10. Select Update in the Data File Edit Mode section, and click OK.

 11. The Extraction confirmation dialog box is displayed. Click OK.



12. The Record Format View is displayed. In this view, the user can use various functions of Data Editor.

13. To exit Data Editor, select Exit from the File menu, or click on the Close (X) button.



Browse for Folder

Screen Image

Field Descriptions

Folder

Selects the folder on the disk drive.

Drive

Selects the drive.

Network

Allocates the drive on the network.



Set Conditions

The Set Conditions dialog box is provided to specify conditions for extraction of records from the data file. Only those records that match the specified
 data conditions are extracted.

Screen Image

To add, update or delete an extraction condition:

Add

The Add function appends a new condition to the existing condition. Enter the new condition and click the Add button. The extraction condition is
 added to the final condition list displayed in the upper part of the dialog box. As many as 10 conditions can be specified

Update

The Update function changes an existing condition in the Extraction Conditions list. Select the condition to modify, make the change, and click the
 Update button. The selected condition is updated in the Extraction Conditions list.

Delete

The Delete function removes an extraction condition. Select the condition(s) to be removed. Multiple conditions can be selected using the Ctrl key.
 Click the Delete button. The extraction condition(s) are deleted from the Extraction Conditions list.

Set Conditions Fields

Extraction Conditions

The set data condition is displayed. Data is extracted according to the conditions displayed in the Extraction Conditions list.

Condition Definition

Connected condition

When two or more data conditions are specified, the two conditions must be connected with either "AND" or "OR".  The default is "AND".

Item name

 Specifies the data item associated with the extraction condition. Click the Select Item button to select from the list of available data items,
 displayed in the Select Item dialog box. Only those items in this list can be used in the Item Name field.

 The handling of OCCURS items depends on the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the



 following table:

Checked Specify a data item name with a subscript.

Not Checked Specify only the data item name, without a subscript.

Operator

 Specifies the operator to compare the data value with the selection condition value. The operator that can be specified depends on the data type
 attribute:

Character type
 attribute

 "Prefix ", "Exact Match"

Figure type
 attribute

"=", "!=", ">", ">=", "<", "<="

Condition value

 Specify the value of the extraction condition.



Confirm Update

This is a screen to confirm the number of data records that have been updated, added, and deleted.  You can select whether to save the information that
 was set in the Item Select processing.

Screen Image

Field Descriptions

Update

Displays the number of updated records.

Add

Displays the number of added records.

Delete

Displays the number of deleted records.

Save Select Items

If checked, saves the information set in the item select.



Copy Current Record (Sequential / Line Sequential)

Data Editor copies the current record and inserts the copied record(s) in front of the record number specified. If zero is specified, Data Editor appends the
 copied record(s) to the end of the file. Multiple copies of the current record can be inserted at the same time.

Screen Image

 Explanation of control

Insert at Record Number

Data Editor copies the current record and inserts the copied record(s) in front of the record number specified. If zero is specified, Data Editor
 appends the copied record(s) to the end of the file.

Number of Copies

Specifies the number of copies of the current record to insert.

Generate item values

 If this box is checked, sequence numbers will be automatically generated for the newly added record(s).  Click the Details button to display the
 Data Generation dialog box to modify the automatic data generation values.



Data Editor Version Information

Screen Image

Explanation

Displays the version number and copyright information for Data Editor.



Data File Setup

 The Data File Setup dialog box is used to set format and data file information.

Screen Image

Fields

Format Information

File Type

Displays the setting of the File Type in the COBOL Library Analysis Method tab of the Environment Setup dialog box.

To specify a library:

1. Click the Setup button. The Specifying Format Files dialog box is displayed.

2. Select a file that is of the type indicated in File Type field (COBOL library file name or layout definition file) and click the Open button. If the
 Cancel button is clicked, the system returns to Data File Setup dialog box.
Note:  Specify a file only of the File Type indicated. A file of a type other than the File Type will result in an analytical error.

3. Click OK when the message "Analyze the Library <library-name>?" is displayed.

4. After the file is analyzed, the file name and record length are displayed in the Data File Setup dialog box. If any errors are generated in the analysis, a
 message is displayed explaining the error.

Character Code

Displays the setting of the Character Code in the Analysis Option section of the COBOL Library Analysis Method tab of the Environment Setup dialog
 box.

BINARY

Displays the setting of the BINARY Option in the Analysis Option section of the COBOL Library Analysis Method tab of the Environment Setup
 dialog box.

Data File Information

File Organization

Select Sequential, Line Sequential, Indexed, or Relative.

Record Format

 The default value is Fixed. This field is disabled when an existing fixed-length file is being edited.



Length

Specify a record length in the range of 1 to 32760. The default value is the record length of the analyzed library. The record length of existing indexed
 files cannot be modified.

Minimum

 For variable length format indexed files, specify the minimum record length of a data file. For fixed files, this Minimum is set to 0.

Note: The minimum record length will be set automatically with the Key Info, even if it not set in the Minimum field.

Key Info

Key Information is enabled when Indexed is selected for the File Organization.

1. Click the Setup button. The Key Information Setup dialog box is displayed.

2. Specify the primary key and secondary keys.

Specifying Keys
Offsets and lengths are in bytes. Offsets start from 1. For compound keys, use a
 "/"(slash) to separate the individual components.

Example) "1,10/11,5"

Specifying
 Duplicate Keys

Check the Duplicate Key check box for any keys that can have duplicates.

3. When all the settings are completed, click OK. The Data File Setup dialog box is displayed.

Code Information

Displays the code system of the data file.

Comment

 Optional:  You can enter a comment for the data file, up to 255 characters.



Data Generation

 This screen is used to set values for data generation.

Screen Image

Data Generation Fields

Item Explanation

 Auto-Generation Information Lists the format information of each item in the file.

Setup Button Displays the Setup Format dialog box, where the format information of each item can be modified for use with auto-
generation.

Item Information

Displays the name and description of the item currently selected.

Format Information

Type

Setup Default Value
 Select this option to use the value (NULL or BLANK) that was set in the COBOL Embedded
 Characters section of the Work Environment tab of the Environment Setup dialog box.
Setup Format (Initial Value)
 Select this option to direct Data Editor to generate data in a specific format. Setup Format is the
 Type field default.
Reference Other Item
 Select this option to direct Data Editor to generate data using the data generation method for the
 specified column.
Setup enumeration type
 Select this option to direct Data Editor to generate data from data provided in advance.

File Name

  If Setup Enumeration Type was selected in the Type field, click the Browse button to



 select the file to be used as the Enumeration file. A different file can be specified for
 each item.
Note: This field is disabled if a Type other than Setup Enumeration Types was specified. 
 Click the Open button to open the specified file in Notepad.

Enumeration file format

The Enumeration file must be in the ASCII text file format.
A record that ends with a line feed code is treated as one data
 item.
Double-quotation marks (") are treated as data.
Commas (,) cannot be used.
Up to 100,000 data items can be included.
Records that contain only one line feed code are ignored.

Coding samples
AAAAA
 BBBBB
 CCCCC
     :

11.111
 22.222
 33.333
  :

Reference Item

 If Reference Other Item was selected in the Type field, specify the item to be used to
 automatically generate data.
Note: This field is disabled if a Type other than Reference Other Item was specified. 

Format

 If Setup Format was selected in the Type field, specify a format for the item. A format
 appropriate to the attributes of the item is set as the default.

Custom Format

 Checking this checkbox allows you to customize the format. See Formats and Setting
 Examples .

Select Format Example button

 The following formats are pre-registered:  %D, %U, %s, %S, %YMD, %YMA, %T,
 %TS.
 Custom formats can be added and  deleted using the Add and Delete buttons. Note: Pre-
registered formats cannot be deleted.

Start Value

Specify the value with which the variable part begins. If more than one variable part
 exists, specify the start values of the variable parts, separating each by a comma (,). The
 specified values must be within the range allowed for the corresponding format.

End Value

Specify the value with which the variable part ends. If more than one variable part exists,
 specify the end values of the variable parts, separating each by a comma (,). The
 specified values must be within the range allowed for the corresponding format.

Increment Value

Specify an increment for the variable part. You can specify a value in the range of -9 to
 +9. The up and down arrows can be used to change the increment value.

If end value exceeded

 Select the action to be taken if the number of data items that should be generated has not been reached.
 This can occur when the value in the variable part exceeds the end value, or when the number of
 enumeration data items has not reached the number of records that should be generated.

Initializing
 Select this option to use the value you set in the COBOL Embedded Characters section of the Work Environment
 tab of the Environment Setup dialog box.
Repeat from the start value
 Select this option to repeat from the start value when generating data in the specified format.

Delete



Use this button to clear the format information for the selected item.

Setup

Use this button to apply the specified format to the selected item.

Previous / Next Item

Use these buttons to navigate to the previous or next item while keeping the Setup Format dialog box
 open.

Delete Button Clears the format information for the selected item.

Repetition generation
 information

 This section is used to generate data via repetitions. If the Repeats checkbox is checked, a record with a nested structure
 can be created based on level numbers and number of repetitions for the item selected in the Auto-Generation
 Information. Use level numbers to specify which items should nest within which other items. The value assigned to an
 item must be higher by the increment value than the value assigned to an item that is one level lower.

Repeats

 Specify a value equal to or greater than 1 for both the level number and the number of repetitions.
 You cannot specify repetition for items that have no specified format.

Update

Use this option to update the Auto-Generation Information with the specified repetition generation
 information.



Backup (Environment Setup)

Screen Image

Field Descriptions

Create Data File Backup

Check the Create Backup file check box to have Data Editor make backups. The backup files are created in the work file folder specified on the Folders
 tab. The backup file name is Filename +".BAK".
 When a file of this name already exists, it is overwritten. The default setting is with the Create Backup File box checked.

Example Data file name  Backup file name

DATAEDIT.DAT >> DATAEDIT.DAT.BAK

Backup File Folder

Specify the folder in which to store the backup file saved with Data Editor. The default folder is the TEMP folder within the Data Editor installation
 folder.

Note:
 See the Precautions for Display and Operations.

Browse

 Click the Browse button to select a folder using the Browse for Folder dialog box.



COBOL Library Analysis Method (Environment Setup)
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Field Descriptions

File Type

Specify the file type for the format. The following formats can be specified. The default is COBOL library.

COBOL library File of record description in COBOL

Layout Definition File  File made by definition of layout in Data Editor

Analysis Method

Specify whether to use COBOL Analysis Library or Fujitsu COBOL Compiler when the format analysis is done.  COBOL must be installed in order to
 use Fujitsu COBOL Compiler.

Note:
 See the Precautions with Copy Libraries.

Analysis Option

Reference Format Type

 Specify whether the COBOL library files are fixed length format, variable length format, or free format.
 The default setting is variable length format.
 This setting is not related in the file definition and the layout definition file.

BINARY Option

 You can specify this option when Fujitsu COBOL Compliler is selected in the Analysis Method area.
 A binary item can be treated as a WORD or a BYTE using the BINARY setting, which is a COBOL translation option.  The default setting is WORD.
 This setting is not related to the layout definition file or the file definition.

Note:
 See the Precautions with Copy Libraries.



Character Code

The default value is ASCII.
 This setting is not related in the Layout definition file.

When you select "Unicode", format files created using UCS2 cannot be analyzed.

COPY Sentence Additional Character String

If the REPLACING phrase is not specified when the COBOL library files contain a temporary original (parentheses etc.), it cannot be analyzed
 correctly. To analyze it correctly, an additional character string for the COPY sentence is specified. The character string must be specified according to
 COBOL grammar. The specification of the JOINING/DISJOINING phrase is also valid. This setting is not related in the Layout definition file.

Specification example)

    REPLACING ==()== BY ==AA==

Note:
 See the Precautions with Copy Libraries.



Code Conversion (Environment Setup)
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Field Descriptions

Data Code Type

Code Type

 Select the setting of Code information in the Data File Setup dialog box as ASCII, EBCDIC, or Unicode. The default setting is ASCII.

Unicode Details

 The part of the Unicode COBOL data file that is in national characters is created in UCS2 (little endian or big endian) form.

UCS2 Endian

In the Data File Mode list, select the endian order for storing data on data files: Big (big endian) or Little (little endian). The default setting is Little. 

 In the Hexadecimal Display list, select the endian order for hexadecimal numbers displayed in the hexadecimal edit bar: Big (big endian) or Little (little
 endian). The default setting is Little.

 Binary File Code Type

 Select the setting of Line Sequential File Code Type in the Data File Setup dialog box as UCS2 or UTF8. The default setting is UCS2.



Display Format (Environment Setup)
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Field Descriptions

Table Format : Limit Item Display Width

Maximum Display Width

Set the maximum width for displaying items in the Table Format View. When 0 is specified, the display width is determined by the size of each item.

Record Format : Display Item Width

Display Item Width

This sets the width of the string used to display the data item name in the Record Format View. Valid display width settings are 0 and 11 - 60. A
 specification of 0 indicates that the maximum width of  60 bytes is to be used. The default setting is 0. 

Edit Procedure

Suppress display of leading zeros

Specify if zeros should be suppressed when displaying numeric items in the Record Format View and the Table Format View. The default setting is
 unchecked.



Folders (Environment Setup)
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Field Descriptions

Folder for Data Editor Information (.LNC) Files

Specify the folder in which to save the test case file made with Data Editor. The default folder is the TEMP folder within the Data Editor installation
 folder.

Note:  See the Precautions for Display and Operations.

Browse

 Click on this button to use the Browse for Folder dialog to select the folder.

Folder for Data Editor Workfiles

Specify the folder in which to create the Data Editor work file. The default folder is the TEMP folder within the Data Editor installation folder.

Note:  See the Precautions for Display and Operations.

Browse

 Click on this button to use the Browse for Folder dialog to select the folder.



Work Environment (Environment Setup)
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Field Descriptions

COBOL Embedded Characters

Empty space in character data items can be filled with BLANK or NULL values. If BLANK is specified, single byte spaces are embedded for PICTURE
 X type items and double byte spaces for PICTURE N type items.
 The default setting is BLANK.

Access Mode

 Set up the method to access the data file.

COBOL IO Specify this to access a COBOL file. (COBOL must be installed.)

BINARY Specify this to access a sequential and fixed length file other than a COBOL file. (COBOL does not need to be installed.)

COBOL File Size

The size of the data file is specified. Either "Standard" or "Large" is specified. This setting is used only for sequential and line sequential files.

Standard A data file up to 1GB can be manipulated.

Large A data file exceeding 1GB can be manipulated.

Default Edit Mode

When a previously edited file is loaded, you can specify the default edit mode for the Select Data File dialog box. The options are Update, View and Add.
 The default setting is Update.

 When the Select All Data box is checked and you select a field to edit, any characters that you enter will overwrite all data in the field. If the Select All
 Data box is unchecked, characters will be inserted into the data instead of overwriting it.

Warning message on Add/Copy for Indexed/Relative Files

When you add or copy records on the Record Format View, specify whether to display the message box. If an error occurs and the message box display is
 suppressed, the changes cannot be undone. The default setting is to suppress the display.

Editor for Previewing Error File

 The content of format analysis errors can be viewed in a specified editor. The default is "NOTEPAD.EXE".



Extraction confirmation

This screen confirms the number of records to be extracted. It displays the number of records that exist in the data file, and the number of records that
 meet the extraction condition.
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 Explanation of control

Number

Displays the number of records to be extracted.



Font

 This screen is used to select the font used to display the content of the data.

Screen Image

Field Descriptions

Font

 Select the display font.

Font style

 Select the display font style.

Size

 Select the display font size.

Effects

 Specify special text effects: strikethough, underline, and font color.

Sample

 The Sample field displays a preview of the font options currently selected.

Script

 Select a type style of the selected language from the list of styles valid for the selected font.



Hexadecimal Edit

Hexadecimal Edit Bar

 Used to display and edits hexadecimal data.  The data item selected by the cursor is processed.
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Field Descriptions

Hexadecimal Edit

Displays the content of the data of the display/edit object as a hexadecimal number.

Position (of cursor)

The cursor position in the Hexadecimal Edit box is displayed in the form of "current position/number of digits displayed".

Move

After the Enter key is pressed, the new hexadecimal value overwrites the original data in the file.

Hexadecimal Display Format of National Character items (UCS2)

When the code system is Unicode and the item is a national character item, displays in which mode (big endian or little endian) the hexadecimal number
 value is stored.  "BE" indicates "Big Endian" mode and "LE" indicates "Little Endian" mode.
 This setting can be changed using the Hexadecimal Display option of the Code Conversion (Environmental Setup) dialog.



Generate Item Values

This screen is used to configure data that is to be generated.
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Field Descriptions

 Auto-Generation Information

Specifies the data item name to be replaced for the automatic generation data. Use the Browse button to select from the list of items in Select Item Name
 dialog box.

The Item Name field only accepts item names selected from the Select Items dialog , which is displayed when you click on the Browse button.  Only
 elementary items can be set.

Handling of OCCURS items differs according to the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the
 following table:

Checked Specify a data item name with a subscript.

Not checked Specify a data item name without a subscript.

Format Information

Type

Setup Default
 value

The generated value is created using the existing format.

Setup Format The format is changed, and data is created according to the new format.

Format

Customizing of Format

Customize the format by checking the box.

Format

The new format is specified here.

Specifying a format:
A format is composed of an optional variable part and an optional fixed part. Either may be specified in any order.



 Variable
 part

Begins with character "%" (percent), followed by a value indicating the "Number of digits", and then a character denoting the new
 format.

Specification example: %9D

Number
 of digits

The number of digits must equal the number of digits in the original format. If adding a fixed part to the new format, for
 every fixed part character added, the number of digits must be reduced by one character. If the format characters are
 "YMD" and "YMA", the number of digits can only be 2 or 4.

Format
 character D

Numerical value with a sign. The value generated can be -9 to +9. Data items that can use this attribute are data
 items whose original format defined character data types (alphanumeric character items etc.) and numeric data
 types (external decimal items etc.).

U
Numerical value without a sign. The value generated can be 0 to 9. Data items that can use this attribute are data
 items whose original format defined character data types (alphanumeric character item etc.) and numeric data
 items without a sign (external decimal items etc.).

s Small alphabetic letter of normal width. The range of the value generated can be a to z. Data items that can use
 this attribute are data items whose original format defined character types (alphanumeric character item etc.).

S Normal width alphabetic capital letter. The  value generated can be A to Z. Data items that can use this attribute
 are data items whose original format defined character types (alphanumeric character item etc.).

YMD Date (Only valid dates are accepted). The value generated is a valid date. Data items that can use this attribute
 are data items whose original format defined character types (alphanumeric character item etc.).

YMA Date (will accept both valid and invalid dates). The value generated is a valid date. Data items that can use this
 attribute are data items whose original format defined character types (alphanumeric character item etc.).

T

Time
 The range of specifiable values is 000000 (0:0:0) to 235959 (23:59:59).
 The number of characters cannot be specified for the variable part. 
 The item attribute which can be specified is a character type (alphanumeric character item etc.).

TS

YMD + Time
 The range of specifiable values is 19700101 090000 (9:00:00, January 1, 1970) to 20380119 031407 (3:14:7,
 January 19, 2038).
 The number of characters cannot be specified for the variable part. 
 The item attribute which can be specified is a character type (alphanumeric character item etc.).

Fixed
 part

The fixed part of a format is a string enclosed by single quote characters ('). When a fixed part is added to a format, the characters
 enclosed in the single quote characters are added to the data item as a literal.

Specification example '9999'

Format Example

This list box displays the list of system registered formats (%D, %U, %s, %S, %YMD, %YMA, %T, %TS), as well as those formats that were
 added by the user.  User added formats can be deleted; system registered formats cannot be deleted.

Range Specification

Start Value

The start value of the variable part of the format is set in this entry field. If the format contains two or more variable parts, delimit the starting
 values with the "," character (comma). The start value should be a value that is compatible with the corresponding format.

End Value

The end value of the variable part of the format is set in this entry field. If the format contains two or more variable parts, delimit the starting
 values with the "," character (comma). The end value should be a value that is compatible with the corresponding format.

Increment Value

The increment value of the variable part of the format is set in this entry field. Specify values within the range of from -9 to +9.

Operation when end value is exceeded

The behavior of the automatic generation of data when the value of the variable part exceeds the end value is selected here. Choose from
 "Initializing" or "Repeat from the beginning value".

Examples

Format: D (Numerical value with a sign)

Example 1) To update the item defined by PIC S9(5) on 100 existing records for the value of 101 - 200 respectively:

Format %5D



Start Value +00101 (acceptable as 101)

End Value +00200 (acceptable as 200)

Increment Value 1

Example 2) To update the item defined by PIC S9(5) on 100 existing records for the value of 50 to -49 respectively:

Format %5D

Start Value +00050 (acceptable as 50)

End Value -00049 (acceptable as -49)

Increment Value -1

Format: U  (Numerical value without sign)

Example 1) To update the item defined by PIC 9(5) on 100 existing records for the value of 101 - 200 respectively:

Format %5U

Start Value 00101(acceptable as 101)

End Value 00200(acceptable as 200)

Increment Value 1

Example 2) To update the item defined by PIC X(10) on 100 existing records for the value of ABCDE00001 - ABCDE00100 respectively:

Format 'ABCDE'%5U

Start Value 00001(acceptable as 1)

End Value 00100(acceptable as 100)

Increment Value 1

Format: s (Small alphabetic letter of normal-width)

Example 1) To update the item defined by PIC X(5) on 100 existing records for the value of aaaaa - aaadv respectively:

Format %5s

Start Value aaaaa

End Value aaadv

Increment Value 1

Example 2) To update the item defined by PIC X(10) on 100 existing records for the value of aaaaa10cc - aaadv10fx respectively.

Format %5s'10'%2s

Start Value aaaaa,cc

End Value aaadv,zz

Increment Value 1

Format: S (Normal-width alphabetic capital letter)

Example 1) To update the item defined by PIC X(5) on 100 existing records for the value of ZZZZZ - ZZZWE respectively.

Format %5S

Start Value ZZZZZ

End Value ZZZWE

Increment Value -1

Example 2) To update the item defined by PIC X(10) on 100 existing records for the value of AAAAAAAAXX - AAADVADVXX respectively.

Format %5S%3S'XX'

Start Value AAAAA,AAA

End Value AAADV,ADV

Increment Value 1

Format: YMD (date:no error)



Example 1) To update the item defined by PIC X(8) on 100 existing records for the value of 20000101 - 20000410 respectively.

Format %4YMD

Start Value 20000101

End Value 20000410

Increment Value 1

Example 2) To update the item defined by PIC X(6) on 100 existing records for the value of 000101 - 000410 respectively.

Format %2YMD, or %YMD

Start Value 000101

End Value 000410

Increment Value 1

 When the year is represented by two digits, such as 99 and  02, then 99<02.

Format: YMA (date:with error)

Example 1) To update the item defined by PIC X(8) on 100 existing records for the value of 20000101 - 20000407 (the value of the error inclusive on the
 way) respectively.

Format %4YMA

Start Value 20000101

End Value 20000407

Increment Value 1

Example 2) To update the item defined by PIC X(6) on 100 existing records for the value of 990701 - 991007 (the value of the error inclusive on the
 way) respectively.

Format %2YMA, or %YMA

Start Value 990701

End Value 991007

Increment Value 1

When the year is represented by two digits, such as 99 and 02, then 99<02

Format: T (time)

Example 1) To update the item defined by PIC X(6) on 100 existing records for the value of 100001 - 100140 respectively.

Format %T

Start Value 100001

End Value 100140

Increment Value 1

Processing
 number

100

Format:TS (date+time)

Example 1) To update the item defined by PIC X(15) on 100 existing records for the value of 20000101 100001 - 20000407 100140 respectively.

Format %TS

Start Value 20000101 100001

End Value 20000407 100140

Increment Value 1

Processing
 number

100



Key Information

Displays the key information of an indexed file.

 Screen Image

Explanation of control

Attr  Attribute: Displays the names of the primary and secondary keys.

Dup
 Duplicate: Displays whether duplicates are allowed for each key.
    - Blank : No duplicates are allowed
    - Dup: Duplicates are allowed

Description of
 Settings

Displays the components of the keys in the format: offset, length [/ offset-2, length-2]...



Key Information Setup

The Key Information Setup dialog box is provided for the entry and viewing of the primary and secondary key information for indexed files.
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Explanation of control

Primary Key

Enter a string to define the structure of the primary key. The format is:
offset, length [/ offset-2, length-2]...
The first byte in the record is offset 1.
 For compound keys, separate the individual parts using "/".
 Example: 1, 10/16,5
 The example above has two parts. The first is 10 bytes long starting at the first byte, and the second part is 5 bytes long starting
 at the 16th byte.
 The key definition string can be a maximum of 254 characters.

Secondary Key

Enter a string to define the structure of the secondary key.  The format is:
offset, length [/ offset-2, length-2]...
The first byte in the record is offset 1.
 For compound keys, separate the individual parts using "/".
 Example: 1,10/16,5
 The example above has two parts. The first is 10 bytes long starting at the first byte, and the second part is 5 bytes long starting
 at the 16th byte.
 The key definition string can be a maximum of 254 characters.

Duplicate Key Check this box when duplicate keys are allowed.



Link to Data Converter

This screen is used to set information for the Link to Data Converter. The following import/export processing can be done.

Import

 CSV and XML format files can be imported to the editing file.  An importable CSV-Format file must meet the following conditions:

Item Format

Delimiter Items are separated with ASCII commas ",".

Quotation Marks  Only non-numeric items canbe enclosed in quotations. See the Precautions for Display and Operations.

Importable XML-Format files are the only files supported by the Data Converter. If importing of another format file is attempted, the Data Converter will
 reject that file and display an error message. For importing XML format, the layout definition file must be XML and the output must be Data format.

Export

 CSV format file, XML format file, and the Data File format file can be exported to the editing file.  For exporting XML format, the layout definition file
 must be XML and the output must be Data format.

Note:
 See the Precautions for Display and Operations.
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Field Descriptions

Import/Export

 Select Import or Export.

Output Data Format

Select Data file format, CSV format, or XML format.  Data File Format cannot be selected for Import.

Select Items Processing

This is applicable only for Export. When a data item is not chosen by Select Items, it is unavailable. When Data File Format is set by Data form, it
 becomes available.  The default value for determining the length of the output file record is as follows:



- When "Output Select Items" is checked:
 Sum total of item length for data items selected by Select Items.

- When "Output Select Items" is not checked:
 Sum total of all data items, as if all data items were selected by Select Items.

Import Data Location

This is applicable only for Import. Specify the position within the editing data where the imported data will be inserted.  The default value is 1, the
 beginning of the file.

Refer to the Data Converter online manual for instructions on using the Data Converter.

Import Data Quotes

Specifies the quotation mark of the CSV file. The default setting is "not specified".

 Output Data File

Specifies the file to be output from the file being edited.

XML Layout Definition File

Specify an existing layout definition file created by Data Converter, or specify a new layout definition file to be created.



Print

Display the standard setting for printing.  Data is printed as it is shown in the Table Format View, per the settings in the Setup Print Page dialog box.
 Specify other settings in the Setup Print Page screen.  Go to the Print Preview screen to confirm the print image before printing.
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Field Descriptions

Printer

Displays the printer selected and the printer information currently set for the computer.

Print range

Specify the range of pages to print. Specify that the entire document, the specified page, or that the specified start and end pages are to be printed.

Copies

Specify the number of copies to print.



Record Range

The Record Range dialog box is provided for specifying the range of records to be loaded into the Data Editor.

 Screen Image

Explanation of control

First Record Specify the number of the first record to be loaded. The default is 1.

Last Record Specify the number of the last record to be loaded. If zero is entered, the last record loaded will be the last record in the file. The
 default is zero.



Record

 Specify the number of records to be inserted, added, or deleted in this dialog box.

Screen Image

Record Fields

Number

 Specify the number of records to be inserted, added, or deleted from the current record. You can enter a number in this field, or use the up and
 down arrows to increase or decrease the number.

Generate item values

 If this box is checked, item values will be generated for the newly added or inserted records.  Click the Details button to display the Data Generation
 dialog box to modify the data generation values. 
Note: This option is not available for record deletion processing.



Replace

The following screen is used to enter information for Replace Data processing.  Replace Data is used to search for specified numeric values from selected
 data, and to replace it with the character string specified in the Replacement Character String.
 The replace function works only for data of X items (alphanumeric characters) and N items (national characters).

 Note: See the Precautions for Display and Operations.
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Field Descriptions

Search character string

Specify the character string for which to search. You may reuse any of the last five recently-used search values, but these are cleared at the end of each
 editing session.

Replacement Character String

Specify the character string to replace ones that match the search criteria. You may reuse any of the last five recently-used replace values, but these are
 cleared at the end of each editing session.

Case-sensitivity

Specify whether to treat upper and lower case letters as different characters.  The default setting is checked.  
 This setting determines which item names will be selected: those that match the search value exactly, or any that match regardless of case.

Search Item Names

Specify the data item to be searched.  The item name defaults to the one immediately before the cursor location on the Record Format View or the Table
 Format View.
 Click on the Browse button to select an item from the Select Items list.

The Search Item Name field accepts only item names selected from the Select Items dialog, which is displayed when you click on the Browse button.  By
 default, only elementary items can be set.

 OCCURS items are processed according to the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the following
 table:

Checked Specify a data item name with a subscript.

Not checked Specify a data item name without a subscript.

Search Direction

 Select Search Forward or Search Backward to search from the current cursor position.  The default setting is Search Backward.  Data at the current
 cursor position is included in the search. 



Replace the hexadecimal data

The following screen is used to enter information for Replace Hexadecimal Data processing.  Replace Hexadecimal Data is used to search for specific
 hexadecimal values from selected data, and replace it with the hexadecimal data specified in the Replacement Hexadecimal Data field. The replace
 function works only for data of X items (alphanumeric characters) and N items (national characters).

Note: See the Precautions for Display and Operations.
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Field Descriptions

Search Hexadecimal Data

Specify the hexadecimal value to be selected. You may reuse any of the last five recently-used search values, but these are cleared at the end of each
 editing session.

Replacement Hexadecimal

Specify the hexadecimal value to replace ones that match the search criteria. You may reuse any of the last five recently-used replace values, but these
 are cleared at the end of each editing session.

Item for Search

Specify the data item to be searched.  The item name defaults to the one immediately before the cursor location on the Record Format View or the Table
 Format View.
 Click on the Browse button to select an item from the Select Items list.

The Search Item Name field accepts only item names selected from the Select Items dialog, which is displayed when you click on the Browse button.  By
 default, only elementary items can be set.

OCCURS items are processed according to the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the following
 table:

Checked Specify a data item name with a subscript.

Not checked Specify a data item name without a subscript.

Search Direction

 Select Search Forward or Search Backward to search from the current cursor position.  The default setting is Search Backward.  Data at the current
 cursor position is included in the search.



Search

Allows the user to set information for Search processing. Search processing checks data being edited for a specified character string or numeric value. 
  Only the specified data item will be searched.

Note:  See the Precautions for Display and Operations.
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Field Descriptions

Search Character String

 Specify a character string or numeric value to be searched for, or select from the five most recent searches. The recent searches are selectable until Data
 Editor is exited. The Search Character String specification depends on the data item attribute:

CharacterType Attribute

Simply specify a character string.

 Numeric Type Attribute

Specify this item as "comparison operator + numeric value".

 As a comparison operator, one of the following five can be specified:

 "="(equal to), ">"(greater than), "<"(less than), ">="( greater than or equal to), and "<=(less than or equal to). You can omit "="(equal to).

Example: Searching for data greater than or equal to 500 >=500

 A sign and a decimal point can be specified. A value without a sign will be assumed to be a positive number. A sign that is input for the data attribute
 without a sign will be ignored.

 When a comparison operator is specified, do not leave a blank at the beginning or between comparison operators.

Examples of errors:
 " >=500" (A blank at the beginning)
 "> =500" (A blank between comparison operators)

Search Item Name

Specify the name of a data item to be searched. The Default Value is set to the name of the item currently selected by the cursor in the Record Format
 View or the Table Format View.
 Press the Browse button to select an item from the list of items in the Select Item dialog box. The specified data item name must be an exact match.

The Search Item Name field only accepts item names selected from the Select Items dialog, which is displayed when you click on the Browse button. 
 Only elementary items can be set.

 The handling of OCCURS items depends upon the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the following
 table:

Checked Specify a data item name with a subscript.

Not
 Checked

Specify a data item name without a subscript.



Case-sensitive

Specify whether to treat upper and lower case letters as different characters. The default setting is Case-sensitive enabled. This becomes effective when
 the data item of the character type attribute is retrieved.

Search Direction

 Specify the search direction, Search Forward or Search Backward, starting from the present cursor position. The default setting is Search Forward, with
 all data between the cursor and the end of the search string  included in the retrieval object.  



Search the hexadecimal data

Allows the user to input information for Search for Hexadecimal Data processing, which searches the data being edited for a specified hexadecimal value.
 All extracted or edited data will be searched unless search data is specified.  If a display item for Select Items is selected, only this data will be searched.

Note:  See the Precautions for Display and Operations.
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Field Descriptions

Hexadecimal Data

 Specify a hexadecimal value to be searched for, or select from the five most recent searches. The recent searches are selectable until Data Editor is
 exited.

Specify Search Item

 Specify whether to search all data items or a specific data item for the hexadecimal value.  If no data item is specified, all of the data currently being
 edited will be searched.  If a data item name is specified, only that data item will be searched.  
 The Browse button allows you to select from the list of data items in the Select Item dialog box.  The specified data item name must be an exact match.

The Search Item field only accepts item names selected from the Select Items dialog, which is displayed when you click on the Browse button.  Only
 elementary items can be set.

The handling  of OCCURS items depends upon the setting of the Show OCCURS Items checkbox in the Select Items dialog as indicated in the following
 table:

Checked Specify a data item name with a subscript.

Not Checked Specify a data item name without a subscript.

Search Direction

 Specify the search direction, Search Forward or Search Backward, starting from the present cursor position. The default setting is Search Forward, with
 all data between the cursor and the end of the search string  included in the retrieval object.  Search rules apply if a data item to be searched is specified.



Select Data File

The Select Data File dialog box displays format information, data file information, edit modes of the data file, and the extraction methods.

Screen Image

Title Bar

Select Data File  Access mode when COBOL IO was selected in the Work Environment
 tab of the Environment Setup dialog box.

Select Data File (Binary)  Access mode when BINARY was selected in the Work Environment tab
 of the Environment Setup dialog box.

Fields

Data File Name

Folder Displays the path name of the data file.

File
 Name

Displays the file name of the data file.

Data File Edit Mode

   Select Update, View, or Add.

Data File Setup

    Click the Data File Setup button to change the settings of data file information, format information, etc.

Format Information

File
 Name

Displays the format file name.

Record
 Name

Displays the record name of the format.

Length Displays the record length of the format.

File type Displays the file type (COBOL library, Layout Definition File).



BINARY Displays the setting of the Binary Option in the Analysis Option section of the Environment Setup dialog box COBOL Library Analysis
 Method tab.

Select
 Items

 Used to select data items to edit or view. Click the Select Items button to display the Select Items dialog box. Select items can also be
 changed in the Record Format View. When the data file organization is line sequential and the code system is Unicode, the Select Items
 button is disabled.

Data File Information

File Org Displays the data file organization.

Format Displays the record format of the data file.

Length Displays the record length of the data file (maximum record length).

Minimum Displays the minimum record length of the data file.  A value is displayed in this field only for variable length format indexed files.
 Otherwise, 0 is displayed.

Key Info Record key information applies only to indexed files. Click the Browse button to display the Key Information dialog box.

Code Displays the code system of the data file.

Select Record Range

   Select Record Range is enabled only when the data file Edit Mode is Update or View. Select All, Selection, or Data Condition.  Click the Setup button
 when Selection or Data Condition is selected. The following is displayed, depending on whether Selection or Data Condition is displayed.

Selection 1. If Selection is selected, the Record Range dialog box is displayed when the Setup button is pressed.

2. Specify the first record and the last record in the Record Range dialog box.

3. Click OK. The cursor returns to the Select Data File dialog box.

Data Condition 1. If Data Condition is selected, the Set Conditions dialog box is displayed when the Setup button is pressed.

2. In the Set Conditions dialog box, you can specify conditions, and you can add, update, and delete items in the Final Condition List.

3. Click OK. The cursor returns to the Select Data File dialog box.

Note: Data conditions cannot be set for the Layout Definition File.

Comment

   Displays the content of the comment that was entered in the Comment field in the Data File Setup dialog box when the file was first created.



Select Item

Allows the user to specify a data item name. For the Search for Item Name processing, the specified data item name is displayed at the top of the screen.

Note:  See the Precautions for Display and Operations.
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Field Descriptions

Specify Item Name

Specify the name of a data item to be displayed.  The specified data item name must be an exact match.

You may select for display only the items previously selected by the Select Items dialog box. By default, only elementary items are displayed.

The Show OCCURS Items checkbox setting in the Select Items dialog box determines how OCCURS items are displayed/entered:

Checked Specify a data item name with a subscript.

Not Checked Specify a data item name without a subscript.

Select Item

Displays the list of data items defined in the COBOL library or the layout definition file. You can select the name of a data item in the list.

This list shows the items that you specified in the Select Items dialog box.



Select Items

This screen is used to choose the data items to be displayed and edited. Additional items can be selected by incrementing the OCCURS phrase.  Items are
 displayed in the Record Format View and the Table Format View according to the settings in the Select Items dialog box, which is accessible only from
 the Record Format View.

Screen Image

Select Items is not normally used in the following circumstances:

Screen Format
 Type

Displayed Item Item which can be edited

Record Format View Record/Group Item/Basic
 Item

Basic Item Only

Table Format View Basic Item Basic Item Only

 When the OCCURS phrase is used, all items of the array, (1)-array (maximum value), are selected.

The redefine item has not been selected.

Select Items Fields

Record Format

The Record Format drop down list contains all of the level records defined in the COBOL library associated with the data file. Select the record definition
 you wish to use. The items contained in the record are displayed in the list box below.

Show OCCURS items

This checkbox is enabled only when an item with an OCCURS phrase exists in the COBOL library.  Checking this check box results in all OCCURS
 groups to be displayed. Unchecking this box results in the display of only the first group.

Select items to be displayed

Select the items to be displayed from the list of items. The list contains all the items in the selected record with OCCURS items expanded or not,



 according to the Show OCCURS items check box.

The list is dsplayed as follows:

- Displays all items in the record selected by Record Format Specification.

- Displays according to the setting of OCCURS Phrase Progress.

- The redefine item is displayed at the same position as the mark of "R" on the left side, and the definition by the COBOL registration collection file. An
 item displayed in any level greater than one becomes an item to be redefined.

The condition that can be selected is as follows:

- The item which corresponds to a main key in the indexed file has been unconditionally selected.

- When both the basic item included in the group item and the group item are selected, becomes a form from which only the group item is selected.

- When both the redefine item and the item to be redefined are selected, becomes a form from which only the item to be redefined is selected.



Header/Footer (Setup Print Page)

Screen Image

Field Descriptions

Header Information

File Name Specify whether the edit file name is to be printed on the header.  
 The default setting is checked.

Specify character string
Specify whether an additional character string is to be printed on the header.  Input a character string if you want one to
 print.
 The default setting is unchecked.

Print Date Specify whether the print date is to be printed on the header.
 The default setting is checked.

Print Time Specify whether the print time to be is printed on the header.
 The default setting is checked.

Footer Information

Page Number Specify whether the page number is to be printed on the footer.
 The default setting is checked.

Code

Specify whether the code information is to be printed on the footer.
 The default setting is checked.
 When the code system is Unicode and the item is a National character item (N item), endian order information is output. The
 output format is Data File Mode/Hexadecimal Display. For example, UnicodeBE/Big Endian is output.



Margin (Setup Print Page)

Screen Image

Field Descriptions

Setup of Page Margins

Top Specify the top margin size in units of millimeters.  The default setting is 25mm.

Bottom Specify the bottom margin size in units of millimeters.  The default setting is 20mm.

Left Specify the left margin size in units of millimeters.  The default setting is 10mm.

Right Specify the right margin size in units of millimeters.  The default is setting is 10mm.

Note:  See the Precautions when Printing.



Page (Setup Print Page)

Screen Image

Field descriptions

Printer name Displays the printer name.

Properties  Click to change the selected printer name.

Font  Specify the font of the printed character string.  The default setting is Courier New 9 point.

Note:  See the Precautions when Printing.

Paper Size Displays the printed size of the form.

Orientation Displays the vertical or horizontal orientation of the printed form.



Setup Data Editor (Setup Print Page)

Screen Image

Field Descriptions

Print Record Range

Starting record

Specify the starting record number for the data to be printed. The default is 1.

Ending record

Specify the ending record number for the data to be printed. The default setting is the number of records loaded in Data Editor. The specification of "0"
 means the final record.

Print deleted records

Specify whether records deleted by the data edit are to be printed. The default setting is unchecked.

Format

Include hexadecimal values

Specify whether the hexadecimal data content is also to be printed. The default setting is unchecked.

Print in standard format

Specify whether to print according to each item attribute, using delimiters and column labels. The default setting is "checked".

Print underlines

Specify whether underlines are to be printed in the data content. The default setting is unchecked.

Print header/footer

Specify whether the header and footer are to be printed. The default setting is checked.

Print record number

Specify whether the record number is to be printed. The default setting is checked.
 When this box is checked, select to print record numbers on All Pages or only on the Top Page.  The default setting is All Pages.

Print record status



Specify whether the status of each record (update/add/delete etc.) is printed. The default setting is checked.

This checkbox is unavailable when Print in standart format is unchecked.



Specify Record Number

This screen is used to specify the number of the record whose data is to be displayed. The content of the record data.
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Field Description

Record Number

Specify the record number. A "0" indicates that the final record is to be displayed.



Specifying Format Files

This screen is used to select the COBOL library or the layout definition file used to format data.
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Field Descriptions

 Displays only the file types which can be specified for a data format.

Files of type

 The file types that are displayed depend on the selection in the Files of type field of COBOL Analysis Options (Environment Setup):

- COBOL library (*.CPY;*.COB;*.CBL;*.COBOL)

- Layout definition file (*.LAY)



Unicode Edit

 This dialog box is used to view and edit Unicode data. The item at the cursor location is the item being edited.
 The Unicode edit function works only for data of X items (alphanumeric characters) and N items (national characters).

Screen Image

Field Descriptions

Item name

Displays the data item name of display/edit object.

 Data contents

Displays the contents of the item being edited.  If the item contains any line-feed codes, it will be displayed over two or more lines.

Select Font

 Click the Font button to change the display font using the Font dialog box.

Cursor location

 The cursor position is displayed in the upper right corner of this screen. Cursor location is presented in the format of "current position / number of
 characters" in number of characters.



Print File (Showing Record Items)

 Document Image

 Explanation

The user can print a print form described in this section by making the following selections in the Setup Data Editor screen in the Setup Print Page menu
 item.

 - Do not check Include Hexadecimal Values.
 - Check Print in Standard Format.

 Header

The header is composed of the data file name, an optional user specified character string, and print date and time that can be printed on each page.

 To output the header information, select the Print Header/Footer check box in the Format area in the Setup Data Editor (Setup Print Page) dialog box,
 and then select the items you want to output in the Header area in the Header/Footer (Setup Print Page) dialog.

 Any character string exceeding one page when printed as the header is omitted.

 Heading Part

A Data Item name, Data Item attribute, and relative position can be printed. The Data Item attribute and relative position are printed as displayed in the
 Table Format View.

 Details Part

Record Number

The number printed is the same as the record number displayed on the screen.  The following print formats can be set
 in the Setup Data Editor screen of the Setup Print Page dialog.

 -  Print Record Number : Enabled/Disabled
 -  Print on                  : All Pages/Top Page

Status The edit status is printed as shown on the screen. The status is printed only on the first page of a record. The user can
 enable or disable printing of the record number in the Setup Data Editor screen of the Setup Print Page dialog.

Data Contents

The data contents are printed with each data item delimited, in a standard format. As with the display format, the data
 contents are printed in a format matching the respective data item attribute,  and data is printed after being converted
 to ASCII.
 The user can enable or disable printing an underline in the Setup Data Editor settings screen of the Setup Print Page
 menu item.

Termination Symbol The symbol (<!), indicating the end of a record, is printed at the end of a record.

 Footer



 Page number and the data file code information can be printed. If the records are longer than can be printed on the page width, the records will be printed
 on consecutive pages with the horizontal direction prioritized.  The user can input print specifications in the Setup Data Editor screen of the Setup Print
 Page menu item and Header/Footer tab.



Print File (Showing record items with hexadecimal values)

 Document Image

 Explanation

The user can print a print form described in this section by making the following selections in the Setup Data Editor screen in the Setup Print Page menu
 item.

 - Check the Include Hexadecimal Values checkbox.
 - Check the Print in Standard Format.

 Header

The header is composed of the data file name, an optional user specified character string, and print date and time that can be printed on each page.

 Any character string exceeding one page when printed as the header is omitted.

 Heading Part

A Data Item name, Data Item attribute, and relative position can be printed. The Data Item attribute and relative position are printed as displayed in the
 Table Format View.

 Details Part

Record Number

The number printed is the same as the record number displayed on the screen.  The following print formats can be set
 in the Setup Data Editor screen of the Setup Print Page dialog.

 -  Print Record Number :Enabled/Disabled
 -  Print on                  :All Pages/Top Page

Status The edit status is printed as shown on the screen. The status is printed only on the first page of a record. The user can
 enable or disable printing of the record number in the Setup Data Editor screen of the Setup Print Page dialog.

Data Contents

The data contents are printed with each data item delimited, in a standard format. As with the display format, the data
 contents are printed in a format matching the respective data item attribute,  and data is always printed after being
 converted to ASCII.

 The user can enable or disable printing an underline in the Setup Data Editor settings screen of the Setup Print Page
 menu item.

Hexadecimal Data

Each data character is printed in hexadecimal format two characters long. As with the display format, the data contents
 are printed in a format matching the respective data item attribute. The Data is printed showing the file contents
 exactly as it is stored.

 The user can enable or disable printing an underline in the Setup Data Editor settings screen of the Setup Print Page
 menu item.

Termination Symbol The symbol (<!), indicating the end of a record, is printed at the end of a record.



 Footer

 Page number and data file code information can be printed. If the records are longer than can be printed on the page width, the records will be printed
 on consecutive pages with the horizontal direction prioritized.  The user can input print specifications in the Setup Data Editor screen of the Setup Print
 Page menu item and Header/Footer tab.



Print File (No record items)

 Document Image

 Explanation

The user can print a print form described in this section by making the following selections in the Setup Data Editor screen in the Setup Print Page menu
 item.

 - Do not check Include Hexadecimal Values.
 - Do not check Print in Standard Format.

 Header

The header is composed of the data file name, an optional user specified character string, and print date and time that can be printed on each page.

 Any character string exceeding one page when printed as the header is omitted.

 Details Part

Record Number

The number printed is the same as the record number displayed on the screen.  The following print formats can be set
 in the Setup Data Editor screen of the Setup Print Page dialog.

 -  Print Record Number :Enabled/Disabled
 -  Print on                  : All Pages/Top Page

Data Contents

The data contents are printed with each record. The data contents are printed in a format matching the respective data
 item attribute, and data is printed after being converted to ASCII.

 The user can enable or disable printing an underline in the Setup Data Editor settings screen of the Setup Print Page
 menu item.

Termination Symbol The symbol (<!), indicating the end of a record, is printed at the end of a record.

 Footer

A page number and data file code information can be printed. If the records are longer than can be printed on the page width, the records will be printed
 on consecutive pages with the horizontal direction prioritized.  The user can input print specifications in the Setup Data Editor screen of the Setup Print
 Page menu item and Header/Footer tab.

 Graduation

Prints the graduation in ten bytes. This corresponds to a data relative position for each record.



Print File (No record items, with hexadecimal values)

 Document Image

 Explanation

The user can print a print form described in this section by making the following selections in the Setup Data Editor screen in the Setup Print Page menu
 item.

 - Check Include Hexadecimal Values.
 - Do not check Print in Standard Format.

 Header

The header is composed of the data file name, an optional user specified character string. and print date and time that can be printed on each page.

 Any character string exceeding one page when printed as the header is omitted.

 Details Part

Record Number

The number printed is the same as the record number displayed on the screen.  The following print formats can be set
 in the Setup Data Editor screen of the Setup Print Page dialog.

 -  Print Record Number :Enabled/Disabled
 -  Print on                  : All Pages/Top Page

Data Contents

The data contents are printed with each record, with no column headings. The data contents are printed in a format
 matching the respective data item attribute, and data is printed after being converted to ASCII.

 The user can enable or disable printing an underline in the Setup Data Editor settings screen of the Setup Print Page
 menu item.

Termination Symbol The symbol (<!), indicating the end of a record, is printed at the end of a record.

Footer

A page number and data file code information can be printed. If the records are longer than can be printed on the page width, the records will be printed
 on consecutive pages with the horizontal direction prioritized. The user can input print specifications in the Setup Data Editor screen of the Setup Print
 Page menu item and Header/Footer tab.

 Graduation

Prints the graduation in ten bytes. This corresponds to a data relative position for each record.



Numeric Items and Display Formats

Data Item Attribute

Data Editor handles the following data items as numeric items:

- External decimal item.

- External decimal item (LEADING).

- External decimal item (TRAILING).

- External decimal item (LEADING SEPARATE).

- External decimal item (TRADING SEPARATE).

- Internal decimal item (PACKED-DECIMAL).

- Internal decimal item (COMP-3).

- Binary item (BINARY).

- Binary item (COMP).

- Binary item (COMP-4).

- Binary item (COMP-5).

- Pointer item.

Default Value

When a new numeric item is created or a record is added, the Default Value is set to 0 (zero).

Input Specification

Characters that can be Input:   0 through 9, +, -, and "."  only

Number of Digits that can be Input: Upper limit depends on the item attribute.

Inputting a Sign

- A sign must be input at the beginning or at the end.

- Only one sign can be input.

- A sign that is input for an unsigned item is ignored.

- "+" is added to a signed item whose sign is omitted.

Inputting a Decimal Point

- Input a decimal point so that the number of digits will not exceed the range specified in the item attribute, unless both the integer and decimal parts are
 0.

- Only one decimal point can be input.

- A decimal point can be input for an item without a decimal point as long as the decimal part is 0. In this case, only the integer part is valid.

- A decimal point can be omitted from an item with a decimal point as long as the number of digits in the integer part falls within the allowable range for
 the item attribute, or is 0 because the input value is handled as an integer.

- The input position of the sign must be first or last.

Display Specification

Items are displayed in a format conforming to the respective numeric item attributes. The display format also differs depending on the specification of the
 environment settings. Zeros are suppressed in numeric items in the display format. The following is an example of a display format:

Examples:

Attribute Value Zero Suppress Do Not Zero Suppress

No Sign and Decimal point 9(4)
0 0 0000

123 123 0123

With Sign S9(4)
0 +0 +0000

123 +123 +0123

With Decimal point V9(4)
0 0 0.0000

0.123 0.123 0.1230



With Sign and Decimal point SV9(4)
0 +0 +0.0000

0.123 +0.123 +0.1230

If the numeric part is not valid, a numeric error occurs. For the external decimal item attribute, the numeric value is recognized by the low-order four
 bits. For any other attributes, the entire item is processed as 0 if an error occurs. However, an error is not always managed in this manner.

Example of external decimal:
    A character "A" (0x41): Recognized as "1".
    A character "J" S(0x4A): Recognized as "0" (because it is over 9).

Stored Data Format

Data is stored in a format conforming to the respective numeric item attribute defined in the COPY clause.



Alphanumeric Items and Display Formats

Data Item Attribute

Data Editor manages the following as alphanumeric items:

- Alphabetic item

- Alphanumeric item

- Alphanumeric edited item

- Index data item

- Numeric data item

- Group item (if items have been selected with Select Items)

 Default Value

When a new item is created or a record is added, the Default Value (NULL or BLANK) is set on the screen. The Default Value is the value that you set in
 the COBOL Embedded Characters area in the Work Environment (Environment setup) dialog.

 Input Specification

Characters that
 can be input:

Normal-width characters, em-size characters, combination of normal-width/em-size charaacters.

Number of digits
 that can be input:

Any number of digits can be input. However, the number of digits is checked to be in accordance with the item attribute when
 your input is confirmed.

 Display Specification

 The stored data is displayed in the format in which it is stored.  However, the display format depends on the specification of the environment settings
 (COBOL pad characters of the work environment).

- If a NULL is set
    Data that consists of blanks only, or character strings followed by blanks, is displayed without removing the blanks.

Example)

Item Attribute Data Content Display Content

X(5) "" ""

X(5) "     " "     "

X(5) "ABC  " "ABC  "

- If a blank is set
    Data that consists of blanks only or character strings followed by blanks is displayed after removing the blanks.

Example)

Item Attribute Data Content Display Content

X(5) "" ""

X(5) "     " ""

X(5) "ABC  " "ABC"

 See the Precautions for Display and Operations.

Stored Data Format

  The input data is stored in the format in which it is input. However, with regard to the pad characters, the stored data format depends on the specification
 of the environment settings (COBOL pad characters of the work environment).

- If a NULL is set
    If the input character string has fewer digits than the maximum specified in the item attribute, the empty digits are padded with NULL characters.

- If a blank is set
   If the input character string has fewer digits than the maximum specified in the item attribute, the empty digits are padded with blanks.



Floating-point Items and Display Formats

Data Item Attribute

Data Editor manages the following as floating-point items:

- External floating-point items

- Single-precision internal floating-point items (COMP-1)

- Double-precision internal floating-point items (COMP-2)

 Default Value

When a new item is created or a record is added, the Default Value is set to NULL on the screen.

 Input Specification

Characters that
 can be input:

Normal-width characters, em-size characters, a combination of normal-width/em-size characters.

Number of digits
 that can be input:

External Upper limit depends on the item attribute.

COMP-
1

Maximum of four digits.

COMP-
2

Maximum of eight digits.

 Display Specification

The data is displayed in the format in which it is stored.

Stored Data Format

 Data is stored in the format in which it is input. If the input data has fewer than the maximum number of digits, the unused digits are padded with NULL
 characters.



Boolean Items and Display Formats

Data Item Attribute

Data Editor manages the following as Boolean items:

- Internal Boolean item (BIT)

- External Boolean item (DISPLAY)

 Default Value

When a new item is created or a record is added, the default value is equal to the number of digits padded with 0s.

 Input Specification

Characters that can be input: Only 0 or 1 can be input.

Number of digits that can be input:  The upper limit depends on the item attribute.

 Display Specification

Character string expressed as 0 and 1.

Stored Data Format

Data is stored in a format conforming to the respective Boolean item attribute defined in the COPY clause. If the input data has a fewer number of digits
 than the maximum, the unused data is padded with 0s.



Character Code Conversions

 Data Editor supports Data Files in ASCII and EBCDIC.  Since data displayed on the screen is in ASCII, Data Files in some other code systems must be
 converted before the files can be displayed or stored.  The following are system code converting patterns:

 Display Processing

Input Output

EBCDIC >> ASCII

Unicode >> ASCII

 Storage Processing

Input Output

ASCII >> EBCDIC

ASCII >> Unicode

Code conversion

Data Editor supports both ASCII and EBCDIC. In Data Editor, a non-character code in the same code system causes an error.  If both the source and
 destination code systems are ASCII, a tab character (0x09) does not cause an error.

 EBCDIC and ASCII code conversions that differ from the general code conversion specification are provided below.

 Replacement by alternative characters

EBCDIC (Kana) b (4F) ’ (4A) I (5A) Ê (5F)

ASCII ] (5D) [ (5B) * ! (21) * ^ (5E)

*: "[" and "!" of ASCII are interchanged in typical code conversion.

 Conversion of lowercase alphabetical characters

EBCDIC (Kana) 
-> ASCII

uppercase alphabetic characters -> uppercase alphabetic characters

ASCII 
-> EBCDIC (Kana)

uppercase alphabetic characters -> uppercase alphabetic characters

lowercase alphabetic characters -> uppercase alphabetic characters



Data Description Formats

 Details of the display form of each item attribute defined in the COBOL library file or the Layout Definition File are as follows:

PICTURE Definition Screen Display Format

A X(1) A

X X(1)

XA99AX X(6)

99/99 #X(5) 9

\\\,\\9 #X(7)

N N(1)

NBN #N(3)

G(10) DISPLAY-1 N(10)

9 9(1)

999999999999999999 9(18)

S9 S9(1)

9V9 9(1)V9(1)

9(4) PACKED-DECIMAL 9(4) PD

9(4) COMP-3 9(4) C3

9(4) BINARY 9(4) B

9(4) COMP 9(4) C

9(4) COMP-4 9(4) C4

9(4) COMP-5 9(4) C5

1(8) DISPLAY 1(8) D

1(8) BIT 1(8) B

+9.9E+99 9(8) E9(E)

COMP-1 9(4) C1

COMP-2 9(8) C2

POINTER 9(9) P

INDEX X(4)

Notes:

Even if the SIGN Clause is specified for a numeric item (with sign), the sign information is not displayed.

When the display item is selected by Item Select, "FG" may be written in the attribute column to indicate that it is a group item.



Toolbar

The toolbar buttons perform the functions shown below. The numbers indicate the positions of the icons within the toolbar, from left to right.

File 1 Create a new data file

2 Open an existing data file

3 Save as a new data file

4 Save and close the data file

5 Close the data file

6  Print

7 Print preview

Record 8 Undo changes to the current record

9 Append record(s)

10 Copy record(s)

11 Delete record(s)

Search 12 Display the specified record

13 Display the first record in the file

14 Display the record before the current record

15 Display the record after the current record

16 Display the last record in the file

View 17 Switch to record format view

18 Switch to table format view

19 Select items to display

20 Hexadecimal edit

Options 21 Environment Setup

22 Link to Data Converter

 Help 23 Display the Help Topics window



Status Bar

The Status Bar displays information about the file being edited, and provides messages explaining functions and buttons under the pointer.

 The Status Bar presents the following information:

 Item Explanation

 ORGN Displays the organization of the file being edited : SEQuential / LINE sequential / INDeX / RELative

 ATTR Displays whether the records are FIXed or VARiable length.

 MODE Displays the edit mode : UPDaTe / VIEW / ADD

 Code Information Displays the type of character encoding scheme of the data file opened : 
 [ASCII] / [EBCDIC] / [UnicodeBE] / [UnicodeLE] / [Unicode/UCS2BE] / [Unicode/UCS2LE] / [Unicode/UTF8]

 Message Used for displaying messages.  Whenever the pointer is over a toolbar button or menu function the message gives an
 explanation of the function.

 Cursor Position The cursor position of the Edit box is displayed in the form of "Current position / Total attribute length".



Shortcut Keys

Data Editor provides the following keyboard shortcuts:

File (F)

Ctrl + O Selects "Open Data File"

Ctrl + S Selects "Save and Close Data File"

Ctrl + P Selects "Print"

Record (R)

Ctrl + Z  Selects "Undo"

Ctrl + A Selects "Append"

Edit (E)

Ctrl + H  Selects "Hexadecimal Edit"

Locate (L)

F7  Selects "Previous Record"

F8  Selects "Next Record"

F5  Selects "First Record"

F6  Selects "Last Record"

Ctrl + F  Selects "Search"

Shift + F3  Selects "Previous"

F3  Selects "Next"

Ctrl + I  Selects "Search for Item Name"

Ctrl + M  Selects "Replace"



General Precautions

The following are general precautions to be applied when using Data Editor.

1. Forcibly Terminating Windows

While Data Editor is running, terminating Windows may corrupt a file being manipulated.

2. Recovering Data from a Data File

If an error occurs in the system, Data Editor, or related software executed during a file operation using Data Editor, the recovery processing may be
 disabled and data in a file may be corrupted.  If an indexed file is corrupted without a backup copy, perform file recovery processing using the COBOL
 File Utility supplied with Fujitsu COBOL.

3. Free Disk Drive Space

 Ensure that the disk drive that contains the data file has sufficient free space. A backup copy should be made, since data can be lost if insufficient disk
 space is encountered during a save.

4. COBOL Library (COPY Clause)

The COBOL library (COPY clause) used to manipulate a data file must be syntactically correct.

5. Information Settings of a Data File

The user may not be able to open a file if it has a different organization and attributes compared to the actual file.

6. Exclusive Use of a file

If a file being used by Data Editor is used by another application at the same time, a malfunction may occur.

7. Folder in Which to Create a Work File to be Used by Data Editor

The following files are created in this folder. Be sure to secure sufficient space for this folder.

- Work File for File Manipulation: Requires twice as much space as the file to be manipulated. To add or copy large amounts of data, the required work
 space is 2 x file size + Number of data entries to be added or copied x Record length x 2.

- Error File: A file containing errors occurring during COPY clause analysis will be output.

8. Number of Records that can be edited

You can edit (add, modify, or delete) up to 100,000 records at a time. If you edit a data file that has more than 100,000 records, split your editing into
 several sessions, wiht each editing session having 100,000 records or fewer. 
 You can specify the number of records that you want to edit in the Select Record Range area in the Select Data File dialog box.

9. If the COBOL library and a Data File have different Record Lengths

If COPY clause record
 length > Data file record
 length

The portion of data exceeding the COPY clause record length can be input, but it will be discarded.

If COPY clause record
 length < Data file record
 length

The portion of data exceeding the COPY clause record length cannot be input.

For an additional record, the portion of data exceeding the COPY clause record length is set to NULL characters.

For "Copy Record", the portion of data exceeding the COPY clause record length is not copied but set to NULL
 characters.

If, in the indexed file, the key is defined in a portion exceeding the COPY clause record length, Add Record or Copy
 Record cannot be executed in the Record Format View.

10. Information File

If different folders contain data files with the same file name, each folder uses the same information file.

11. When the Data View is not displayed

 Some menu items (File, View, and Help) are disabled when the Data View is not displayed in the lower right section of the Data Editor screen due to a
 window size reduction, etc. 



12. Checking Free Disk Space When Saving Data

Data Editor checks free disk space when saving data. If a data file is to be saved to the drive where the Windows system has been installed, the following
 problems may occur because no correct value can be obtained:

- A message appears, indicating that the data cannot be saved although there is sufficient free disk space.

- Data is saved although there is not sufficient free disk space.  In this case, as many records of data as possible are saved.



Precautions for Display and Operations

The following describes precautions on screen display contents and operations.

1. Alternate Characters

Data for which a code conversion error has occurred in the Record Format View or Table Format View is displayed using the following alternate
 characters:

- Alphanumeric Item : "_" (underscore)

2. About the editing operation

- For the Record Format View, the Table Format View or when Edit of hexadecimal edit screen is performed, the cursor position is displayed. When you
 select a range of characters in a character string, the cursor position is displayed at the beginning of the range.

- When the length of an item exceeds the number of dislplay columns, the part that exceeds the display columns is shown on a new line. When this
 occurs, the cursor is positioned at the left side of the new line.

3. Indexed Organization File

- For an indexed file in which duplicate prime keys are allowed, storage order range extraction cannot be selected.

- Up to four alternate keys may be defined when created.

- The number of items that can be specified as keys when created conforms to the definitions in the Key Information Setting screen (less than 255
 characters).

- If keys are allocated to signed numeric items, the records are in the order of absolute values.

- If a record format is changed and key items have non-matching relative positions and data lengths, a malfunction will occur.  The same rule applies if an
 item containing a key is changed using the Select Items function.

- You cannot edit the data of key items in indexed organization files using the Hexadecimal Edit bar.

4. When the code system of the line sequential organization treats the data file of Unicode

When a line sequential file contains Unicode:

- All item attributes must be National characters when treated as UCS2 code.

- All item attributes must be other than National characters when treated as UTF8 code.

5. Environment Settings
    Information file folder, work file folder, and backup file folder:

- Do not specify the root drive. Specify a subfolder.

- Use a file system that supports long file names.

- Use an absolute pathname, not a relative pathname, for the specification.

6. Undo

- Undo is disabled when another record is displayed or when a menu item is being executed.

- Undo is disabled if no data has been changed.

7. Changing the Font

- A character size from 6 through 26 can be set.

- The font color setting in the View > Font dialog box is ignored.

8. Hexadecimal Edit

- An item with the BIT attribute cannot be handled.

- The value may shift by the specification of the SYSTEM for items that exceed 2000 bytes.

- The Cursor Placement on the Hexadecimal Edit Bar is displayed by the form of "Current position/Attribute length" (The Unit of Measure: Byte Count).

9. Data Converter Linkage

Common for Import and Export

- If the record format has a variable length, the Data Converter Linkage is disabled.

- The number of items that can be handled depends on the Data Converter specification.



Import

- The import of the data file form is not supported.

- This function is disabled if the user has selected display items using Select Items.

- This function is disabled if the file being edited has an indexed or relative organization.

- The code system of the CSV file should be ASCII.

Export

- An OCCURS clause is always expanded regardless of the setting of Show OCCURS Items in Select Items.

- Records to be output Include those deleted using "Delete Record".

10. Search

A code conversion error occurs with the data when the code system of the data file is EBCDIC, and Unicode is not correctly retrieved. 
 The following data items cannot be handled:

- Floating-point item (COMP-1, COMP-2, external floating-point item)

- Internal Boolean item (BIT)

The following character cannot be specified in search character strings:

- "_" (Underscore)

If the COPY clause and a data file have different record lengths, the following applies. The same rule also applies to the variable length record format.

If COPY clause record length <
 Data file record length

The user cannot specify a data item corresponding to a relative position exceeding the data file record length
 (not displayed in the list of the Select Items dialog box).

If COPY clause record length <
 Data file record length

The user cannot search the portion of data exceeding the COPY clause record length.

11. Search for Hexadecimal Data

Matching data that extends over two or more data items is not assumed to be a match.

The following data item cannot be handled:

   - Internal Boolean item (BIT)

   The following describes the specification used if the COPY clause and a data file have different record lengths. The same rule also applies to the
 variable length record format.

If COPY clause record length > Data
 file record length:

The user cannot specify a data item corresponding to a relative position exceeding the data file record length
 (not displayed in the list of the Select Items dialog box).

If COPY clause record length < Data
 file record length:

The user cannot search the portion of data exceeding the COPY clause record length.

12. Search, Search for Hexadecimal Data and Previous and Next

   The cursor is placed in a matching data item. Thus, the cursor is placed only once in a data item even though the data item contains multiple matching
 character strings and values.

13. Search Item Name

   The following describes the specification used if the COPY clause and a data file have different record lengths. The same rule also applies to the
 variable length record format.

If COPY clause record length > Data
 file record length:

The user cannot specify a data item corresponding to a relative position exceeding the data file record length
 (not displayed in the list of the Select Items dialog box).

14. Extraction by specification of data condition

Up to ten data extraction conditions can be specified.

The items which cannot be specified for the data condition are:

- Floating-point item



- Internal Boolean item (BIT)

- External Boolean item

- Item not selected by Select Items (group item when Select Items is default)

- When the record length of the data file is longer than the record length of the format, an item located in the area where the record length of the data file
 is exceeded.

When the access method is a binary access, the data condition cannot be extracted.

15. Data Generation/Generat Item Values

- The number of characters that can be specified for the format is 128 bytes or less.

- The number of characters that can be specified for a start value and an end value is 128 bytes or less, including the comma. etc.

- The range of values that can be specified for an increment value is "-9" to "+9".

- Up to five digits can be specified for format %s and %S.

- Up to 18  digits can be specified for format %D and %U.

- Up to 3 fixed parts can be specified for an alphanumeric character. The upper limit is not in the variable part.

- For each format definition, only one fixed part and one variable part can be specified.

- Up to 100 formats can be specified.

The items which cannot be processed by Data Generation/Generate Item Values are the following:

- Pointer item

- Floating-point item

- Boolean item

- N item

- Relative record number of relative organization

- Item not selected by Select Items (Group item when Select Items is default)

- When the record length of the format is longer than the record length of the data file, an item located in the area where the record length of the data file
 is exceeded.

16. Table Format View

   To confirm a value entered in an item, move the cursor or press the Enter key.
    Performing any other processing before confirming your input discards the input data.

17. Replace

The precautions concerning the retrieval apply correspondingly to "10. Search".

- The length of the retrieval character and the replacement character is assumed to be the same. It is an error for "Retrieval Character" < "Replace
 Character", or "Retrieval Character" > "Replace Character"

- When the retrieval substitution for the character string is executed, check the attribute of the item of the retrieval character string and the replacement
 character string.

- The Replacement processing of the key item of an indexed or relative organization is not done.

- The replace function only works for data of X items (alphanumeric characters) or N items (national characters).

18. Replace the hexadecimal data

The precautions concerning the retrieval apply correspondingly to "11. Search for Hexadecimal Data".

- The length of the retrieval character and the replacement character is assumed to be the same. It is an error for Retrieval Character < Replace Character,
 or Retrieval Character > Replace Character.

- When the hexadecimal retrieval replacement is executed, if the input data causes a code conversion error by the replacement character string, it will not
 be done because of the error.

- The Replacement processing to the key item of an indexed or relative organization is not done.

- The replace function only works for data of X items (alphanumeric characters) or N items (national characters).



Precautions with Copy Libraries

When data is manipulated in a data file, the COBOL COPY clause is analyzed to create record format information.  The following are precautions
 concerning the COPY clause.

Commonness

Number of Items

The maximum number of item definition statements is 9,999, excluding comment lines and 01-level items.  If the OCCURS clause specification is used,
 the number of definition statements generated will be equivalent to the OCCURS repetition number.

COBOL COPY Library

1. Describing the COBOL library to be handled

The COPY clause must be correctly described in terms of COBOL syntax.

2. Nested COBOL library

When the COPY clause in nested files is analyzed, all referenced files must exist in the same folder.

3. The following COBOL specifications may NOT be used in the COPY clause:

- OCCURS DEPENDING ON Clause

- REDEFINES Clause in the 01 level

- TYPE / TYPEDEF Clause (supported when Fujitsu COBOL compiler is used)

- Temporary original (parentheses etc.) (supported when a COBOL compiler is used)

4. Data Editor ignores the following specifications if they occur in the COBOL library:

- Item with level number 77

- Item with level number 66 or 88

- BASED ON Clause

- JUSTIFIED Clause

- BLANK WHEN ZERO Clause

- RENAME Clause

- KEY IS Clause

- VALUE Clause

- VALUE NULL Clause

- Symbol and symbol constant with the condition name VALUE

- PRINTING POSITION Clause

- CHARACTER TYPE Clause

- SYNC Clause

5. Notes of specification in description of COBOL library:

- Numeric edited items and alphanumeric edited items are treated as alphanumeric items.

- The INDEX specification of the USAGE Clause is handled as X(4).

- An external floating-point item is handled as an alphanumeric item.  A pad character is always set to "NULL" regardless of the "COBOL Pad
 Character" setting in the environment settings (work environment).

- A pointer data item is handled in the same way as the "PICTURE 9(9) COMP-5" specification.  However, the attribute column displays "9(9)P".

- The COMPUTATIONAL-1 and COMPUTATIONAL-2 attributes are handled as "PICTURE X(4)" and "PICTURE X(8)" attributes, respectively. 
 However, a pad character is always set to "NULL" regardless of the "COBOL Pad Character" setting in the environment settings (work environment).

- A currency symbol is not supported.

- The COMPUTATIONAL-4 and COMPUTATIONAL05 attributes are handled in the same way as a binary item.  However, as for the internal
 representation of the storage space of COMPUTATIONAL-5, the low address byte position represents the low-order digits and the high address byte
 position represents the high-order digits.

- The item for which the number of digits of 32,767 or more is specified cannot be treated.



6. COPY Clause without an 01-level Item

When the COBOL library is analyzed and no 01-level item is found, the record name Data Editor-ADDREC is added automatically.

7. USAGE Clause Specification in a Group Item

If a group item has a USAGE Clause, all basic items are displayed as follows:

- Binary item    :B
 - Internal decimal item :PD

8. BIT Attribute Item Containing the OCCURS Clause Specification

Data Editor cannot process a BIT attribute item which contains the OCCURS Clause Specification, nor a group item containing the OCCURS Clause that
 contains a BIT attribute item.  If a COPY clause containing such an item is encountered, the results of the operation cannot be guaranteed.

9. Redefining a Redefining Item

Data Editor cannot process a redefining item that is also a redefined item.

10. Handling a Basic Item of Binary Data

Compilation Option "BINARY"
    The "BINARY (WORD, MLBON)" specification is not supported.  An unsigned binary item is always handled as if "BINARY (WORD, MLBOFF)"
 is specified.

Layout Definition File

1. Description

This file should be an ASCII file created by the Layout Definition File function of the Data Converter utility.

2. Level Number

Each item is treated as a basic item defined at the 02 level.

Items within the OCCURS item will be defined at lower levels (04, 06, 08....).

3.Data Editor will disregard the following specifications

- Multiple formats.

- More than 01 level specification.



Precautions with Data Files

The following describes precautions on handling a data file.

1. Record Length

A file with a maximum record length of 32,760 bytes can be processed.

2. Exclusive Use of a File

Exclusive control is exercised on files being used by Data Editor. If such a file is shared by another program, Data Editor may not operate normally.

3. Unsupported Files

- 0-byte files cannot be processed.

- A data file with a full pathname exceeding 255 characters cannot be processed.

- If the access method is "binary access", files greater than or equal to 2 GB cannot be processed.

4. Files with Fixed-length Record Format

The following precautions exist for a fixed-length record whose record length specified in the Data Generation dialog box is different from the actual file
 record length.

- The final record cannot be updated.

- Records cannot be added, deleted, or copied.

- The data will be displayed incorrectly.

5. Line Sequential Files

- If a line sequential organization file contains an item with a COMP, PACKED-DECIMAL, or BIT attribute, a malfunction may occur.

6. Indexed Files

An abnormal bit occurring while an indexed file was being updated may corrupt the data file. In this case, perform recovery processing using COBOL
 File Utility.

7. Unicode Files

- National characters are treated as UCS2 (Little Endian) code, and alphanumeric items are treated as UTF8 code.

- The record format cannot be changed, and neither group items nor redefining items can be selected in the Select Items dialog.

- Data Editor supports only line sequential files with UCS2 (little endian) or UTF8 codes. 

     - Only National characters can be used with UCS2 (Little Endian) code.

   - Only non-National characters can be used with UTF8 code.

- For indexed files, if the main key information does not correspond to a relative position of item information and length, it cannot be updated with Data
 Editor.



Precautions when Printing

The following are precautions for printing and print preview.

1. Printing in General

- Up to 1,500 data items can be handled.

- Data can be printed only as displayed in the Table Format View. Printing data as displayed in the Record Format View is not supported.

- No extracted records can be printed.

- If Data Editor is activated multiple times on the same machine, a memory shortage may occur.

- Specify the printer resolution at 300 dpi or more. If the resolution is set to 240 dpi or less, data may not be printed exactly as shown in the preview
 screen.

2. Margin

- The user can set the top, bottom, right, and left margins to 0 through 50mm.

3. Font

- Font sizes 6 through 26 are supported.

- Only fixed-pitch fonts are supported and displayed in the list.

- Unless a WYSIWYG font is specified (one that looks the same displayed and printed), data may not be printed as shown on the preview screen.

4. Line Spacing and Data Item Interval

Line spacing One quarter of the font character size

Data Item Interval  Two blanks (if data items are delimited when printing)

5. Hexadecimal Printing

- If fewer than three lines remain to be printed, including both regular print lines and hexadecimal print lines, these lines are printed on the next page.

- An internal Boolean item (BIT) is printed as a '-' (hyphen).

6. Paper for Printing

Although paper sizes other than the following are indicated as "Unknown" in "Paper Size" of "Print Page Settings Property", they can be used for
 printing.

- Letter (8 1/2 x 11 inc)
 - Legal (8 1/2 x 14 inc)
 - A4 sheet (210 x 297 mm)
 - A3 sheet (297 x 420 mm)
 - A4 small sheet (210 x 297 mm)
 - A5 sheet (148 x 210 mm)
 - B4 sheet (250 x 354 mm)
 - B5 sheet (182 x 257 mm)
 - C sheet (17 x 22 inc)
 - D sheet (22 x 34 inc)
 - E sheet (34 x 44 inc)
 - Letter Small (8 1/2 x 11 inc)
 - Tabloid (11 x 17 inc)
 - Ledger (17 x 11 inc)
 - Statement (5 1/2 x 8 1/2 inc)
 - Executive (7 1/2 x 10 1/2 inc)
 - Folio (8 1/2 x 13 inc)
 - Qurrto (215 x 275 mm)
 - 10 x 14 inc sheet
 - 11 x 17 inc sheet
 - Note (8 1/2 x 11 inc)
 - #9 Envelope (3 7/8 x 8 7/8 inc)
 - #10 Envelope (4 1/8 x 9 1/2 inc)
 - #11 Envelope (4 1/2 x 10 3/8 inc)
 - #12 Envelope (4 3/4 x 11 inc)
 - #14 Envelope (5 x 11 1/2 inc)



 - DL Envelope (110 x 220 mm)
 - C5 Envelope (162 x 229 mm)
 - C3 Envelope (324 x 458 mm)
 - C4 Envelope (229 x 324 mm)
 - C6 Envelope (114 x 162 mm)
 - C65 Envelope (114 x 229 mm)
 - B4 Envelope (250  353 mm)
 - B5 Envelope (176 x 250 mm)
 - B6 Envelope (176 x 125 mm)
 - Italy Envelope (110 x 230 mm)
 - Monarch Envelope (3 7/8 x 7 1/2 inc)
 - 6 3/4 Envelope (3 5/8 x 6 1/2 inc)
 - US Std Fanfold (14 7/8 x 11 inc)
 - German Std Fanfold (8 1/2 x 12 inc)
 - German Legal Fanfold (8 1/2 x 13 inc)

7. Header and Footer

Any character string exceeding one page when printed as the header or footer is omitted.

8. Subheading

A subheading is printed only if data items are delimited. The attribute and relative position indicated as a subheading are printed if they are displayed on
 the screen.

9. Record Number

A printed record number corresponds to that displayed on the screen. If a deleted record is not to be printed, the corresponding record number is skipped.

10. Printing Data without Delimiters

- COBOL libraries including consecutive BIT items not divisible by 8 are not supported.

11. Variable-Length Record

A variable-length record is printed based on the length in which the data format exists (COBOL library record length).

12. If the COBOL library and a Data File have Different Record Lengths

If COBOL library record length >
 Data file record length:

No subheading (data item name, attribute, and relative position) is printed for the portion having no data.

If COBOL library record length <
 Data file record length:

No data  is printed for the portion having no data format in the COBOL library.

13. Continuation of a Character String through Multiple Pages

If a character string is too long for a single page, it is printed on multiple pages.

14. Printer

If a printer that does not support Windows is used, data may not be printed as shown in the preview screen.



 These messages appear when you operate Data Editor. Helpful information will be added to a message depending
 on your operation.

 10001: Error writing information files (.LNC files) folder registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10002: Error writing workfiles folder registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10003: Error writing COBOL embedded characters setup registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10004: Error writing edit mode registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10005: Error writing backup file creation registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10006: Error writing library analysis, source program registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10007: Error writing library analysis, library registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10008: Error writing library analysis, case sensitivity registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10009: Error writing library analysis, tab code use registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10010: Error writing library analysis, character code registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10013: Error writing code conversion information, conversion object code system registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.



 10017: Error writing message display registry during record operations of indexed/relative organization files.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10018: Error writing zero suppress of integer item registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10019: Environment setting information (editor name used when the COPY phrase errored) could not be saved in
 the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10020: Environment setting information (backup file making folder) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10021: Environment setting information (list form screen: maximum display width) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10022: Environment setting information (record format screen: item name display width) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10023: Environment setting information (analysis method) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10024: Environment setting information (analytical option: treatment of a binary item) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10025: Environment setting information (addition character string to the method of analyzing the format and the
 COPY sentence) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10026: Environment setting information (addition character string to the method of analyzing the format and the
 COPY sentence) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10027: Environment setting information (code type of code conversion information and the line sequential file)



 could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10028: Environment setting information (hexadecimal display form of code conversion information and Japanese
 item (UCS2)) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10029: Environment setting information (work environment and size of COBOL file) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10030: Environment setting information (working environment and access method) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10031: Environment setting information (server information, host name) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10032: Environment setting information (server information, port number) could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10033: Environment setting information (server information, server's current directory) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10034: Environment setting information (transfer, maximum number of items at transfer) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10035: Environment setting information (working environment and access method) could not be saved in the
 registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.

 10036: Environment setting information (Display Format and Display of information at connection destination)
 could not be saved in the registry.
 [Explanation] An error occurred while trying to save Environment information in the registry.
 [User response] This may be caused by insufficient disk space on the Windows(R)/Windows NT(R) system. Check
 the amount of free disk space.



 10101: Could not find the specified folder. Please specify it again.
 [Explanation] An attempt to save the file has failed because the specified folder does not exist.
 [User response] Verify that the specified folder exists. With Data Editor, files cannot be saved to the drive root.
 Make sure you create a folder and save the file in that folder.

 10102: No write access to the specified folder for local file. Specify the save folder again.
 [Explanation] An attempt to save the file has failed because the user has insufficient permissions to write to the
 specified folder.
 [User response] Either make sure that the user has write access permissions for the target folder, or save to another
 folder for which such permissions have been granted.

 10103: Attempt to save a file in an existing folder with no write access. Specify the save folder again.
 [Explanation] An attempt to overwrite the existing file has failed because the user has insufficient permissions to
 write the file.
 [User response] Either make sure that the user has write access permissions for the existing target file, or save to
 another file for which such permissions have been granted.

 10201: The full path of the test case file exceeded the limitation. Please shorten the file name of the data file.
 [Explanation] The name of the test case file (including the drive name and folder names) exceeds the maximum
 length.
 [User response] The length of the test case file name is affected by the data file name and the folder in which the
 test case file is saved: the name of the folder (full path) in which the test case file is saved + the name of the data file
 + 4 (the .LNC extension for the test case files).

 10203: Could not save the file because there was no writing authority for the specified folder.
 [Explanation] An attempt to save the file has failed because the user has insufficient permissions to write to the
 specified folder.
 [User response] Check the access permissions for the specified folder.

 10204: Could not update the file because there was no writing authority in the specified file.
 [Explanation] An attempt to update the specified file has failed, since the user has insufficient permissions to write
 to the file.
 [User response] Check the access permissions for the specified file.

 10206: The file is already open in Data Editor. Please specify the another data file name.
 [Explanation] The specified data file is currently open.
 [User response] Specify another data file name.

 10207: Cannot open the file because it is in use by other applications. Please end the other applications.
 [Explanation] The specified data file is already in use by another application.
 [User response] Close the data file in the other application, and then open it in Data Editor.

 10211: The specified file already exists. Overwrite this data file?
 [Explanation] The specified data file has already been saved. Would you like to overwrite it?
 [User response] To overwrite the file, choose "Yes". Otherwise, choose "No" and specify another file name.

 10212: The specified file already exists. Overwrite the Data Editor control file?
 [Explanation] The specified test case file has already been saved. Would you like to overwrite it?
 [User response] To overwrite the file, choose "Yes". Otherwise, choose "No" and specify another data file name.

 10301: The data file will exceed 2GB if saved with the added or inserted records. The binary access can read/write
 data files up to 2GB. Please save the data file after deleting the added or inserted records.
 [Explanation] The data file will exceed 2GB if saved with the added or inserted records. The binary access can
 read/write data files up to 2GB.
 [User response] Please save the data file after deleting the added or inserted records.

 10302: If the added or inserted record is saved, the size of the data file will exceed 2GB. The COBOL linkage



 version can transfer data files up to 2GB. Delete the record you added or inserted and save the data file.
 [Explanation] If the added or inserted record is saved, the size of the data file will exceed 2GB. The COBOL
 linkage version can transfer data files up to 2GB.
 [User response] Delete the record you added or inserted and save the data file.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 20001: Insufficient memory for this operation. Close other applications and then retry the operation.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other open applications and try the operation again. If this does not work, try restarting
 Windows(R)/Windows NT(R).

 20002: Cannot find the specified record. Please check the specified record position.
 [Explanation] An out-of-range value was specified.
 [User response] Specify a value greater than 1 but less than the total number of records, or 0.

 20003: Cannot copy the record. Please check the specified record position.
 [Explanation] An out-of-range value was specified for the record position.
 [User response] For the record positions, specify a value greater than 1 but less than the total number of records, or
 0.

 20008: Cannot find the record data. Data may have been lost. Close the process and re-start from the main window.
 [Explanation] A discrepancy exists between the data and memory information.
 [User response] Contact a Fujitsu service engineer (SE).

 20009: Internal file access error. Data may have been lost. Close the process and re-start from the main window.
 [Explanation] A discrepancy exists between the data and memory information.
 [User response] Contact a Fujitsu service engineer (SE).

 20010: Duplicate key value. Please re-enter the key value.
 [Explanation] An existing value was entered for a record key for which duplicates are not allowed.
 [User response] Enter a new record key value.

 20011: Cannot create control.
 [Explanation] An attempt to create a control failed, due to a memory shortage.
 [User response] Reboot Windows(R)/Windows NT(R), and try the operation again.

 20014: Error in the specified record position. The total number of records is shown.
 [Explanation] An out-of-range value was specified.
 [User response] Specify a value greater than 1 but less than the total number of records, or 0.

 20015: Internal process error.
 [Explanation] An internal error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 20016: Updated data will be lost. Continue with Undo?
 [Explanation] The currently displayed record will be reverted to its previous data. Would you like to continue?
 [User response] None

 20017: Data has been updated. Do you want to save the changes?
 [Explanation] Data has been updated. Would you like to save it?
 [User response] None

 20018: Please enter the key value.
 [Explanation] Data has not been entered for the matching record key items.
 [User response] Enter data for the record key item.

 20019: First record.
 [Explanation] The currently displayed record is the first record.
 [User response] None



 20020: Last record.
 [Explanation] The currently displayed record is the last record.
 [User response] None

 20021: Cannot delete control.
 [Explanation] An internal error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 20022: Duplicate key error. The duplicate record is ignored.
 [Explanation] The record you are trying to add has an existing record key. Therefore, the record will be ignored.
 [User response] None

 20023: Failure to undo changes to the record.
 [Explanation] An error occurred during record re-processing.
 [User response] This may be due to insufficient disk space for the folder specified for "Folder to create Data Editor's
 work files" in the Environment. Check the amount of available disk space.

 20024: Key item.
 [Explanation] Since the specified item is a record key, its data cannot be modified.
 [User response] None

 20025: Duplicate relative record number. Please re-enter the relative record number.
 [Explanation] The input relative record number already exists.
 [User response] Enter a value not yet specified as a relative record number.

 20026: Please enter the relative record number.
 [Explanation] Input a relative record number.
 [User response] Enter a relative record number.

 20027: Relative record number.
 [Explanation] The specified item cannot be processed because it is a relative record number.
 [User response] None

 20028: Save the item view setting?
 [Explanation] Would you like to save the information of the selected items in the test case file?
 [User response] None

 20029: The relative record number is out of range. Enter a number between 1 and 99999.
 [Explanation] The specified relative record number is erroneous.
 [User response] Specify a value from 1 to 99999.

 20030: Internal file access error. Insufficient disk space.
 [Explanation] The disk specified in "Folder to create Data Editor's work files" in the Environment does not have
 sufficient free space.
 [User response] Either specify another folder for "Folder to create Data Editor's work files" in the Environment, or
 free space on the disk, and try again.

 20031: Performing this operation saves your changes to records so you cannot Undo them. Continue?
 [Explanation] When you add to a record, you cannot return the record to it's previous state.
 [User response] None

 20032: Specified file already exists. Please specify a new file name.
 [Explanation] Even though a data file was created, an existing file was specified.
 [User response] Enter a new file name.

 20033: The information file (.LNC) does not match information obtained from the COBOL library. Select another
 library.



 [Explanation] A discrepancy exists between the test case file and the format information in memory.
 [User response] In the test case settings dialog box, perform format file parsing again.

 20034: Error in the input record length.
 [Explanation] The input record length is erroneous.
 [User response] Specify a value between 1 and the maximum record length (test case selection dialog box : record
 length for data file information). For indexed files, specify a value larger than the smallest record length.

 20035: Duplicate relative record number. Duplicate record ignored.
 [Explanation] The input relative record number already exists.
 [User response] Enter a value not yet specified as a relative record number.

 20037: Data Editor is already running.
 [Explanation] Data Editor is already running, and two instances cannot run concurrently.
 [User response] For concurrent execution, execute with the EXE argument "-d".

 20038: The number of records exceeds the maximum number (100,000).
 [Explanation] The maximum number of modifiable records (100,000) has been exceeded.
 [User response] Either use the retrieval conditions in the test case selection dialog box to reduce the number of
 records to modify, or modify records in the add mode.

 20039: This item cannot be edited in the hexadecimal edit function.
 [Explanation] The BIT attribute item cannot be modified as a hexadecimal.
 [User response] None

 20040: Insufficient disk space for saving the data. Deleting unnecessary records or allocate more disk space.
 [Explanation] Insufficient disk space for saving the data. 
 [User response] Allocate more disk space and try again.

 20041: Abnormal termination of retrieval.
 [Explanation] An error occurred during search processing.
 [User response] Contact a Fujitsu service engineer (SE).

 20042: The corresponding data was not found.
 [Explanation] The corresponding data could not be found.
 [User response] None.

 20044: The format to generate data was not specified. The corresponding data was not found.
 [Explanation] The format to generate data was not specified. The corresponding data was not found.
 [User response] Choose "No" to auto-create data. Otherwise, choose "Yes".

 20045: Data generation failed.
 [Explanation] An error occurred during the data creation processing.
 [User response] Free more disk space and try again.

 20046: A data generation error occurred. Review the error file?
 [Explanation] An error occurred during data creation processing. Would you like to see detailed error information?
 [User response] See the error information, and try performing data creation settings again.

 20047: Failure in loading the generated data.
 [Explanation] An error occurred while the created data was being loaded.
 [User response] Check the data creation settings.

 20048: Failure in loading the generated data. Review the error file?
 [Explanation] An error occurred while the created data was being loaded.
 [User response] Review the error information and check the data creation settings.



 20049: Failed to obtain information needed for data creation. The data was not auto-generated.
 [Explanation] Information needed to auto-generate the data could not be obtained.
 [User response] Contact a Fujitsu service engineer (SE).

 20050: No format information to auto-generate data.
 [Explanation] No format information was found to use in auto-generating data.
 [User response] Provide format information for auto-generating the data.

 20051: An error occurred while auto-created data was loaded, but no error information was output to the error file.
 [Explanation] An error occurred while auto-created data was loaded, but no error information was output to the
 error file.
 [User response] This may be caused by insufficient disk space for the folder specified for "Folder to create Data
 Editor's work files" in the Environment. Check the amount of free disk space.

 20061: Not in the record length range at 01 levels for which the index key is specified. Cannot add/copy the record
 because it cannot set the value in the index key.
 [Explanation] Since the specified record format has no specified position format as a record key, no key value can
 be set for the record to add, and record add/copy processing cannot be performed.
 [User response] Specify a separate format when performing add/copy processing.

 20091: The attribute prohibits Unicode editing.
 [Explanation] The item is not Unicode-modifiable.
 [User response] None.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 41001: Problem in the data description in the specified file.
 [Explanation] There is a problem with the attribute of the specified data file. This is displayed when a hidden file,
 system file, volume file, or directory attribute is specified.
 [User response] Check the specified data file.

 41002: The file name cannot be entered because the information files (.LNC) folder name is longer than the
 maximum of 255 characters. Either shorten the folder name or specify another folder.
 [Explanation] The length of the name of the folder in which the test case file is saved is too long for Data Editor to
 handle.
 [User response] Specify a shorter name for "Folder to store test case files" in the Environment, and try again.

 41003: The file name cannot be entered because the workfiles folder name is too long. Either shorten the folder
 name or specify another folder.
 [Explanation] The length of the name of work file creation folder is too long for Data Editor to handle.
 [User response] Specify a shorter folder name for "Folder to create Data Editor's work files "in the Environment,
 and try again.

 41006: Click the Analyze button and select the library that specifies the record format.
 [Explanation] No format file has been set.
 [User response] Set the format file to be used.

 41007: File organization not specified in the data file information.
 [Explanation] No file structure information has been specified for the data file.
 [User response] Specify file structure information for the data file.

 41008: Record format not specified in the data file information.
 [Explanation] No record format information has been specified for the data file.
 [User response] Specify record format information for the data file.

 41009: Record length not specified in the data file information.
 [Explanation] No maximum record length information has been specified for the data file.
 [User response] Specify a maximum record length information for the data file.

 41010: The information files (.LNC files) folder is not setup or access authority may not be set. Please set up the
 information files (.LNC files) folder in environment setup.
 [Explanation] The same as above.
 [User response] Specify a folder for "Folder for Data Editor Information Files (.LNC files)" in the Environment
 setup, and try again.

 41011: The workfiles folder is not set up or access authority may not set. Please set up the folder in environment
 setup.
 [Explanation] The same as above.
 [User response] Specify a folder for "Folder for Data Editor Workfiles" in the Environment setup, and try again.

 41012: Cannot allocate memory for the information files (.LNC files).
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41013: Cannot allocate the Library folder name area.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).



 41014: Cannot allocate the area for the COBOL_WB folder name.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41015: Cannot allocate the information files (.LNC files) name (full path) area.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41016: Cannot allocate the data file (FULL path) area.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41017: Cannot allocate the extraction target file (FULL path) area.
 [Explanation] The memory required to operate Data Editor could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41020: Cannot open the key information area.
 [Explanation] The memory required to operate Data Editor could not be read.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41025: The folder for the specified data file does not exist. Please re-enter the file name.
 [Explanation] The file could not be saved, since the specified folder does not exist.
 [User response] Verify that the specified folder exists. Note that Data Editor cannot handle files in the drive root, so
 you must create a folder and place files in the folder.

 41026: The specified file has zero bytes. It is recommended that you delete the file and specify a new file.
 [Explanation] The specified file is 0 bytes long.
 [User response] Specify another file, or delete the file and try again.

 41027: Cannot access COBOL system software. Cannot continue the process. Confirm the COBOL installation or
 path settings and specify the data again.
 [Explanation] COBOL has not been installed properly.
 [User response] Reinstall COBOL, and try using Data Editor again.

 41029: The folder specified for the new data file does not have write access. Please enable write access or re-enter
 the file name.
 [Explanation] The folder specified for data file creation lacks sufficient write access permissions.
 [User response] Either specify a folder for which write access permissions exist, or apply permissions the specified
 folder, and try again.

 41032: Cannot create the file because the full filename is too long. Please re-enter the file name or change folders to
 create a shorter full filename.
 [Explanation] The length of the specified data file name (folder path name + file name) is too long for Data Editor
 to handle.
 [User response] Shorten the file name or folder name.

 41034: Cannot find the information files (.LNC files). Check the information setup 
 [Explanation] An error occurred which prevented checking for the existence of the test case file.
 [User response] Contact a Fujitsu service engineer (SE).

 41036: Cannot refer to an item in the information file (.LNC file). 
 [Explanation] An error occurred while obtaining format item information from the test case file.



 [User response] Delete the test case file (the file in the folder specified for "Folder to store test case files", in the
 Environment, that has the data file name + .LNC extension).

 41037: Cannot obtain data file information. 
 [Explanation] An attempt to obtain data file information has failed.
 [User response] Verify that the specified data file is an indexed file.

 41038: Cannot allocate the key information area. 
 [Explanation] The memory required for the record key information could not be allocated.
 [User response] Close any other running applications, and try the operation again. If this does not help, restart
 Windows(R)/Windows NT(R).

 41039: Cannot obtain the key information of the indexed file. 
 [Explanation] Record key information could not be obtained.
 [User response] Verify that the specified data file is an indexed file.

 41040: Failure in the item setup for the information file (.LNC file). 
 [Explanation] An error occurred while setting format item information in the test case file.
 [User response] Restart Windows(R)/WindowsNT(R), and try again.

 41041: Cannot create analysis table. 
 [Explanation] An error occurred while creating format item information. 
 [User response] Restart Windows(R)/WindowsNT(R), and try again.

 41042: Cannot extract the data from the data file. 
 [Explanation] An attempt to read the data file has failed.
 [User response] Verify that the data file information set in the test case settings dialog is correct. Also verify that
 record numbers are within the retrieval conditions specified.

 41046: The number of extracted record exceeds the maximum of 100,000. Extract up to the maximum number of
 records.
 [Explanation] The number of records in the specified data file exceeds the maximum number of records modifiable
 in Data Editor (100,000). Only the first 100,000 of these records will be modifiable.
 [User response] To modify more than 100,000 records, either use the retrieval conditions in the test case selection
 dialog box to reduce the number of records to modify, or modify in the add mode.

 41048: Since the library length is shorter than the record length, the record operation will not work. Add or copy
 cannot be done in the record format screen. Continue the operation?
 [Explanation] The same as above.
 [User response] To add/copy records, specify the format for the item corresponding to the key.

 41049: The backup file folder was not created or the access authority is not set. Please specify the backup file folder
 in the environment setting.
 [Explanation] The same as above.
 [User response] Specify a folder for "Folder to create backup files" in the Environment, and try again.

 41051: The full path of the backup file exceeded the limitation. Please shorten the file name or path.
 [Explanation] The full path name of the backup file folder is too long to for Data Editor to handle.
 [User response] Specify a shorter folder name for "Folder to create backup files" in the Environment, and try again.

 41052: The number of retrieved records exceeds the maximum number of 100,000. Only the first 100,000 records
 will be displayed.
 [Explanation] The number of retrieved records has reached 100,000. Data Editor will select the first 100,000
 records.
 [User response] If the number of records to modify exceeds 100,000, use the condition settings to reduce the
 number of records.



 41061: Access rights are not set for the specified data file folder. Please notify the system administrator and acquire
 access rights for the folder.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41063: Access rights are not set for the specified test case storage folder. Please notify the system administrator and
 acquire the access rights for the folder.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41064: Access rights are not set for the specified work file folder. Please notify the system administrator and
 acquire the access rights for the folder.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41066: Access rights are not set for the test case file. Please notify the system administrator and acquire the access
 rights for the test case storage folder.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41067: Access rights are not set for the backup file. Please notify the system administrator and acquire the access
 rights for the backup file folder.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41068: The backup file is read-only. Please grant write authority to the backup file.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41071: There an error in the format file analysis. Please exit and re-launch Data Editor.
 [Explanation] Same as above.
 [User response] Follow the instructions in the message.

 41072: National and non-national characters cannot occur in the same file format when Unicode is used.
 [Explanation] When the character encoding is Unicode and the file format is line sequential, only national items or
 non-national items can be used.
 [User response] Specify a file of only national items or non-national items.

 41073: When UCS2 is used, the file must have only national character items.
 [Explanation] When the character encoding is Unicode (UCS2), and the file format is line sequential, the format
 must consist of only national items.
 [User response] Specify a file of only national items.

 41074: When UTF8 is used, the file must have only character items.
 [Explanation] When the character encoding is Unicode (UTF8), and the file format is line sequential, the format
 must consist of non-national items.
 [User response] Specify a file of only non-national items.

 41075: The relative position and length information of the specified key does not match that of the format data item.
 Try to set key information from the test case setting.
 [Explanation] The relative position and length information of the specified key does not match that of the format
 data item.
 [User response] Set key information that matches the relative position and length information of the format data
 item.

 41076: Analysis table was not made. Please analyze the format file from the test case setting again.
 [Explanation] The same as above.



 [User response] Re-analyze the format file.

 41077: The test case file may be abnormal. Please delete and analyze the test case file again. Delete the test case
 file?
 [Explanation] The same as above.
 [User response] To delete the test case file, choose "Yes", and recreate the test case file.

 41078: An older version of COBOL cannot use the data file specified for Unicode from V60L10. To operate the
 data file of Unicode, install V60L10.
 [Explanation] The installed COBOL is older than V60L10. This version does not support Unicode data files.
 [User response] To use Unicode, install COBOL version V60L10 or later.

 41079: The COBOL file size is set to large file in the environment settings. This setting does not allow access of
 indexed files or relative organization files. Set the COBOL file size to standard file in the environment settings.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 41080: The user does not have authority to update the selected data file. Cannot save the data file. OK?
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 41101: The specified file name or format may be incorrect. The file format may be changed if the record operation
 continues as it is the current state.
 [Explanation] The same as above.
 [User response] Check the COPY statement in the target file, specify a correct COPY statement, and perform
 parsing again.

 41102: A file organization other than sequential was specified, but the access method is binary. Please change the
 file organization in the test case setting.
[Explanation] Binary access can only be used for sequential files.
[User response] To use binary access, change the file organization to sequential.

 41103: A record type other than fixed length was specified, but the access method is binary. Please change the
 record type in the test case setting.
 [Explanation] Binary access can only be used for files with fixed-length record formats.
 [User response] To use binary access, change the record format to a fixed-length format.

 41104: A data extraction condition was specified, but the access method is binary. Please change the extraction
 condition.
 [Explanation] Binary access cannot be used when a "Data condition" is specified.
 [User response] Change the retrieval conditions.

 42002: Cannot save the analysis option file. Check the space available for the workfiles folder.
 [Explanation] An attempt to create a work file has failed.
 [User response] Free more disk space and try again.

 42003: Please specify a COBOL library.
 [Explanation] The format file to use has not been set.
 [User response] Set a format file to use.

 42004: File organization is not specified in the data file information. Please specify the file organization.
 [Explanation] No file structure information has been specified for the data file.
 [User response] Specify the file structure for the data file.

 42005: Record format is not specified in the data file information. Please specify the record format.
 [Explanation] No record format information has been specified for the data file.
 [User response] Specify the record format for the data file.



 42006: Record length is not specified in the data file information. Please enter the record length.
 [Explanation] No maximum record length information has been specified for the data file.
 [User response] Specify the maximum record length for the data file.

 42007: Key information is not set in the data file information. Please set the key information.
 [Explanation] No record key information has been set.
 [User response] Set the record key information.

 42008: Cannot open the key information area.
 [Explanation] The memory required to operate Data Editor could not be released.
 [User response] Close any other running applications, and try the operation again. If this doesn't help, try again after
 restarting Windows(R)/Windows NT(R).

 42009: The specified data file is not an indexed file. Please re-select the file organization.
 [Explanation] The specified data file is not an index organization file.
 [User response] Check the specified data file.

 42011: Specified record length in data file information is out of range (1 - 32760). Please enter a record length
 within the supported range.
 [Explanation] A number out of the range of the data file record length has been input.
 [User response] Input a number from 1 to 32760.

 42012: Cannot read the data file information.
 [Explanation] An attempt to obtain record key information has failed.
 [User response] Check that the specified data file is an index organization file.

 42013: Cannot read the key information for an indexed file.
 [Explanation] An attempt to obtain record key information has failed.
 [User response] Check that the specified data file is an index organization file.

 42014: Cannot set up the item information file (.LNC file).
 [Explanation] An error occurred during processing to set format item information in the test case file.
 [User response] Restart Windows(R)/WindowsNT(R), and try again.

 42015: Analyze the Library ********?
 [Explanation] Would you like to parse the format file ********?
 [User response] None

 42016: Cannot analyze the Library ********.
 [Explanation] An attempt to parse the format file ******** has failed.
 [User response] Correct any syntax errors in the format file.

 42021: The range specified for the key contains multiple records. Please re-enter the key information.
 [Explanation] Record key information is set out of the record range.
 [User response] Perform settings such that the sum of the start position and key length is less than or equal to the
 record length.

 42022: Error information on the COPY phrase analysis result was not able to be saved in the file.
 [Explanation] An error occurred when error information from format file parsing was written to a file.
 [User response] If the folder set in "Folder to create Data Editor's work files" in the Environment contains the
 "Analyze.err" file, check the access permissions for that file.

 42023: Error information on the COPY phrase analysis result was not able to be saved in the file. Please end the
 application for which the error information file is displayed.
 [Explanation] An error occurred when error information from format file parsing was written to a file.
 [User response] If the folder set in "Folder to create Data Editor's work files" in the Environment contains the
 "Analyze.err" file, close the application that is using that file.



 42025: The value less than the length of a minimum record was entered into the record length of the data file
 information. Please enter a record length value that is greater than the minimum record length.
 [Explanation] The value input for the record length is smaller than or equal to the minimum record length.
 A value less than the minimum record length is set in the record length of the data file information. Please set a
 record length value that is larger than the minimum record length.
 [User response] Specify a record length value that is greater than the minimum record length.

 42026: The length of a minimum record of data file information is not input. Please input the length of a minimum
 record.
 [Explanation] The minimum record length for the data file has not been specified.
 [User response] Specify the minimum record length for the data file.

 42027: The range specified for a record key is not contained within the minimum record length defined. Please
 specify the record key again.
 [Explanation] The last relative position of the record key information exceeds the minimum record length.
 [User response] Make adjustments so that the last relative position of the record key information does not exceed
 the minimum record length.

 42032: Cannot obtain the format file because the file name of the format file is too long. Shorten the folder name for
 the work file.
 [Explanation] The full path of the work file exceeds 256 characters.
 [User response] Shorten the specified file name or change the path of the work folder.

 42033: Failed to convert the line feed code of the format file obtained from the server.
 [Explanation] The same as above.
 [User response] Check the code for the format file on the server.

 42034: A file that contains some odd number length records is specified as the line sequential file of Unicode/UCS.
 That file is not suitable as the format file of Unicode/UCS2. Please change the format file.
 [Explanation] The same as above.
 [User response] Either specify a format file for which the record length is an even number, or change the file
 character encoding to something other than Unicode.

 42035: One or more odd numbers are used for the record length of the line sequential file of Unicode/UCS2. Odd
 numbers cannot be used as record lengths for a line sequential file of Unicode/UCS. Please change the record
 lengths.
 [Explanation] The same as above.
 [User response] Either make the record length an even number, or change the file character encoding to something
 other than Unicode.

 42201: Extracting data.
 [Explanation] The data file is being read.
 [User response] None

 42202: Updating data.
 [Explanation] The data file is being updated.
 [User response] None

 42203: Analyzing now.
 [Explanation] The format file is being parsed.
 [User response] None

 43001: No entry for primary key. Please specify a primary key.
 [Explanation] No primary key information has been set.
 [User response] Set the primary key information.

 43002: The key offset was not specified. Please enter the offset.



 [Explanation] The start position of the key has not been input.
 [User response] Input as follows: "key-start-position, key-length".

 43003: The key length not specified. Please enter the length.
 [Explanation] The key length has not been input.
 [User response] Input as follows: "key-start-position, key-length".

 43004: The key offset is not numeric. Please enter a numeric value.
 [Explanation] The specified key start position contains an invalid character.
 [User response] Input as follows: "key-start-position, key-length".

 43005: The key length is not numeric. Please enter a numeric value.
 [Explanation] The specified key length contains an invalid character.
 [User response] Input as follows: "key-start-position, key-length".

 43006: Cannot read the key information area.
 [Explanation] An attempt to obtain record key information has failed.
 [User response] Check whether the specified data file is an index organization file.

 43007: Cannot open the key information area.
 [Explanation] An attempt to release record key information has failed.
 [User response] Restart Windows(R)/WindowsNT(R), and try again.

 43011: The primary key length exceeds 254 bytes. Please specify a length of less than 254 bytes.
 [Explanation] The sum of the primary key lengths exceeds 254 bytes.
 [User response] Make adjustments so that the sum of the primary key lengths does not exceed 254 bytes.

 43012: The range specified for the key contains multiple records. Please re-enter the key information.
 [Explanation] Record key information has been set outside of the record range.
 [User response] Perform settings such that the sum of the start position and key length is less than or equal to the
 record length.

 43013: The secondary key-1 length exceeds 254 bytes. Please specify a length less than 254 bytes.
 [Explanation] The sum of the secondary key 1 lengths exceeds 254 bytes.
 [User response] Perform settings such that the sum of the secondary key 1 lengths does not exceed 254 bytes.

 43014: The secondary key-2 length exceeds 254 bytes. Please specify a length less than 254 bytes.
 [Explanation] The sum of the secondary key ‚Q lengths exceeds 254 bytes.
 [User response] Perform settings such that the sum of the secondary key ‚Q lengths does not exceed 254 bytes.

 43015: The secondary key-3 length exceeds 254 bytes. Please specify a length less than 254 bytes. secondary key-3
 length exceeds 254 bytes. Please specify a length less than 254 bytes.
 [Explanation] The sum of the secondary key ‚R lengths exceeds 254 bytes.
 [User response] Perform settings such that the sum of the secondary key ‚R lengths does not exceed 254 bytes.

 43016: The secondary key-4 length exceeds 254 bytes. Please specify a length less than 254 bytes.
 [Explanation] The sum of the secondary key ‚S lengths exceeds 254 bytes.
 [User response] Perform settings such that the sum of the secondary key ‚S lengths does not exceed 254 bytes.

 43017: An invalid character string was set as a key.
 [Explanation] Unspecifiable characters have been input for the key information.
 Invalid characters have been input for the key information.
[User response] Valid characters include numbers (0-9), commas (,), and slashes (/).

 43018: A relative position or the length of the key is not set.
 [Explanation] The key relative position or key length has not been specified.
 [User response] Input as follows: "key-start-position, key-length".



 43019: Two or more relative positions are set in the key information.
 [Explanation] The key relative position has been specified more than once.
 [User response] Input as follows: "key-start-position, key-length".

 43020: Characters other than the numerical value and the delimitation character are set.
 [Explanation] Unspecifiable characters have been input for the key information.
 Invalid characters have been input for the key information.
[User response] Valid characters include numbers (0-9) commas (,), and slashes (/).

 43021: The repetition permission was set to the key not set. Please set repetition in no permission, whether to set
 key information.
 [Explanation] "Multiple" has been specified for unspecified record key information.
 [User response] Set key information, or clear the "Multiple" check box.

 43022: The range specified for a key is not installed on the length of a minimum record. The length of a minimum
 record is additionally changed within the range of the key.
 [Explanation] The last relative position of the information set for the key exceeds the minimum record length. The
 last relative position of the key will be set for the minimum record length.
 [User response] None

 44004: View Items setup error.
 [Explanation] An error occurred during item selection processing.
 [User response] Restart Windows(R)/WindowsNT(R), and try again.

 44011: The item which was not able to be selected at the same time was selected. Please select the item again. (An
 item name and the offset imformation are shown; in the selected items, an item exists that has the same offset as the
 shown one.)
 [Explanation] Items that cannot be selected simultaneously are specified simultaneously.
 [User response] Reselect the items. Item groups and the basic items that belong to them cannot be specified
 simultaneously. Also, a subject redefinition item and its related redefinition item cannot be specified
 simultaneously.

 44013: Since Unicode is specified as the data file code, the group and redefine data may not be correctly displayed.
 [Explanation] The same as above.
 [User response] It is warning. Please choose "It is" when disregarding a warning. 

 45001: The information files (.LNC files) folder is not setup or access authority is not set. Please specify another
 folder or grant write authority to the folder.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 45003: The workfiles folder is not setup or the access authority is not set. Please specify another folder or grant the
 folder the write authority.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 45007: The code system not specified.
 [Explanation] The same as above.
 [User response] Specify a Code.

 45011: The specified editor is not in an executable form. Please specify the editor again.
 [Explanation] The file specified for the editor is not an executable file.
 [User response] Specify an editor.

 45012: The backup file folder is not set up or access authority is not set. Please specify another folder or grant write
 authority to the folder.
 [Explanation] The same as above.



 [User response] Follow the instructions in the message.

 45015: The character string specified for the backup file folder is a relative path. Please specify an absolute path.
 [Explanation] "Folder to create backup files" is specified with a relative path.
 [User response] Use an absolute path to specify the folder.

 45016: The character string specified for a test case file storage folder is a relative path. Please specify an absolute
 path.
 [Explanation] "Folder to store test case files" is specified with a relative path.
 [User response] Use an absolute path to specify the folder.

 45017: The character string specified for the work file folder is a relative path. Please specify an absolute path.
 [Explanation] "Folder to create Data Editor's work files" is specified with a relative path.
 [User response] Use an absolute path to specify the folder.

 45018: The value specified for "Record formatting window: Display width of item name" is not valid. Please set it
 within the range of 0 or 11-60.
 [Explanation] The value specified for "Record formatting window: Display width of item name" is not valid.
 [User response] Specify 0 (for the maximum display of 60), or a number from 11 to 60.

 45022: The the COPY sentence additional character string was not specified. Please uncheck the additional
 character string checkbox.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 45024: Characters \\ were set for the current directory of the server. Please change the characters containing \\.
 [Explanation] The same as above.
 [User response] Set the current directory on the server in the server information for the Environment.

 45025: Cannot specify a period (.) or periods (..) for the current directory of the server. Change the server's current
 directory.
 [Explanation] The same as above.
 [User response] Set the current directory on the server in the server information for the Environment.

 45026: No host name is set. Set a host name.
 [Explanation] The same as above.
 [User response] Set the current directory on the server in the server information for the Environment.

 45027: Cannot specify a comma (,) in a host name. Change the host name.
 [Explanation] The same as above.
 [User response] Set the current directory on the server in the server information for the Environment.

 45028: Cannot specify successive slashes (/) for the current directory of the server. Change the server's current
 directory.
 [Explanation] The same as above.
 [User response] Set the current directory on the server in the server information for the Environment.

 45031: The file cannot be made for the directory. Please specify the folder.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 46001: Non-hexadecimal characters entered. Input characters 
 0 to 9 and A to F.
 [Explanation] A non-hexadecimal character was specified
 [User response] Input alphanumeric characters 0 to 9 and A to F.

 46002: Insufficient input data. Input %ld characters.



 [Explanation] The input data is not long enough.
 [User response] Input 2 bytes for each character in the data item.

 46003: Hexadecimal character conversion error. Non-hexadecimal characters entered.
 [Explanation] An invalid hexadecimal character was specified.
 [User response] Input alphanumeric characters 0 to 9 and A to F.

 46004: An invalid value was input for the cursor location. Please input a valid value.
 [Explanation] An invalid value was specified.
 An invalid value was input as the cursor location. Please input a valid value.
 [User response] Input numeric characters 0 to 9.

 47001: The last record number is smaller than first record number.
 [Explanation] The end record number is set to be smaller than the start record number.
 [User response] Set a value larger than the start record number. You can also specify 0 (indicating the last record).

 49001: Cannot access the save folder for Data Converter.
 [Explanation] Data Converter was not installed correctly.
 [User response] Reinstall Data Converter, and try using Data Editor again.

 49002: Cannot activate Data Converter.
 [Explanation] Data Converter was not installed correctly.
 [User response] Reinstall Data Converter, and try using Data Editor again.

 49003: Cannot create layout definition file.
 [Explanation] An attempt to create a work file failed.
 [User response] Check that the drive containing the folder set in "Folder to create Data Editor's work files" in the
 Environment has sufficient free space.

 49004: Cannot create the executable indication file.
 [Explanation] An attempt to create a work file failed.
 [User response] Check that the drive containing the folder set in "Folder to create Data Editor's work files" in the
 Environment has sufficient free space.

 49005: Cannot save the data file used for local file creation.
 [Explanation] An attempt to create a work file failed.
 [User response] Check that the drive containing the folder set in "Folder to create Data Editor's work files" in the
 Environment has sufficient free space.

 49006: Cannot create the local file.
 [Explanation] An attempt to create a work file failed.
 [User response] Check that the drive containing the folder set in "Folder to create Data Editor's work files" in the
 Environment has sufficient free space.

 49007: The number of items in the layout definition file exceeds the limit of 500.
 [Explanation] When the number of data items exceeds the limit, Data Converter cannot be linked.
 [User response] Reduce the number of items using the item selection function. For more detail, see the Data Size
 Limits of Data Converter.

 49011: Failed in import.
 [Explanation] An attempt to import the specified data file has failed.
 [User response] Make sure that the specified file is in CSV format.

 49012: Data conversion error on import. Review the error file?
 [Explanation] A conversion error occurred during import processing. Would you like to see the conversion error
 information?
 [User response] Compare the data entered with the item attribute.



 49013: A data conversion error occurred after import. The error file could not be output.
 [Explanation] A conversion error occurred during import processing, 
 but the error information could not be output to a file. [User response] The error file may be in use by another
 application. Close the other application.

 49014: Access authority is not set to the specified CSV file. Please contact the system administrator to acquire
 access authority for the specified CVS file.
 [Explanation] The same as above.
 [User response] None

 49015: Cannot import non-ASCII XML data. Please import an ASCII 
 XML file.
 [Explanation] XML import does not support data files with character encodings other than ASCII.
 [User response] To use XML import, convert the data to ASCII.

 49016: The file to import was not specified. Please specify the file to import.
 [Explanation] The same as above.
 [User response] None

 49017: The file that was specified to import does not exist. Please re-specify the file to import.
 [Explanation] The same as above.
 [User response] None

 49018: Access authority is not set for the specified file to import. Please contact the system administrator to acquire
 the access authority for the file to import.
 [Explanation] The same as above.
 [User response] None

 49019: The layout file was not specified .\nPlease specify the layout file.
 [Explanation] The same as above.
 [User response] None

 49020: The specified layout file does not exist.\nPlease re-specify the layout file.
 [Explanation] The same as above.
 [User response] None

 49021: Access authority is not set for the specified layout file. Please contact the system administrator to acquire the
 access authority for the layout file.
 [Explanation] The same as above.
 [User response] None

 49022: Failed in the interpretation of the layout file. Please redo after confirming the validity of the specified layout
 file.
 [Explanation] The same as above.
 [User response] None

 49023: Can't use the specified layout file to import XML data. Please specify another layout file which import data
 form is \"XML form\" and export data form is \"Data file form\".
 [Explanation] The same as above.
 [User response] None

 49024: Can't use the specified layout file to export XML data. Please specify another layout file which import data
 form is \"Data file form\" and export data form is \"XML file form\".
 [Explanation] The same as above.
 [User response] None

 49025: There are some files on the specified path. Please re-specify another path which has no file. Or specify an



 existing file using radio button.
 [Explanation] The same as above.
 [User response] None

 49026: Failed to load DLLs which relates data import process of Data Converter. Confirm whether Data Converter
 is normally installed.
 [Explanation] The same as above.
 [User response] None

 49027: Failed to get the address of MDApi function which relates data import process of Data Converter. Confirm
 whether Data Converter is normally installed.
 [Explanation] The same as above.
 [User response] None

 49028: Size of the specified file to import is 0Byte. Please re-specify another file to import.
 [Explanation] The same as above.
 [User response] None

 49029: Can't open the error file when importing data because that file is already opened exclusively by another
 application. Please redo this process after shutting the application which is using this error file.
 [Explanation] The same as above.
 [User response] None

 49030: There are some translation error in the process of importing XML file. Now show the error log file.
 [Explanation] The same as above.
 [User response] None

 49031: Failed to inport XML file. The specified file may be not correct as XML file. Please refer the help of Data
 Converter and confirm whether the specified file is a correct XML file.
 [Explanation] The same as above.
 [User response] None

 49032: The current specified COPY phase does not correspond to Data Converter. Please redo this process after
 changing COPY phase.
 [Explanation] The same as above.
 [User response] None

 49033: The folder of the specified layout file dose not exist or the access authority is not set to it. Please confirm the
 folder to change path or contact the system administrator to acquire the access authority.
 [Explanation] The same as above.
 [User response] None

 49044: Import cannot take place, because the number of records being modified reaches 100,000. Close the data
 being modified, and try again.
 [Explanation] The same as above.
 [User response] None

 49045: Range (0-100000) where the specification of the insertion position can be treated with Data Editor is
 exceeded. Please change the specification of the insertion position. 
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 50001: A big value is set from the end record number in the beginning record number.
 [Explanation] The value set for the start record number is greater than the end record number.
 [User response] Set a start record number equal to or less than the end record number. You can also specify the end
 record number to be 0.

 50002: A big value is set from the number of records which exists in the beginning record number. Try to set the
 beginning record number.
 [Explanation] The value set for the start record number is greater than the number of existing records.
 [User response] Specify a number greater than one but less than or equal to the number of existing records.

 50004: A specified character string of the header is not set. Please set the character string or remove the check on
 the specified character string check box.
 [Explanation] In the string specified for the header, the print check box has been checked, but there is no string
 specified for printing.
 [User response] Clear the check box if you do not wish to print. Otherwise, specify a string.

 50005: There is only a deletion record within the range on the specified record.
 [Explanation] The range specified as the "Print range" only contains deleted records.
 [User response] If you only want to print deleted records, check the "Print deleted records" check box in the print
 page setup.

 50101: The area where data was printed was not able to be secured. Please end the processing of the print.
 [Explanation] The memory required for print processing could not be secured. Print processing will be cancelled.
 [User response] This may be due to a memory shortage, or not enough system work space (disk capacity).

 50103: There is only a deletion record within the range on the record specified though the print of the deletion
 record is not specified. Please specify the print of the deletion record from print page setting.
 [Explanation] The range specified as the "Print range" only contains deleted records.
 [User response] If you only want to print deleted records, check the "Print deleted records" check box in the print
 page setup.

 50104: The limitation of the number of items to be able to treat the specified item by processing the print (1500
 pieces) is exceeded. Please decrease and process the number of items by the item selection.
 [Explanation] The number of data items for print processing exceeds the limit.
 [User response] You need to select 1500 or fewer data items when printing using the item selection function.

 50105: Memory shortage occurred by processing the print. Please end the processing of the preview when you
 execute the print preview.
 [Explanation] A memory shortage occurred during print processing.
 [User response] When displaying a print preview, be sure to close the print preview window. If there are multiple
 instances of Data Editor running, or if other applications are running, close them and try again.

 50106: Because the item where data exists is not selected, it is not possible to print. Please select the item where
 data exists in the item selection.
 [Explanation] Since all items have been placed in relative positions exceeding the record length of the data file, no
 printable data exists. Use the item selection function to select fewer items than the data file record length.
 [User response] Use the item selection function to select fewer items than the data file record length., or clear the
 selection.

 50107: A big value is set from the number of prints of maximum pages at the beginning position within the range of
 the print. There is no printed page.
 [Explanation] The same as above.
 [User response] Specify a correct value for the start position.



 50108: A big value is set from the number of prints of maximum pages at the ending position within the range of
 the print.
 [Explanation] The same as above.
 [User response] Specify a correct value for the end position.

 51001: The retrieval character string exceeds the attribute length of the item. Please specify it by length below the
 item length.
 [Explanation] The length of the specified search string exceeds the length of the search target item.
 [User response] Specify a string with a length shorter than or equal to the length of the search target item.

 51002: The item is not specified. Please specify the item name.
 [Explanation] No item name is specified for the search target.
 [User response] Specify an item name.

 51003: The specified item does not exist. Please specify the item name again.
 [Explanation] The specified item name does not exist.
 [User response] Specify a name that is a total match. For repeating items, you will need to include the index.

 51004: The retrieval character string is not specified. Please specify the retrieval character string.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51005: The mistake is found in the specification of the retrieval character string. Please input it according to the
 type of the specified item.
 [Explanation] The specified search string does not match the data format of the search target item.
 [User response] Specify a search string that matched the data format of the search target item.

 51006: The hexadecimal character string is not specified. Please specify the hexadecimal character string.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51007: An incorrect character was specified for a hexadecimal character string.
 [Explanation] A non-hexadecimal character was specified.
 [User response] Input alphanumeric characters 0 to 9 and A to F.

 51008: The specified item is off the subject of the retrieval. Please specify the item name again.
 [Explanation] No data exists in the relative position of the specified item.
 [User response] Specify an item defined within the range of the maximum record length.

 51009: The data of the specified item is not effective. Please confirm the length of the record.
 [Explanation] No data exists in the relative position of the specified item.
 [User response] Specify an item defined in the range of the record length (the length of each record, when records
 are of variable length).

 51010: The number of input characters is odd numbers. Please specify it in two bytes.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51011: Character '_' cannot be specified for a retrieval character string. Please delete these characters.
 [Explanation] The search string contains a black square character (n) or an halfwidth underscore character (_).
 These characters cannot be used to specify a search string.
 [User response] Specify a search string without black square characters (n) or halfwidth underscore character (_).

 51012: The specified item is not a basic item. Please specify the item name again whether to make the item effective
 by the item selection.
 [Explanation] The same as above.
 [User response] Specify a basic item.



 51013: NOT specified the string which replace source string. Please specify the string which replace source string.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51014: Neither the length of the source string for search nor the length of the string for replacing the source are the
 same. Please input these strings so that these lengths become same.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51015: There are some errors in the string which replace source string. Please input the string so that it adapts the
 specified type of the item.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51016: NOT specified the hex data which replace source hex data. Please sepcify the hex data which replace source
 hex data.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51017: Specified invalid hex character string as the hex data which replace source hex data.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51018: The specified item is out of the range of replacing process. Please re-specify items.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51019: Neither the length of the source hex data for search nor the length of the hex data for replacing the source
 are the same. Please input these hex data so that these lengths become same.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51020: The number of the input characters of the hex data for replacing the source is ODD NUMBER. Please
 specify it in multiple of two bytes.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51021: Can't specify these character '_' for replacement. Please delete these characters.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51022: Replaced %d string(s)
 [Explanation] The same as above.
 [User response] None

 51023: Specified same string as the string for search and the string for replacing the source. Please reset these
 strings.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51024: The replaced data will not be able to return to the original data. Do you wish to replace all data, really?
 [Explanation] The same as above.
 [User response] None

 51025: The specified item is key item. Please re-specify another item.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.



 51026: Specified same hex data as the hex data for search and the hex data for replacing the source. Please reset
 these hex data
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51028: The length of the string for replacing source exceeds the length of the attribute of the item. Please specify
 the string whose length is shorter than the length of attribute of item.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51029: The length of the hex data for search exceeds twice the length of the attribute of the item. Please specify the
 hex data whose length is shorter than twice the length of the attribute of the item.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 51030: The length of the hex data for replacing source exceeds twice the length of the attribute of the item. Please
 specify the hex data whose length is shorter than twice the length of the attribute of the item.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53001: The item is not specified. Please specify the item name.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53002: It specifies it contingent on the item name from which the item is not selected. Please set and process the
 item name from which the item is selected.
 [Explanation] Item names not selected by using item selection function are specified in the conditions.
 [User response] Either set item names that are selected by using item selection function, or re-select items by using
 the same function.

 53003: The relative record number was specified for a condition. It cannot specify the relative record number for a
 condition.
 [Explanation] The same as above.
 [User response] None

 53004: The specified item exceeds the length of the record of the user specification. Try to select the item installed
 on the length of the record of the user specification.
 [Explanation] The specified item has been placed in an area exceeding the data file record length.
 [User response] Select an item placed within the data file record length.

 53005: The item of the attribute which was not able to be specified for a condition was specified. It cannot specify
 floating-point item and a Boolean item for a condition.
 [Explanation] The same as above.
 [User response] None

 53006: The comparison operator of a numeric item is set to the condition of the non-numeric item. Please change
 the comparison operator and process it.
 [Explanation] The same as above.
 [User response] Specify a comparison operator for the string item.

 53007: The comparison operator of the non-numeric item is set to the condition of a numeric item. Please change
 the comparison operator and process it.
 [Explanation] The same as above.
 [User response] Specify a comparison operator for the number item.

 53008: The condition value is not set. Please set the condition value.
 [Explanation] The same as above.



 [User response] Specify a condition value.

 53009: The value of the condition value is not correct compared with the attribute of the specified item. Please
 change the condition value or the item name.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53010: The error occurred by the code conversion of the condition value. The value of the condition value is not
 correct compared with the attribute of the item for which is specified. Please change the condition value or the item
 name.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53011: It failed in the preservation of the item selection. Please analyze from the test case setting again and set the
 condition again.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53101: Capacity shortage of the disk occurred at OPEN of the condition extraction file. Please confirm and process
 the capacity of the disk.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53102: The error of the file access prohibition occurred at OPEN of the condition extraction file. Please confirm and
 process setting the condition extraction file.
 [Explanation] The same as above.
 [User response] Check the access permissions for the condition retrieval file.

 53103: The error of the file undefinition occurred at OPEN of the condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53104: The error of illegal passing occurred at OPEN of the condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53105: The error of the excess of the number of opening files occurred at OPEN of the condition extraction file.
 Please end and process other applications.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53106: OPEN of the condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53107: An exclusive error occurred at OPEN of the condition extraction file. Please end and process the application
 which uses the condition extraction file.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53108: The error occurred at OPEN of the condition extraction file. Please confirm and process the condition
 extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53109: Internal processing error. The area in the condition extraction file commonness header has not been released.
 [Explanation] The same as above.



 [User response] Contact a Fujitsu service engineer (SE).

 53110: Internal processing error. As for the condition extraction file, OPEN is not done.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53111: Internal processing error. The area in the condition extraction file commonness header is not acquired.
 [Explanation] The same as above.
 Contact a Fujitsu service engineer (SE).

 53112: It failed from the condition extraction file to reading a common header. Please confirm and process the
 condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53113: Common information on the header of the condition extraction file and the test case file is different. Please
 analyze information on COBOL from the test case set dialog again, and register the condition newly.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53114: Capacity shortage of the disk occurred when it wrote a common header in the condition extraction file.
 Please confirm and process the capacity of the disk.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53115: Failed in writing a common header in the condition extraction file. Please confirm and process the condition
 extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53116: Internal processing error. The area in the condition extraction file condition set part has not been released.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53117: Internal processing error. Failed in the acquisition of the area in the header of the condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53118: Failed from the condition extraction file to reading the condition set part. Please confirm and process the
 condition extraction file.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53119: Internal processing error. The area in the condition extraction file condition set part is not acquired.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53120: Capacity shortage of the disk occurred when it wrote the condition set part in the condition extraction file.
 Please confirm and process the capacity of the disk.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53121: Failed in writing the condition set part in the condition extraction file. Please confirm and process the
 condition extraction file. 
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).



 53122: Internal processing error. The area in the condition extraction file commonness header failed in acquisition.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 53123: As much as one condition is not registered though the extraction by the data condition is specified. Please
 register the condition by starting the condition set dialog from set button.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53124: Information on the item is different though there is an item name specified for a condition. Please register
 the condition by starting the condition set dialog from set button again.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53125: The specified condition extraction file has the problem in the attribute. Please delete and process the
 condition extraction file.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53126: There is no writing right in the condition extraction file. Please give and process the writing right to the
 condition extraction file.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53127: Version information on the condition extraction file is different. Please delete and process the condition
 extraction file.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 53128: The access right limit is not set in the condition extraction file. Please notify system administrator and
 acquire the access right limit of the file under the test case storage folder.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 54001: A connection to the server has already be established.
 [Explanation] The same as above.
 [User response] None

 54002: No host name is set. Set the host name in the Environment.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 54003: No port number is set. Set the port number in the Environment.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 54005: No user ID is set. Set the user ID.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 54006: No password is set. Set the password.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 54008: An attempt to initialize COBOL access processing has failed. Disconnect from the server.
 [Explanation] An attempt to initialize COBOL access processing on the server failed.
 [User response] Disconnect from the server, and check with the server administrator that COBOL is installed



 properly.

 54050: Disconnect from the server.
 [Explanation] The same as above.
 [User response] None

 54051: An attempt to terminate COBOL access processing has failed.
 [Explanation] The same as above.
 [User response] None

 54100: An attempt to obtain the wide area has failed.
 [Explanation] The same as above.
 [User response] None

 55001: Processing could not be performed, since the directory path name is too long.
 [Explanation] The path of the target file is longer than 512 characters.
 [User response] To use the target file, change the file name / directory.

 55002: Processing could not be performed, since the file name is too long.
 [Explanation] The file name of the target file is longer than 256 characters.
 [User response] To use the target file, change the file name.

 55003: An invalid path is specified for the file name. Paths that include directories cannot include those within the
 current directory.
 [Explanation] The set file name contains characters that cannot be specified.
 [User response] Specify only the file name.

 55004: An attempt to perform code conversion has failed.
 [Explanation] Code conversion failed for the file name.
 [User response] Check the start code of the Data Editor server.

 55005: Processing could not be performed, since the full path of the work file name is too long.
 [Explanation] The path of a work file created by internal processing is longer than 256 characters.
 [User response] Change the work folder, and try again.

 55006: An attempt to access the work file has failed.
 [Explanation] An attempt to access a work file used for internal processing has failed.
 [User response] Check the access permissions for the work folder.

 55009: No file name was specified.
 [Explanation] The same as above.
 [User response] Specify a file name

 55010: The specified file name does not exist.
 [Explanation] The same as above.
 [User response] None

 55011: The specified file name already exists.
 [Explanation] The same as above.
 [User response] None

 55012: The file name contains space characters.
 [Explanation] File names cannot contain null characters.
 [User response] Specify a file name that does not contain null characters.

 55013: The file name contains characters that cannot be used on the client.
 [Explanation] The same as above.



 [User response] Do not specify a file name that contains characters that cannot be used with Windows(R).

 55014: The specified file name cannot be used on the client. Change the file name and try again.
 [Explanation] The same as above.
 [User response] Do not specify the file name as a Windows(R) reserved word.

 55015: In the Environment, the current directory on the server is not set. Set it to continue.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 55016: Access permissions for the specified file are insufficient. Contact the administrator to get the appropriate
 permissions.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 55017: The specified current directory on the server does not exist. Check the current directory on the server as
 specified in the Environment.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 55018: Access permissions for the specified directory are insufficient. Contact the administrator to get the
 appropriate permissions.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 55019: The specified file name is an existing directory. Change the file name.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 55020: Either the directory of the specified data file does not exist, or no access permissions are set. If the directory
 exists, contact the administrator to get the appropriate permissions.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 58101: Failed to load the class libraries of the Unicode editing function.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 58102: The input data size is too large. Please input a smaller amount of data.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 60001: Numeric value conversion error. There are non-convertible values.
 [Explanation] An error occurred during a numeric item data check.
 [User response] Check the contents of the data.

 60002: Numeric value conversion error. There are non-convertible values.
 [Explanation] An error occurred during a numeric item data check.
 [User response] Check the contents of the data.

 60003: Numeric value conversion error. Error in the alphabet setup.
 [Explanation] A mistake exists in the code setting for a numeric item.
 [User response] Check the code setting.

 60004: Numeric value conversion error. Error in decimal point setup.
 [Explanation] A mistake exists in the decimal place setting in a numeric item.
 [User response] Check the decimal point setting.

 60005: Numeric value conversion error. Conversion area exceeded.
 [Explanation] A numeric item contains an out-of-range value.
 [User response] Enter a value in the range appropriate for the attribute.

 60006: 1 byte value specified in N type item.
 [Explanation] An item in Japanese contains a 1-byte character.
 [User response] Enter a 2-byte character, and make sure that all spaces are fullwidth.

 60007: Numeric value conversion error. Alphabets not specified.
 [Explanation] No code has been specified for a numeric item which requires one.
 [User response] Enter the code.

 60008: Numeric value conversion error. Non-numeric value specified.
 [Explanation] An error occurred during a numeric item data check.
 [User response] Check the contents of the input data.

 60009: Numeric value conversion error. Integer part exceeds the digit count.
 [Explanation] The digit number of integral portion of a numeric value with a decimal point exceeds the permissible
 range.
 [User response] Check the contents of the input data.

 60010: Numeric value conversion error. Decimal part exceeds the digit count.
 [Explanation] The digit number of fractional portion of a numeric value with a decimal point exceeds the
 permissible range.
 [User response] Check the contents of the input data.

 60020: Numeric value conversion error.
 [Explanation] An error occurred during a numeric item data check.
 [User response] Check the contents of the input data.

 60030: Code conversion error. Non-convertible characters specified.
 [Explanation] An error occurred during code conversion.
 [User response] Check the contents of the input data.

 60031: Code conversion output area exceeded.
 [Explanation] An error occurred during code conversion.
 [User response] Check the number of characters entered.



 60039: Code conversion error. Parameter error.
 [Explanation] An unexpected error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 60099: Numeric value conversion error. Parameter error.
 [Explanation] An unexpected error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 61002: Registry key does not exist. Check the setup.
 [Explanation] An attempt to install the COBOL parsing library has failed.
 [User response] Please reinstall the COBOL parsing library.

 61003: Registry key value does not exist. Check the setup.
 [Explanation] An attempt to install the COBOL parsing library has failed.
 [User response] Please reinstall the COBOL parsing library.

 61004: Parameter error in registry access.
 [Explanation] An attempt to install the COBOL parsing library has failed.
 [User response] Please reinstall the COBOL parsing library.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 70002: The test case file is read-only or is being used by another application.
 [Explanation] The same as above.
 [User response] Check if another Data Editor is running and processing a data file with the same name as the test
 case file. Also, if it is network environment, check if another user is using a data file with the same.

 70003: Cannot read the information file (.LNC file). Check the file.
 [Explanation] The same as above.
 [User response] The disk space or the memory may be insufficient.
 - When the disk space is insufficient, select another folder for "Folder to create Data Editor's work files" in the
 Environment or increase the disk space, then retry.
 - When the memory is insufficient, stop the rest of application programs, if any, then retry. If it does not work,
 restart Windows(R)/Windows NT(R), then retry.

 70004: Cannot write the information file (.LNC file). Check the file.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to store test case files" in the Environment or increase the disk
 space, then retry.

 70005: Cannot close the information file (.LNC file). Check the file.
 [Explanation] The same as above.
 [User response] Stop and restart Data Editor, then retry.

 70006: Cannot create the information file (.LNC file). Check the file.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to store test case files "in the Environment or increase the disk
 space, then retry.

 70007: Cannot open the information work file (.LNC work file). Check the workfiles folder.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70008: Cannot read the information work file (.LNC work file). Check the workfiles folder.
 [Explanation] The same as above.
 [User response] The disk space or the memory may be insufficient.
 - When the disk space is insufficient, select another folder for "Folder to create Data Editor's work files" in the
 Environment or increase the disk space, then retry.
 - When the memory is insufficient, stop the rest of application programs, if any, then retry. It it does not work,
 restart Windows(R)/Windows NT(R), then retry.

 70009: Cannot write the information work file (.LNC work file). Check the workfiles folder.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70010: Cannot close the information work file (.LNC work file). Check the workfiles folder.
 [Explanation] The same as above.
 [User response] Stop and restart Data Editor, then retry.

 70011: Failed to create the information work file (.LNC work file). Check the workfiles folder.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.



 70012: Cannot delete the analysis option file. Delete the file.
 [Explanation] The work file failed to be delete.
 [User response] Exit the tool. Then, delete work files in the folder selected for "Folder to create Data Editor's work
 files" in the Environment.
 * Files other than those with the extension 'LNC' may be deleted.

 70013: Failed to delete the work file. Delete the file.
 [Explanation] The work file failed to be delete.
 [User response] Exit the tool. Then, delete work files in the folder selected for "Folder to create Data Editor's work
 files" in the Environment.
 * Files other than those with the extension 'LNC' may be deleted.

 70014: Cannot activate the analyzer. (Insufficient memory)
 [Explanation] Due to insufficient memory, the COBOL parsing library could not start.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart
 Windows(R)/Windows NT(R), then retry.

 70015: Cannot activate the analyzer. (Insufficient disk space)
 [Explanation] Due to insufficient disk space, the COBOL parsing library could not start.
 [User response] The space of the drive where the folder specified for "Folder to create Data Editor's work files" in
 the Environment exists may be insufficient. Check the available space.

 70016: Analysis error. Open the error file?
 [Explanation] An error occurred while the format file was parsed. You are asked whether to see the error
 information file.
 [User response] See the error information file and correct the format file.

 70017: Cannot analyze the DEPENDING ON clause. Please modify the Library.
 [Explanation] Data Editor cannot process COBOL records which include DEPENDINGON statement.
 [User response] Remove DEPENDINGON statement from the COBOL record file.

 70018: Error in analyzing the COBOL library. (Environment setup)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70019: Error in analyzing the COBOL library. (Level number)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70020: Error in analyzing the COBOL library. (data format)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70021: Error in analyzing the COBOL library. (OCCURS clause)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70022: Error in analyzing the COBOL library. (REDEFINES clause)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70023: Error in analyzing the COBOL library. (Digits)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70024: Error in analyzing the COBOL library. (Byte length)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.



 [User response] Check if the format file is correctly described.

 70025: Error in analyzing the COBOL library. (Relative location)
 [Explanation] An error occurred while the result of parsing of the format file was acquired.
 [User response] Check if the format file is correctly described.

 70026: Too many items.
 [Explanation] More items than the maximum number that can be processed by Data Editor exist.
 [User response] The maximum number of items that can be processed by Data Editor is 9998. Also, when OCCURS
 statement is included, the number in the state after expansion is counted.

 70027: Insufficient memory. Close any unused applications.
 [Explanation] The memory is insufficient.
 [User response] Stop unnecessary application programs.

 70028: Insufficient memory. Close any unused applications.
 [Explanation] The memory is insufficient.
 [User response] Stop unnecessary application programs.

 70029: Cannot open the COBOL source work file. Check the workfiles folder.
 [Explanation] An error occurred while a work file used for COBOL program file was opened.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70031: Cannot write the COBOL source work file. Check the workfiles folder.
 [Explanation] An error occurred while a work file used for COBOL program file was loaded.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70032: Cannot close the COBOL source work file. Check the workfiles folder.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70033: Cannot create the COBOL source work file. Check the workfiles folder.
 [Explanation] An error occurred while a work file used for COBOL program file was created.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70034: Cannot create the work file. Check the workfiles folder setup.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to create Data Editor's work files" in the Environment or increase
 the disk space, then retry.

 70035: System error. (File pointer operation)
 [Explanation] This is an error in operation of the test case file.
 [User response] Stop and restart Data Editor, then retry.

 70036: Cannot carry out the analyzer environment setup. Setup the environment correctly.
 [Explanation] The COBOL parsing library has not been installed or its installation information is not correct.
 [User response] Reinstall the COBOL parsing library.

 70037: Analyzer environment not setup. Setup the environment correctly.
 [Explanation] The COBOL parsing library has not been installed or its installation information is not correct.
 [User response] Reinstall the COBOL parsing library.

 70039: 66 and 88 level number items ignored during library analysis.



 [Explanation] When items with the level numbers 66 and 88 are defined in the COBOL record file, they are ignored.
 [User response] None

 70040: Library record length exceeds the limit of 32760 bytes.
 [Explanation] COBOL records longer than 32,760 bytes cannot be processed.
 [User response] None

 70041: The OCCURS phrase of an internal Boolean item is not supported. Please change the copy phrase.
 [Explanation] COBOL records that include internal Boolean items (BITs) to which OCCURS statement is specified
 cannot be processed. This is also applied to COBOL records that include BITs belonging to a group item to which
 OCCURS statement is specified.
 [User response] None

 70042: The file which is not the test case file is specified for a test case file.
 [Explanation] A file named 'Data file name + .LNC' exists in the folder specified for "Folder to store test case files"
 in the Environment, but the format of the file cannot be processed by Data Editor.
 [User response] Delete the file with the name of 'Data file name + .LNC' from the folder specified for "Folder to
 store test case files" in the Environment, then retry.

 70043: Error in parsing of the COBOL parsing library.
 [Explanation] The same as above.
 [User response] Check the value of "Format Parsing Method" in the Environment, then retry.

 70044: The item of the length (32767 or more) that cannot be treated with Data Editor exists. Please change the
 copy phrase.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 70051: Failed in taking the library of the COBOL97 product.
 [Explanation] COBOL is not installed properly.
 [User response] Install COBOL.

 70060: There is NO work file of test case.Please redo COBOL analysis
 [Explanation] The test case file may failed to be parsed.
 [User response] Parse the format file again.

 70061: The path of work file of test case is WRONG.Please check work folder.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 70062: The attribute of the work file of test case is read only. Or the work file is used by other application. Please
 redo COBOL analysis.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 70063: The capacity of the disk is insufficient. Please retry this process after confirming the capacity of the disk.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 70064: There are some mistakes in the work file of the test case. Please redo COBOL analysis.
 [Explanation] Information in the test case file is not correct.
 [User response] Parse the format file again.

 70101: There are some item names larger than 64 bytes. Data Converter can't treat the item name larger than 64
 bytes. Ignore the part upper 64 byte and consider the part under 64 byte to be item name.
 [Explanation] The same as above.
 [User response] None



 71001: Cannot obtain sufficient memory.
 [Explanation] The memory space required for Data Editor to run could not be reserved.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart
 Windows(R)/Windows NT(R), then retry.

 71002: Cannot get global memory area.
 [Explanation] The memory space required for Data Editor to run could not be reserved.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart
 Windows(R)/Windows NT(R), then retry.

 71003: Cannot open the file. Check the file name.
 [Explanation] An error occurred while the test case file was loaded.
 [User response] Check the test case file.

 71004: Cannot read the file.
 [Explanation] An error occurred while the test case file was loaded.
 [User response] Check the test case file.

 71005: Write information is not available for the file.
 [Explanation] The loaded file does not have test case information.
 [User response] Delete the test case file (the 'Data file name +.LNC' file in the folder specified for "Folder to store
 test case files" in the Environment).

 71006: Error in expansion of OCCURS. (System error)
 [Explanation] This COBOL record is not supported.
 [User response] Contact a Fujitsu service engineer (SE).

 71007: Target of REDEFINES is not defined. Check that REDEFINES clause is correct.
 [Explanation] This COBOL record is not supported.
 [User response] Contact a Fujitsu service engineer (SE).

 71011: Cannot set the level.
 [Explanation] This COBOL record is not supported.
 [User response] Contact a Fujitsu service engineer (SE).

 71014: Redefinition at 01 level not supported. Update the Library.
 [Explanation] The COBOL record file which includes a re-definition item corresponding to the level 01cannot be
 processed.
 [User response] Delete the re-definition item corresponding to the level 01.

 71015: Number of expanded OCCURS items exceeds the limit. Please update the Library.
 [Explanation] The number of items after expansion of OCCURS statement has exceeded the upper limit.
 [User response] None

 71016: Internal Bool's item is not supported in expansion of OCCURS. Please update the Library.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 71017: The redefine item exists in the lower level of the OCCURS phrase. The COPY phrase with different length
 of Item to be redefined and Redefine item cannot be treated by COBOL Analysis Library. Please analyze it by
 COBOL compiler.
 [Explanation] The same as above.
 [User response] Follow the instructions in the message.

 72001: Cannot obtain sufficient memory.
 [Explanation] The memory area required for Data Editor to run could not be reserved.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart



 Windows(R)/Windows NT(R), then retry.

 72002: Cannot get the global memory area.
 [Explanation] The memory area required for Data Editor to run could not be reserved.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart
 Windows(R)/Windows NT(R), then retry.

 72003: Cannot open the file. Confirm the file name.
 [Explanation] An error occurred while the target file was loaded.
 [User response] Check the access assigned to the target file.

 72004: Cannot read the file.
 [Explanation] An error occurred while the target file was loaded.
 [User response] Check the access assigned to the target file.

 72005: Cannot write the file.
 [Explanation] An error occurred while the target file was loaded.
 [User response] Check the access assigned to the target file.

 72006: Error in file operations.
 [Explanation] An error occurred while the target file was loaded.
 [User response] Check the access assigned to the target file.

 72007: File read information not available.
 [Explanation] An error occurred while the target file was loaded.
 [User response] Check the access assigned to the target file.

 72008: Not a data file. Specify a data file.
 [Explanation] The specified file is not a COBOL data file of Fujitsu COBOL.
 [User response] Specify a COBOL data file of Fujitsu COBOL.

 72010: Error in initializing the COBOL file manager.
 [Explanation] An error occurred during initialization of the COBOL runtime library.
 [User response] Restart Windows(R)/Windows NT(R), then retry.

 72011: Error in closing the COBOL file manager.
 [Explanation] An error occurred during termination of the COBOL runtime library.
 [User response] Restart Windows(R)/Windows NT(R), then retry.

 72012: Error in the key count for the COBOL index file. Please provide the correct key count.
 [Explanation] Inconsistency was detected during check of the number of record keys. This data file is not supported.
 [User response] Contact a Fujitsu service engineer (SE).

 72013: Cannot open the data file.
 [Explanation] The data file could not be opened.
 [User response] Check if the settings in the data file information are correct.

 72014: Cannot read the data file.
 [Explanation] The data file could not be read.
 [User response] Check if the settings in the data file information are correct.

 72015: Cannot get the key information.
 [Explanation] The record key information failed to be acquired.
 [User response] Check if the specified data file is an index organization file.

 72016: End of file reached. Specify correct selection record number.
 [Explanation] The data file was read through but there were not any records matching with the specified retrieval



 conditions.
 [User response] Check the retrieval conditions.

 72017: Cannot create the data file.
 [Explanation] The data file failed to be created.
 [User response] Check the disk space.

 72018: Cannot write the data file.
 [Explanation] The data file failed to be written.
 [User response] Check the disk space.

 72019: Cannot close the data file.
 [Explanation] The data file failed to close.
 [User response] If it is an index file, you have to recover the data file by the file utility provided with Fujitsu
 COBOL.

 72020: Parameter error. Set the correct parameter.
 [Explanation] An unexpected error occurred in an internal process.
 [User response] Check the disk space.

 72021: Error in skip mode setup. Set the correct mode.
 [Explanation] An unexpected error occurred in an internal process.
 [User response] Check the disk space.

 72022: Cannot create the backup file.
 [Explanation] The backup file failed to be created.
 [User response] The space of the drive where the folder specified for "Folder to create backup files" in the
 Environment exists may be insufficient. Check the available space.

 72023: Cannot delete the work file.
 [Explanation] The work file failed to be deleted.
 [User response] Exit the tool. Then, delete work files in the folder selected for "Folder to create Data Editor's work
 files" in the Environment.
 * Files other than those with the extension 'LNC' may be deleted.

 72025: Specified data file is already in use.
 [Explanation] The specified data file may be being used by another application program.
 [User response] Close the application program.

 72026: The start record number for the save sequence range specification is incorrect. Please specify correctly.
 [Explanation] The value of the starting record number is not correct.
 [User response] Specify a value within the range between 1 and the number of existing records.

 72027: Duplicate key in an index file.
 [Explanation] The index organization file has duplicate key data.
 [User response] None

 72029: File access error.
 [Explanation] The new data file could not be created.
 [User response] Check the disk space and the access you have.

 72030: The record, which becomes a hit to the condition, does not exist. Please change and extract the condition.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 72031: The code type is not set in the data file. Please set again and process the test case.
 [Explanation] The specified data file does not include code information. Therefore, it is not the Unicode format of a



 line order organization file.
 [User response] On Test Case Configuration screen, specify information on the data file again.

 72032: COBOL files are specified as large files on Environment screen. The large file access function does not
 support access to index/relative organization files. Change the size of COBOL files to 'Standard' on Environment
 screen.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 72033: The file already exists. Update the existing file or delete it.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 73003: Memory shortage occurred by internal processing of Data Editor. Please end Data Editor. Please reactivate
 Data Editor after ending other applications and opening the memory.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75001: The lack of the capacity of the disk occurred when opening the data file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75002: The error of the FILE ACCESS PROHIBITION occurred when opening the data file. Please redo this
 process after checking the setting of that data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75003: The error of FILE UNDEFINITION occurred when opening the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75004: The error of INVALID PATH occurred when opening the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75005: The error of exceeding numbers of opened files occurred when opening the data file. Please redo this
 process after shutting some other applications.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75006: UNDEFINED(unknown) error occurred when opening the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75007: The error of FILE EXCLUSION ERROR occurred when opening the data file. Please redo this process after
 shutting the applications using this data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75008: An error occurred when opening the data file. Please redo this process after checking the data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75009: The lack of the capacity of the disk occurred when getting the length of the data file. Please redo this process
 after checking the capacity of the disk
 [Explanation] The same as above.



 [User response] Follow the instruction provided by the message.

 75010: The error of the FILE ACCESS PROHIBITION occurred when getting the length of the data file. Please
 redo this process after checking the setting of that data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75011: The error of the FILE UNDEFINED occurred when getting the length of the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75012: The error of the INVALID PATH occurred when getting the length of the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75013: The error of exceeding numbers of opened files occurred when getting the length of the data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75014: UNDEFINED(unknown) error occured when getting the length of the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, then retry.

 75015: The error of FILE EXCLUSION ERROR occurred when getting the length of the data file. Please redo this
 process after shutting the applications using this data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75017: The lack of the capacity of the disk occurred when opening the extraction file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75018: The error of the FILE ACCESS PROHIBITION occurred when opening the extraction file. Please redo this
 process after checking the setting of that data file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75019: The error of FILE UNDEFINITION occurred when opening the extraction file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75020: The error of INVALID PATH occurred when opening the extraction file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75021: The error of exceeding numbers of opened files occurred when opening the extraction file. Please redo this
 process after shutting some other applications.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75022: UNDEFINED(unknown) error occurred when opening the data file.
 [Explanation] The same as above.



 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75023: The error of FILE EXCLUSION ERROR occurred when opening the extraction file. Please redo this
 process after shutting the applications using this data file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75024: An error occurred when opening the extraction file. Please redo this process after checking the data file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75025: The lack of the capacity of the disk occurred when opening the 2nd work file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75026: The error of the FILE ACCESS PROHIBITION occurred when opening the 2nd work file. Please redo this
 process after checking the setting of that 2nd work file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75027: The error of FILE UNDEFINITION occurred when opening the 2nd work file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75028: The error of INVALID PATH occurred when opening the 2nd work file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75029: The error of exceeding numbers of opened files occurred when opening the 2nd work file. Please redo this
 process after shutting some other applications.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75030: UNDEFINED(unknown) error occurred when opening the 2nd work file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75031: The error of FILE EXCLUSION ERROR occurred when opening the 2nd work file. Please redo this process
 after shutting the applications using this 2nd work file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75032: An error occurred when opening the 2nd work file. Please redo this process after checking the 2nd work file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75033: Failed to read the data file.
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, an appropriate access is assigned and the disk space is



 sufficient, then retry.

 75034: Failed to read the exclusion file
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75035: Failed to write to the data file
 [Explanation] The same as above.
 [User response] Ensure the path to the target file is correct, an appropriate access is assigned and the disk space is
 sufficient, then retry.

 75036: Failed to write to the exclusion file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75037: Failed to write to the 2nd work filw.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create Data Editor's work files" in the Environment is
 correct, then retry.

 75038: The lack of the capacity of the disk occurred when opening the data file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75039: The lack of the capacity of the disk occurred when opening the exclusion file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75040: The lack of the capacity of the disk occurred when opening the 2dn work-file. Please redo this process after
 checking the capacity of the disk.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75042: The data file is already opened. Please redo this process after closing that data file
 [Explanation] The target data file may be being opened by another application.
 [User response] Ensure none of the other application programs is using the target file.

 75043: The data file is NOT opened.Please end this processing.
 [Explanation] The internal process was aborted due to some reason.
 [User response] Stop and restart Data Editor, then retry.

 75044: The length of the name of the extraction file exceeded the limitation. Please reset the folder from which
 work file is made, using environmental setting.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75045: The length of the name of the backup file exceeded the limitation. Please reset the folder from which work
 file is made, using environmental setting.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75046: There are some mistakes in start location or end location of specification of relative position.Please redo this
 process after re-setting the relative position.



 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75047: DIDN'T set full information for file I/O.
 [Explanation] The information required for file access is not set.
 [User response] Ensure every information item on Test Case Selection dialog box is specified, then retry.

 75048: There are some mistakes in setting of the parameter of making extraction file. Please redo this process after
 specified other data file.
 [Explanation] The information required for file access is not set.
 [User response] Ensure every information item on Test Case Selection dialog box is specified, then retry.

 75050: The lack of the capacity of the disk occurred when opening the backup file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75051: The error of the FILE ACCESS PROHIBITION occurred when opening the backup file. Please redo this
 process after checking the setting of that backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct and an
 appropriate access is assigned, then retry. 

 75052: The error of FILE UNDEFINITION occurred when opening the backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct, then
 retry. 

 75053: The error of INVALID PATH occurred when opening the backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct, then
 retry. 

 75054: The error of exceeding numbers of opened files occurred when opening the backup file. Please redo this
 process after shutting some other applications.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75055: UNDEFINED(unknown) error occurred when opening the backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct, then
 retry. 

 75056: The error of FILE EXCLUSION ERROR occurred when opening the backup file. Please redo this process
 after shutting the applications using this backup file.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 75057: An error occurred when opening the backup file. Please redo this process after checking the backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct, then
 retry. 

 75058: Failed to write to backup file.
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct and an
 appropriate access is assigned, then retry. 



 75059: The lack of the capacity of the disk occurred when writing to the backup file. Please redo this process after
 checking the capacity of the disk
 [Explanation] The same as above.
 [User response] Ensure the value specified for "Folder to create backup files" in the Environment is correct and an
 appropriate access is assigned, then retry. 

 75060: The size of specified file exceeds the size which can operate by binary access. Please operate that file by
 large file access of COBOL.
 [Explanation] The target file is larger than 2 GB.
 [User response] For files larger than 2 GB, use the COBOL large access function to manipulate.

 75061: The starting record number specifying the range of storage orders is larger than the number of records stored
 in the file. Specify an appropriate number.
 [Explanation] The same as above.
 [User response] Follow the instruction provided by the message.

 76001: Failed to acquire information layout definition.
 [Explanation] The same as above.
 [User response] If the target layout definition file exists, confirm if the assigned access is appropriate.

 76002: Data Editor can't operate the specified file because that form is not data file form
 [Explanation] Because the input format of the layout file is not the data file format, the layout file cannot be
 processed by Data Editor.
 [User response] Re-create a layout file whose input format is the data file format.

 76003: Data Editor can't operate the specified file because no inputted data was set on that file.
 [Explanation] The record length of the specified layout file is 0.
 [User response] Re-create a layout file.

 76004: Data Editor can't operate the specified file because the length of the record of that file exceeds the
 limitation(32,760 bytes).
 [Explanation] The same as above.
 [User response] Re-create a layout file.

 76005: Failed to acquiring memory area.
 [Explanation] The internal process failed to reserve the required disk space.
 [User response] Exit unnecessary application programs, then retry.

 76006: Failed to write to work file of test case because of the lack of the capacity of the disk.
 [Explanation] The same as above.
 [User response] Select another folder for "Folder to store test case files" in the Environment or increase the disk
 space, then retry.

 76007: Data Editor can't operate the specified file because the number of item of that file exceeds the
 limitation(9999 items).
 [Explanation] The same as above.
 [User response] Re-create a layout file.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 80001: File name error. Enter the full path of the file.
 [Explanation] There was an error in the file name.
 [User response] Enter the full path for the file.

 80002: No access authority is specified for the file. Please specify access authority for the file.
 [Explanation] There is no access authority to the file.
 [User response] Add access authority to the file.

 80003: The file is being used by another application. 
 End the other application and re-execute.
 [Explanation] The file cannot be accessed because it is being used by another application.
 [User response] End the application that is using the file and re-try.

 80004: The file does not exist. Specify an existing file.
 [Explanation] The file does not exist.
 [User response] Select an existing file.

 80005: An error occurred while opening the file. Please check the file.
 [Explanation] An error occurred while the file was being opened.
 [User response] Check the file.



 The messages appear when you operate Data Editor. Helpful information will be added to a message depending on
 your operation.

 90001: INFO: The daemon started normally.
 [Explanation] Notification message: Notifies the daemon has started.
 [User response] None

 90002: INFO: Wait time (minutes)->
 [Explanation] Notification message: Displays the communication wait time in minute.
 [User response] None

 90003: INFO: The daemon terminated normally.
 [Explanation] Notification message: Notifies the daemon has stopped.
 [User response] None

 90004: Failed to obtain memory area.
 [Explanation] The memory area required for the product to run could not be reserved.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 90005: Failed to set group.
 [Explanation] The daemon failed to start.
 [User response] Contact a Fujitsu service engineer (SE).

 90006: The version level do not match.
 [Explanation] Because the version levels of the daemon and the client differ, the product cannot run.
 [User response] Use the same version level of the daemon and the client to run the product.

 90007: Cannot create because child processes would exceed the limit.
 [Explanation] Because the number of child processes created by the daemon has reached the upper limit, a new
 process cannot be created.
 [User response] Stop a running client, then connect a new client.

 90009: The command contains an error. 
 [Explanation] Information other than that of commands which the daemon can process has been notified.
 [User response] Contact a Fujitsu service engineer (SE).

 90010: The user ID contains an error.
 [Explanation] This user ID is not allowed to connect to the server machine.
 [User response] On the client, set a user ID which is allowed to connect to the server machine, then re-connect.

 90011: Cannot change a process to a user ID.
 [Explanation] The user who started the daemon does not have the authority required to change user IDs associated
 with child processes.
 [User response] Restart the daemon as a user who has the authority which can change IDs associated with
 processes.

 90012: The directory set in the environment variable or environment file does not exist.
 [Explanation] The directory specified to the environment variable/the environment file does not exist.
 [User response] Specify an existing directory to the environment variable/the environment file.

 90013: The object set in the environment variable or environment file is not a directory.
 [Explanation] The thing specified to the environment variable/the environment file is not a directory.
 [User response] Specify an existing directory to the environment variable/the environment file.

 90014: There is no write authority for the directory set in the environment variable or environment file.
 [Explanation] The directory specified to the environment variable/the environment file is not assigned write access.
 [User response] Specify a directory with write access to the environment variable/the environment file.



 90015: The work directory area exceeded 512 bytes.
 [Explanation] The work directory area has exceeded 512 bytes.
 [User response] Specify a directory less than or equal to 512 bytes as the work directory. 

 90016: No work directory has been set in the environment variable or environment file.
 [Explanation] No work directory is specified to the environment variable/the environment file.
 [User response] Specify a work directory to the environment variable/the environment file.

 90017: The work directory contains an error.
 [Explanation] The work directory is incorrect.
 [User response] Specify an existing 'directory' as the work directory.

 90018: Cannot open the error file.
 [Explanation] The error file cannot be opened.
 [User response] Assign write access to the error file.

 90019: Failed to create a child process.
 [Explanation] The child process failed to be created.
 [User response] Contact a Fujitsu service engineer (SE).

 90020: Could not terminate the daemon because a child process was running.
 [Explanation] Although it was requested to stop the daemon, a child process(es) is operating and the daemon cannot
 be stopped.
 [User response] Stop all of the running clients, then stop the daemon.

 90021: The user password contains an error.
 [Explanation] The user password is not correct.
 [User response] On the client, set a correct password, then re-connect.

 90022: The user ID or password contains an error.
 [Explanation] The user ID or password is not correct.
 [User response] On the client, set a correct user ID or password, then re-connect.

 90023: Failed to start the child process.
 [Explanation] This child process failed to start.
 [User response] Ensure the server module exists. Also, ensure the directory where the server module exists and the
 directory where the relevant products exist are specified in the Environment.

 90024: There is no read authority for the directory set in the environment variable or environment file.
 [Explanation] The directory specified to the environment variable/the environment file is not assigned read access.
 [User response] Specify a directory with read access to the environment variable/the environment file.

 90025: Data Editor running on the server does not match the client.
 [Explanation] The type of Data Editor operating at the server side does not match with that at the client side.
 [User response] Check if the product types of the server and the client is same.

 90026: The daemon is already started.
 [Explanation] Notification message: The daemon has already started.
 [User response] None

 90027: No IP address setting file can be found.
 [Explanation] No IP address configuration file.
 [User response] The IP address configuration file does not exist in the work directory.

 90028: Started the child process.
 [Explanation] Notification message: The child process has started.
 [User response] None



 90029: The child process cannot start because the user connected using an unregistered IP address.
 [Explanation] The IP address used for connection does not exist in the IP address configuration file.
 [User response] Use an IP address existing in the IP address configuration file.

 90030: Could not create a log file.
 [Explanation] The log file specified in the client information could not be created.
 [User response] Check if read/write access is assigned to the folder where work files will be created, and if it isn't,
 assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 90031: Could not obtain the IP address.
 [Explanation] The IP address of the connection source client could not be acquired.
 [User response] A communication error occurred. Contact the administrator.

 90042: The method of setting an IP address in the IP address setting file is incorrect.
 [Explanation] IP addresses are incorrectly specified in the IP address configuration file.
 [User response] IP addresses must be specified in the format of "xxx.xxx" (xxx is a numeric value).

 90045: No environment file can be found.
 [Explanation] The environment file does not exist.
 [User response] Create the environment file in the same directory as the daemon module.

 90051: An error occurred during communication between the daemon and child process. If this error recurs, restart
 the daemon.
 [Explanation] Notification message: An error occurred in communication between the daemon and the child
 process.
 If the error occurs repeatedly, restart the daemon.
 [User response] None

 90052: The information file was not created properly. The work area may be insufficient. Expand the area.
 [Explanation] The management tool failed to create the information file correctly. The work area may be
 insufficient. Increase the area.
 [User response] Confirm if read access is assigned to the work folder or the user-specified folder where the
 information file will be created, and if it isn't, assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 90053: Terminated the child process.
 [Explanation] This message notifies the child process has been terminated.
 [User response] None

 90054: The information file was not created properly.
 [Explanation] The management tool failed to create the management information file due to some reason.
 [User response] Confirm if read/write access is assigned to the work folder or the user-specified folder where the
 information file will be created, and if it isn't, assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 90055: Specified file already exists. Please specify a new file name.
 [Explanation] The file specified to the parameter of the management tool already exists.
 [User response] Specify a new file name to the parameter of the management tool.

 90100: Failed to obtain memory area.
 [Explanation] The memory area required for the product to run could not be reserved.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 90101: Timeout occurred.
 [Explanation] Notification message: A timeout occurred.
 [User response] None



 90102: The command contains an error.
 [Explanation] Information other than that of commands which the daemon can process has been notified.
 [User response] Contact a Fujitsu service engineer (SE).

 90103: Failed to open the information file.
 [Explanation] The information file required for the process to run cannot be opened.
 [User response] Contact a Fujitsu service engineer (SE).

 90104: No information is set for the file.
 [Explanation] The file required for the process to run does not include information.
 [User response] Contact a Fujitsu service engineer (SE).

 90107: The child process parameters contain an error.
 [Explanation] The child process has an erroneous parameter.
 [User response] Contact a Fujitsu service engineer (SE).

 90108: An error occurred during file processing.
 [Explanation] An error occurred during file processing.
 [User response] Contact a Fujitsu service engineer (SE).

 90113: The information file was not created properly. The work area may be insufficient. Expand the area.
 [Explanation] The information file is not created correctly. The work area may be insufficient. Increase the area.
 [User response] Confirm if write access is assigned to the work folder or the user-specified folder where the
 information file will be created, and if it isn't, assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 91001: Failed to obtain memory area.
 [Explanation] The memory area required for the product to run could not be reserved.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 91002: The host name contains an error.
 [Explanation] The host name is not correct.
 [User response] Specify a correct host name.

 91003: The command number contains an error.
 [Explanation] The command number is not correct.
 [User response] Contact a Fujitsu service engineer (SE).

 91004: No file name is set.
 [Explanation] The file name is not specified.
 [User response] Contact a Fujitsu service engineer (SE).

 91005: Failed to open the file.
 [Explanation] The file failed to be opened.
 [User response] Contact a Fujitsu service engineer (SE).

 91006: The file failed to be written. The work area or the log area at the server side may be insufficient.
 [Explanation] The file failed to be written. The work area or the log area at the server side may be insufficient.
 [User response] Confirm if read/write access is assigned to the work area or the log area at the server side, and if it
 isn't, assign the access.
 If it is, the space of the drive where the area exists may be insufficient. Check the available space.

 91007: Could not obtain the size of the file.
 [Explanation] Information on the file size could not be acquired.
 [User response] Contact a Fujitsu service engineer (SE).



 91008: The length of the name is incorrect.
 [Explanation] The length of the name is not correct.
 [User response] Contact a Fujitsu service engineer (SE).

 91009: No user ID is set.
 [Explanation] The user ID is not specified.
 [User response] Contact a Fujitsu service engineer (SE).

 91010: No password is set.
 [Explanation] The password is not specified.
 [User response] Contact a Fujitsu service engineer (SE).

 91011: No name is set.
 [Explanation] The name is not specified.
 [User response] Contact a Fujitsu service engineer (SE).

 91012: No processing flag is set.
 [Explanation] The process flag is not specified.
 [User response] Contact a Fujitsu service engineer (SE).

 91013: Cannot change the authority for a file.
 [Explanation] The access to the file cannot be changed.
 [User response] Contact a Fujitsu service engineer (SE).

 91014: Canceled file transfer.
 [Explanation] The file transfer was interrupted.
 [User response] Contact a Fujitsu service engineer (SE).

 91015: Cannot obtain a random file name.
 [Explanation] Random file names cannot be acquired.
 [User response] Contact a Fujitsu service engineer (SE).

 91016: No access authority has been granted.
 [Explanation] You don't have access to the selected file and its directory.
 [User response] To use the selected file and its directory, ask the administrator to assign the access.

 91017: The file name specifies an area outside the address space allocated to the process. 
 [Explanation] Some error occurred during access to the file.
 [User response] Contact the system administrator.

 91018: The system function received a signal during a system call. 
 [Explanation] The same as above.
 [User response] Contact the system administrator.

 91019: Too many symbolic links were detected during conversion of the file name.
 [Explanation] Too many symbolic links were detected while the file name was converted.
 [User response] Contact the system administrator.

 91020: The components of the file name require a hop to multiple remote machines, but the file system does not
 permit this. 
 [Explanation] Although a component of the file name requires hops to more than one remote machines, it is not
 allowed by the file system.
 [User response] To use the selected file and its directory, ask the administrator to assign the access.

 91021: The length of the file name exceeds the maximum value.
 [Explanation] Cannot access the file because its name is longer than the maximum value allowed on the system.
 [User response] Change to a file name with an available length.



 91022: The specified file name is not a directory.
 [Explanation] The specified server file name does not include a directory path.
 [User response] Specify a file name together with its directory path.

 91023: The specified file or directory does not exist.
 [Explanation] The specified server file name or directory name does not exist.
 [User response] Specify an existing name.

 91024: The file name specifies a remote machine, but the link to the machine is no longer active.
 [Explanation] Although the file name indicates that of a remote machine, the link to the machine is not already
 active.
 [User response] Re-establish a link to the machine where the file exists.

 91025: Cannot write to a read-only file or file on the system.
 [Explanation] Writing to files on a read-only file system is not possible.
 [User response] Specify a folder with write access or assign write access to the target folder, then retry.

 91026: The component is too large to be saved in the structure specified by the parameter.
 [Explanation] The component is too large to store in the structure specified by the parameter.
 [User response] Contact the system administrator.

 91027: The information given in the parameter is not an enabled open file descriptor. 
 [Explanation] The open file descriptor specified to the parameter is not valid.
 [User response] Contact the system administrator.

 91028: The maximum number of file descriptors is currently open.
 [Explanation] The maximum number of file descriptors are already opened.
 [User response] Contact the system administrator.

 91029: The system file table is full.
 [Explanation] The system file table is full.
 [User response] Contact the system administrator.

 91030: Failed to open the file.
 [Explanation] You cannot create files in the work directory.
 [User response] You do not have access required to create files in the work directory. Ask the administrator to
 assign the access.

 91031: Failed to read the file.
 [Explanation] You cannot read files in the work directory.
 [User response] You do not have access required to read files in the work directory, or the target file is not assigned
 read access. Ask the administrator to assign the access.

 91032: The file failed to be written. The work area or the log area at the server side may be insufficient.
 [Explanation] The file failed to be written. The work area or the log area at the server side may be insufficient.
 [User response] Confirm if read/write access is assigned to the work area or the log area at the server side, and if it
 isn't, assign the access.
 If it is, the space of the drive where the area exists may be insufficient. Check the available space.

 91034: An error occurred during file processing.
 [Explanation] An error occurred during file transmission/reception and the like.
 [User response] Contact the system administrator.

 92001: Failed to obtain memory area.
 [Explanation] The memory area required for the product to run could not be reserved.
 [User response] Stop the rest of application programs or increase the memory, then retry.



 92002: Failed to obtain host information.
 [Explanation] The host information failed to be acquired.
 [User response] Set the correct host name, then re-connect.

 92003: The port number contains an error.
 [Explanation] The port number is not correct.
 [User response] Set the correct port number, then re-connect.

 92004: The host name does not exist.
 [Explanation] The host name does not exist.
 [User response] Set the correct host name, then re-connect.

 92005: Failed to obtain the socket number.
 [Explanation] The socket number failed to be acquired.
 [User response] Contact the system administrator.

 92006: Failed to set options for the socket.
 [Explanation] Setting of socket options failed.
 [User response] Contact the system administrator.

 92007: Failed to establish communication.
 [Explanation] The communication failed to be established.
 [User response] Contact the system administrator.

 92008: Failed to reserve a queue for the socket.
 [Explanation] The socket queue failed to be reserved.
 [User response] Contact the system administrator.

 92009: Failed to set an access wait time.
 [Explanation] The access wait period failed to be set.
 [User response] Contact the system administrator.

 92010: Failed to create a socket.
 [Explanation] The socket failed to be created.
 [User response] Contact the system administrator.

 92012: Failed to send data.
 [Explanation] Data transmission failed.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92013: The child process has no free port number.
 [Explanation] The child process does not have an available port number.
 [User response] Stop the product running at the server side, then re-connect.

 92014: Timeout processing has started.
 [Explanation] Notification message: A timeout occurred.
 [User response] None

 92015: Communication was cut.
 [Explanation] The communication was terminated.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92200: Failed to initialize WINSOCKET.
 [Explanation] Initialization of WINSOCKET failed.
 [User response] Contact the administrator.

 92201: An error occurred in the socket interface.



 [Explanation] An error occurred in the socket interface.
 [User response] Contact the administrator.

 92202: A system interrupt was generated.
 [Explanation] Due to "User interruption" signal, the process has been terminated.
 [User response] Restart the daemon. Or re-connect from the client.

 92203: A system interrupt was generated.
 [Explanation] Due to "User interruption" signal, the process has been terminated.
 [User response] Restart the daemon. Or re-connect from the client.

 92204: Access was denied.
 [Explanation] The access was denied.
 [User response] Contact the administrator.

 92205: An address exception was generated.
 [Explanation] An address exception occurred.
 [User response] Contact the administrator.

 92206: The specified option contains an error.
 [Explanation] The specified option is not correct.
 [User response] Contact the administrator.

 92207: No more sockets can be opened.
 [Explanation] There is no socket left that can be opened.
 [User response] Contact the administrator.

 92208: Network processing is blocked.
 [Explanation] The networking process is blocked.
 [User response] Contact the administrator.

 92209: Started network processing.
 [Explanation] Notification message: The networking process has started.
 [User response] None

 92210: Started network processing.
 [Explanation] Notification message: The networking process has started.
 [User response] None

 92211: The specified value is not a socket.
 [Explanation] The specified value is not that indicating a socket.
 [User response] Contact the administrator.

 92212: The communication destination address was requested.
 [Explanation] The address of the communication target was requested.
 [User response] Contact the administrator.

 92213: Abandoned because data was too large.
 [Explanation] The data was truncated because it was too long.
 [User response] Contact the administrator.

 92214: The specified protocol is incorrect.
 [Explanation] An invalid protocol was specified.
 [User response] Contact the administrator.

 92215: The protocol is not available.
 [Explanation] The protocol is not available.



 [User response] Contact the administrator.

 92216: The protocol is not supported.
 [Explanation] The protocol is not supported.
 [User response] Contact the administrator.

 92217: The socket type is not supported.
 [Explanation] The socket type is not supported.
 [User response] Contact the administrator.

 92218: Processing is not supported by the socket.
 [Explanation] The process is not supported by the process.
 [User response] Contact the administrator.

 92219: The protocol family is not supported.
 [Explanation] The protocol family is not supported.
 [User response] Contact the administrator.

 92220: The address family is not supported.
 [Explanation] The address family is not supported.
 [User response] Contact the administrator.

 92221: The address family is not supported.
 [Explanation] The same as above.
 [User response] Contact the administrator.

 92222: The address family is not supported.
 [Explanation] The same as above.
 [User response] Contact the administrator.

 92223: The network is stopped.
 [Explanation] The network is not working.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92224: The network cannot be reached.
 [Explanation] The network is not reachable.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92225: Network linkage was reset.
 [Explanation] The network linkage has been reset.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92226: Network linkage was broken.
 [Explanation] The network linkage has been discarded.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92227: Communication with the destination was forcibly cut.
 [Explanation] The connection is forcibly disconnected by the destination.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92228: The buffer area is insufficient.
 [Explanation] The buffer area is not sufficient.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 92229: The socket is already linked.
 [Explanation] The socket is already bound.
 [User response] Contact the administrator.



 92230: The socket is not yet linked.
 [Explanation] The socket is not bound yet.
 [User response] Contact the administrator.

 92231: Communication is closed.
 [Explanation] The communication is closed.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92232: There are too many communication references.
 [Explanation] The communication reference number has exceeded the upper limit.
 [User response] Contact the administrator.

 92233: Timeout occurred during communication.
 [Explanation] A communication timeout occurred.
 [User response] A timeout occurred at the server side. Re-connect the client.

 92234: The request for communication was denied.
 [Explanation] The request for communication was denied.
 [User response] A timeout occurred at the server side. Re-connect the client.

 92235: The symbol has too many levels.
 [Explanation] The number of symbol levels is too many.
 [User response] Contact the administrator.

 92236: The file name is too long.
 [Explanation] The name is too long.
 [User response] Contact the administrator.

 92237: The host is down.
 [Explanation] The host is down.
 [User response] Start the host.

 92238: Communication cannot reach the host.
 [Explanation] Cannot reach the communication partner host.
 [User response] Contact the administrator.

 92239: The directory is not empty.
 [Explanation] The directory is not empty.
 [User response] Contact the administrator.

 92240: There are too many processes in the system.
 [Explanation] The number of processes in the system has exceeded the upper limit.
 [User response] Stop the product running at the server side, then re-connect.

 92241: There are too many users in the system.
 [Explanation] The number of users in the system has exceeded the upper limit.
 [User response] Stop the product running at the server side, then re-connect.

 92242: Disk error.
 [Explanation] Disk error.
 [User response] Contact the administrator.

 92243: Lost the NFS file handle.
 [Explanation] The NFS file handle was lost.
 [User response] Contact the administrator.

 92244: The remote path hierarchy is too deep.



 [Explanation] The remote path is too deep.
 [User response] Contact the administrator.

 92245: An error occurred in the communication protocol.
 [Explanation] Some error in the communication protocol occurred.
 [User response] Contact the administrator.

 92246: WinSock is not ready.
 [Explanation] WinSock is not prepared.
 [User response] Contact the administrator.

 92247: The level of WinSock is different.
 [Explanation] The level of WinSock differs.
 [User response] Contact the administrator.

 92248: WinSock is not initialized.
 [Explanation] WinSock has not been initialized yet.
 [User response] Contact the administrator.

 92249: Could not reference the host name.
 [Explanation] The host name could not be looked up.
 [User response] Specify the correct host name.

 92250: An error occurred in the communication protocol.
 [Explanation] Some error in the communication protocol occurred.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92251: An error occurred in the communication protocol.
 [Explanation] Some error in the communication protocol occurred.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 92252: An error occurred in the communication protocol.
 [Explanation] Some error in the communication protocol occurred.
 [User response] A timeout occurred at the server side or a communication failure occurred. Re-connect the client.

 97001: Failed to obtain memory area.
 [Explanation] The memory area required for the product to run could not be reserved.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 97002: Failed to obtain global memory area.
 [Explanation] Failed to obtain global memory area.
 [User response] Stop the rest of application programs or increase the memory, then retry.

 97003: Failed to open the file. Confirm the file name.
 [Explanation] The file failed to be opened. Confirm the name of the file.
 [User response] Specify the correct file name.

 97004: Failed to read the file.
 [Explanation] The file failed to be read.
 [User response] Assign read access to the file.

 97005: The file failed to be written. The work area or the log area at the server side may be insufficient.
 [Explanation] The file failed to be written. The work area or the log area at the server side may be insufficient.
 [User response] Confirm if read/write access is assigned to the work area or the log area at the server side, and if it
 isn't, assign the access.
 If it is, the space of the drive where the area exists may be insufficient. Check the available space.



 97006: Failed to operate the file.
 [Explanation] The file operation failed.
 [User response] Contact a Fujitsu service engineer (SE).

 97008: Not a COBOL file. Specify a COBOL file.
 [Explanation] This is not a COBOL file. Specify a COBOL file.
 [User response] This is not a COBOL file. Specify a COBOL file.

 97010: An error occurred during initialization of the COBOL file manager.
 [Explanation] A COBOL access error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 97011: An error occurred during termination of the COBOL file manager.
 [Explanation] The same as above.
 [User response] Contact a Fujitsu service engineer (SE).

 97012: The number of keys of the COBOL indexed file is incompatible. Obtain the correct number of keys.
 [Explanation] The number of keys of the COBOL index file is inconsistent. Get the correct key number.
 [User response] The number of keys of the COBOL index file is inconsistent. Get the correct key number.

 97013: Failed to open a COBOL file.
 [Explanation] The COBOL file failed to be opened.
 [User response] Specify the correct file name.

 97014: Failed to write to a COBOL file.
 [Explanation] The COBOL file failed to be read.
 [User response] Assign read access to the file.

 97015: Failed to obtain key information.
 [Explanation] The key information failed to be acquired.
 [User response] Specify a file which includes the key information.

 97016: Read the end of the file. Set a correct extraction record number.
 [Explanation] An error occurred during retrieval of records.
 [User response] As the number of records to be retrieved, specify a value less than the number of file records. 

 97017: Failed to create a COBOL file.
 [Explanation] The COBOL file failed to be created.
 [User response] Assign creation access to the directory where the COBOL file will be created or increase the area
 where files can be created.

 97018: Failed to write to a COBOL file.
 [Explanation] The COBOL file failed to be written.
 [User response] Assign write access to the COBOL file or increase the area for the directory where files exist.

 97019: Failed to close a COBOL file.
 [Explanation] The COBOL file failed to be closed.
 [User response] Contact a Fujitsu service engineer (SE).

 97020: The parameters contain an error. Set correct parameters.
 [Explanation] A COBOL access error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 97021: The skip mode setting contains an error. Set a correct mode.
 [Explanation] The skip mode setting contains an error. Set a correct mode.
 [User response] Contact a Fujitsu service engineer (SE).



 97022: Failed to create a backup file.
 [Explanation] The backup file failed to be created.
 [User response] Assign write access to the directory where the backup file will be created or increase the area for
 the directory where files can be created.

 97025: The specified data file is already being used.
 [Explanation] The specified data file is already used.
 [User response] Specify a new file.

 97026: Set a correct start record number for the storage range specification.
 [Explanation] Specify a valid value to the starting record number which determines the range of storage orders.
 [User response] Specify a valid value to the starting record number which determines the range of storage orders.

 97027: The key of the indexed organization file is duplicated.
 [Explanation] The index organization file includes duplicate keys.
 [User response] Do not specify duplicate keys in the index organization file.

 97029: A file access error occurred.
 [Explanation] A file access error occurred.
 [User response] Contact a Fujitsu service engineer (SE).

 97030: Exceeded the maximum file size that can be transferred. Reduce the number of records so that the file size
 does not exceed 2GB.
 [Explanation] The maximum transferable file size has been exceeded. Reduce the number of records in order to
 make the file size less than 2 GB.
 [User response] Reduce the number of records in order to make the file size less than 2 GB.

 97032: Could not create a file. The creation area may be insufficient. Expand the area.
 [Explanation] The file failed to be created. The work area or the log area at the server side may be insufficient.
 [User response] Confirm if read/write access is assigned to the work area or the log area at the server side, and if it
 isn't, assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 97033: Could not create a backup file. The backup file creation area may be insufficient. Expand the area.
 [Explanation] The backup file failed to be created. The area where backup files are created may be insufficient.
 [User response] Confirm if read/write access is assigned to the area where backup files are created, and if it isn't,
 assign the access.
 If it is, the space of the drive where the folder exists may be insufficient. Check the available space.

 97034: An error with error identification code Item and I-O status %d occurred during COBOL access.
 [Explanation] An error was returned from COBOL at the time of file access.
 [User response] See the relevant COBOL manual to confirm the meaning of the message. Or contact a Fujitsu
 service engineer (SE).

 99001: Failed to allocate memory area.
 [Explanation] The memory area required for data generation could not be reserved.
 [User response] Stop the rest of application programs, if any, then retry. If it does not work, restart
 Windows(R)/Windows NT(R), then retry.

 99002: Failed to open the control file.
 [Explanation] The file used for data generation could not be opened.
 [User response] Confirm if read/write access is assigned to the folder specified to "Folder to create Data Editor's
 work files" and "Folder to store test case files" in the Environment, and if it isn't, assign the access. If it is, the space
 of the drive where the folder exists may be insufficient. Check the available space.

 99003: Failed to read the control file.
 [Explanation] The content of the file used for data generation could not be read.



 [User response] Confirm if read access is assigned to the folder specified to "Folder to create Data Editor's work
 files" and "Folder to store test case files" in the Environment, and if it isn't, assign the access.

 99004: Failed to operate the control file.
 [Explanation] The file used for data generation could not be manipulated.
 [User response] Confirm if read access is assigned to the folder specified to "Folder to create Data Editor's work
 files" and "Folder to store test case files" in the Environment, and if it isn't, assign the access.

 99005: The version of information files of format is NOT SAME.
 [Explanation] Because the version of the format information file differs, it could not be used from the operating
 Data Editor. Therefore, Data Generation screen cannot open. Also, data cannot be created.
 [User response] Rename, move or delete the format information file existing in "Folder to store test case files" in
 the Environment, then retry data generation.

 99006: The format is not set to Item. Please set the format. If you want to close the data generation screen, push
 chancel button.
 [Explanation] Although no format was specified, "OK" was clicked. No format could be created.
 [User response] When you specified a format, click "OK". When you want to complete without specifying a format,
 click "Cancel".

 99007: There are errors in the attributes.
 [Explanation] Attributes which were not selected by the generation format list cannot be specified to formats.
 [User response] Specify attributes selected by the generation format list to formats.

 99008: There are errors in the number of digits in the start value, the end value, or the increment value. Please reset
 these after confirming.
 [Explanation] A value whose digit number exceeds that of the attribute selected by the generation format list is
 specified as the start value, the end value or the increment value.
 [User response] Specify a value with a digit number less than or equal to that of the attribute selected by the
 generation format list as the start value, the end value or the increment value.

 99009: There are errors in the characters of an attribute.
 [Explanation] The attribute character specified for the format is not correct.
 [User response] Specify the attribute selected by the generation format list for the format.

 99010: The length of format exceeds the limited length which can be set as format. Please reset the format after
 checking the length.
 [Explanation] A string longer than the upper limit, 128 bytes, has been specified for the format.
 [User response] Specify a string shorter than or equal to 128 bytes for the format.

 99011: The value of fixed part exceeds the limited value which can be set in format. Please reset the format after
 checking the length of fixed part.
 [Explanation] The number of fixed parts which can be specified for the format depends on the attribute which was
 selected by the generation format list. More fixed parts than the available number has been specified.
 [User response] For the available fixed part number corresponding to the attribute selected by the generation format
 list, see the help information. Specify a value less than the fixed part number described in the help information for
 the format.

 99012: The value of variable part exceeds the limited number which can be set in format. Please reset the format
 after checking the length of variable part.
 [Explanation] The number of variable parts which can be specified for the format depends on the attribute which
 was selected by the generation format list. More variable parts than the available number has been specified.
 [User response] For the available variable part number corresponding to the attribute selected by the generation
 format list, see the help information. Specify a value less than the variable part number described in the help
 information for the format.

 99013: The number of the variable part of the start value and the variable part set in the format do not match.



 [Explanation] The number of variable parts specified for the start value is not the same as that specified for the
 format.
 [User response] Specify the same number of variable parts for the start value as that specified for the format.

 99014: The number of the variable part of the end value and the variable part set in the format do not match.
 [Explanation] The number of variable parts specified for the end value is not the same as that specified for the
 format.
 [User response] Specify the same number of variable parts for the end value as that specified for the format.

 99015: There is an error in the sign of the start value. Please reset start value.
 [Explanation] Because the attribute selected by the generation format list does not support values with signs, such
 value cannot be specified as the start value.
 [User response] Specify a value without a sign as the start value.

 99016: There is an error in the sign of the end value. Please reset end value.
 [Explanation] Because the attribute selected by the generation format list does not support values with signs, such
 value cannot be specified as the end value.
 [User response] Specify a value without a sign as the end value.

 99017: The start value, the end value, and the increment value are inconsistent.
 [Explanation] Within the range between the specified start value and end value, data increased by the specified
 value (increment value) cannot be generated.
 [User response] Change the start value and the end value so that the range becomes appropriate for the increment
 value. Or specify an increment value which is appropriate for the range determined by the start value and the end
 value.

 99018: The increment value exceeds the range which can be set. Please reset the increment value.
 [Explanation] The increment value must be -9 to 9. A value other than them has been specified.
 [User response] Specify a value within the range of -9 to 9.

 99019: The settings and the attribute of the format do not match.
 [Explanation] Values which do not correspond to the format attribute have been specified as the start value and the
 end value.
 [User response] Specify values corresponding to the format attribute as the start value and the end value. For
 available values, see the help information.

 99020: There are errors in the increment value. Please reset the increment value.
 [Explanation] Only numeric values can be specified as the increment value. The specified value is not a numeric
 value.
 [User response] Specify a value within the range of -9 to 9.

 99021: Can't set the value including decimal part as a string.
 [Explanation] When 'Character' attribute is selected by the generation format list, the digit number of the decimal
 part cannot be specified for the format.
 [User response] Specify the digit number of the integer part.

 99022: The number of digits set in the format and the length of the start value or the end value do not match. Please
 reset the start value or the end value to be suitable for the format.
 [Explanation] The length of the string specified for the start value or the end value does not match with the digit
 number of the format.
 [User response] Re-specify the start value or the end value appropriate for the format.

 99023: The attribute prohibits setting of a decimal part. Please check the start value, the end value and the increment
 value.
 [Explanation] Because 'Integer' is selected by the generation format list as the attribute or is specified as the format,
 the decimal part cannot be specified for the start value, the end value or the increment value.
 [User response] Specify an integer as the start value, the end value or the increment value. 



 99024: There is an error in the location of decimal point. Please check the start value, the end value and the
 increment value.
 [Explanation] The decimal point of the start value, the end value or the increment value is placed the starting or the
 ending of the value.
 [User response] Place the decimal point between the integer part and the decimal part of the start value, the end
 value or the increment value.

 99025: There is no value set. Please set the start value and end value as numeric.
 [Explanation] Although 'Numeric' is selected by the generation format list as the attribute or is specified as the
 format, a non-numeric value is specified as the start value or the end value.
 [User response] Specify a numeric value as the start value or the end value.

 99026: Failed to write to the file.
 [Explanation] The folders specified to "Folder to create Data Editor's work files" and "Folder to store test case files"
 in the Environment are not assigned write access.
 [User response] Specify folders with write access or assign write access to the target folders, then retry.

 99027: The capacity of a disk is insufficient.
 [Explanation] There is not available space on the disk where the folders specified to "Folder to create Data Editor's
 work files" and "Folder to store test case files" in the Environment.
 [User response] Check the available disk space, then perform retrieval again.

 99028: Failed to create the data file.
 [Explanation] Because the format information of the data to be generated does not exist in the format information
 file, the data could not be generated.
 [User response] Re-create the format information.

 99029: Selection Item and Reference Item specify the same target.
 [Explanation] The reference source and the reference target are the same.
 [User response] Change the reference target.

 99030: Can't set fixed characters in the format if the attribute is date type.
 [Explanation] When 'Date' attribute is selected by the generation format list, fixed parts cannot be specified for the
 format.
 [User response] Remove the fixed part(s) from the format.

 99031: Can't refer the data because the attribute is different.
 [Explanation] The attributes differ between the reference source and the reference target.
 [User response] Refer a target with the same attribute as the reference source.

 99032: Can't refer the data because the attribute of the sign addition is different.
 [Explanation] The setting of whether signs can be used or not differs between the reference source and the reference
 target.
 [User response] Refer a target whose setting of whether sings can be used or not is the same as the reference source.

 99033: Can't refer the data because the number of digits are too large.
 [Explanation] Because the digit number of the attribute of the reference target is larger than that of the reference
 source, data generation results in overflow and therefore reference is not possible.
 [User response] Refer a target with an attribute whose digit number is less than or equal to that of the reference
 source.

 99034: Please specify Reference Item.
 [Explanation] Although "Reference Other Item" is selected as the format, no reference target is specified.
 [User response] Specify a reference target.

 99035: There are errors in the setting of the format. Please reset the format.
 [Explanation] Variable parts and fixed parts of the format are incorrectly specified.



 [User response] Specify '% Digit Number' attribute for variable parts and information enclosed with double
 quotation marks ("") for fixed parts. For details of how to specify, see the help information.

 99036: The format is not set.
 Please set the format.
 [Explanation] Although 'Format' is selected as the type, no format is specified.
 [User response] Specify a format.

 99037: The start value is not set.
 Please set the start value.
 [Explanation] Although the format is specified, the start value is not.
 [User response] Specify the start value.

 99038: The end value is not set.
 Please set the end value.
 [Explanation] Although the format is specified, the end value is not.
 [User response] Specify the end value.

 99039: The increment value is not set.
 Please set the increment value.
 [Explanation] Although the format is specified, the increment value is not.
 [User response] Specify the increment value.

 99040: Can't set the format having sign to Item having no sign.
 [Explanation] When the attribute is 'Numeric without Sign'
 'Numeric with Sign' cannot be specified as the format.
 [User response] Select 'Numeric without Sign' as the format.

 99041: Can't set the format because there is no format including sign.
 [Explanation] Although 'Numeric with Sign' attribute is selected by the generation format list, no variable part is
 specified at the starting of the format.
 [User response] When you select 'Numeric with Sign' attribute, specify a fixed part at the starting of the format.

 99042: The name of Item was not set.
 Please set the name of Item.
 [Explanation] The name of the data conversion target is not specified.
 [User response] Specify the name of the data conversion target.

 99043: The specified Item is a Item which is not selected, is restricted or does not exist. When it is not sure what
 Item is selected, click "Browse" and select again from the list.
 [Explanation] The specified name does not exist.
 [User response] Specify an existing name.

 99044: All of the information of the format were deleted.
 Would you delete the format information file?
 [Explanation] Format attributes listed on the generation format list were all deleted. The format information file
 does not contain any information. You can delete the file on Data Generation screen. What do you do?
 [User response] When you want to delete the format information file, click "Yes". Otherwise, click "No".

 99045: Can't create the numeric data because that is out of the range which can be set. The maximum value is a
 number shown by 18 digits.
 [Explanation] The maximum digit number of values which can be generated as data is 18. Data exceeding 18 digits
 cannot be generated.
 [User response] When specifying a format for numeric values, specify such the start value, the end value and the
 increment value as do not generate data exceeding 18 digits.

 99046: Can't set the sign to the numeric data which attribute is no sign. Please reset the format after checking that



 the sign is needed or not needed.
 [Explanation] Numeric without Sign' attribute is selected for data generation. Therefore, the formats of signs cannot
 be specified.
 [User response] You need not to specify the formats of signs.

 99047: This format is already set as an example of formats.
 [Explanation] The format which you tried to add already exists in the format example list. 
 [User response] Add a format which does not exist in the format example list.

 99048: Can't delete examples of default formats.
 [Explanation] The format example list includes a fixed number of formats for reference. These formats cannot be
 deleted from the list.
 [User response] When you delete, select a format other than fixed ones.

 99049: The start value is out of the range which can be set.
 Please reset the start value.
 [Explanation] A string longer than the upper limit, 128 bytes, has been specified for the start value.
 [User response] Specify a string shorter than or equal to 128 bytes for the start value.

 99050: The end value is out of the range which can be set.
 Please reset the end value.
 [Explanation] A string longer than the upper limit, 128 bytes, has been specified for the end value.
 [User response] Specify a string shorter than or equal to 128 bytes for the end value.

 99051: Can't set the sign for the fixed characters.
 [Explanation] When 'Numeric' attribute is selected, signs cannot be used for strings in fixed parts.
 [User response] Remove the sign(s) from the string in the fixed part.

 99052: There is an error in the number of digits of the format.
 One character is necessary to store the sign when the attribute has a sign.
 Therefore the maximum number of digits is one less than the attribute length.
 [Explanation] Because the sum of the digit numbers of the variable part and the fixed part specified for the format is
 larger than the digit number of the attribute, the format cannot become effective.
 [User response] Specify such the digit numbers of the variable part and the fixed part as produce the total digit
 number less than that of the attribute. When 'Character' attribute is selected and a value with a sign is specified as a
 variable part of the format, the value of "The sum of the digit numbers of the variable part and the fixed part - The
 digit number of the sign" is considered as the total digit number.

 99053: The number of digits of the variable area in the form exceeds the limitation.
 [Explanation] When 'Character' is selected as the format, a digit number exceeding the maximum value, 5 , is
 specified for the variable part.
 [User response] Specify a digit number less than or equal to the maximum value, 5. To generate data longer than 5
 digits, specify more than one variable parts.

 99054: There are errors in the number of the digits of the DATE which is set as the start value or the end value.
 [Explanation] The digit numbers of the specified start and end values do not match with that of dates specified for
 the format.
 [User response] Specify the start value and the end value with digit numbers matching with that of dates specified
 for the format.

 99055: There are errors in the number of digits of TIME which is set as the start value or the end value. Please reset
 these time values.
 [Explanation] The digit numbers of the specified start and end values do not match with that of times specified for
 the format.
 [User response] Specify the start value and the end value with digit numbers matching with that of times specified
 for the format.



 99056: There are errors in the number of the digits of TIME AND DATE which are set as the start value or the end
 value. Please reset these date values.
 [Explanation] The digit numbers of the specified start and end values do not match with that of pairs of date and
 time specified for the format.
 [User response] Specify the start value and the end value with digit numbers matching with that of pairs of date and
 time specified for the format.

 99057: The information of making system on the file of form information are not matched.
 [Explanation] This format information file cannot be used for the operating Data Editor.
 [User response] Re-create the format information file with a different name.

 99058: The start value or the end value is out of the range which can be set.
 Please set in the range which can be set.
 [Explanation] The specified start and end values are not appropriate for generation of date and time data.
 [User response] Specify the start and the end values appropriate for generation of date and time data. For the range
 of available values, see the help information.

 99059: 0 or a value other than numeric was set. Please chack the start value and the end value.
 [Explanation] Although 'Date and Time' is selected as the format, 0 or a value other than dates and times has been
 specified as the start value or the end value.
 [User response] Specify date and time values other than 0 as the start value and the end value.

 99060: The registry key value is NOT EXIST.
 [Explanation] An error occurred while the Environment information was stored to the registry.
 [User response] The space of the drive where Windows(R)/Windows NT(R) system exists may be insufficient.
 Check the available space.

 99061: Can't get information of the registry key value.
 [Explanation] An error occurred while the Environment information was stored to the registry.
 [User response] The space of the drive where Windows(R)/Windows NT(R) system exists may be insufficient.
 Check the available space.

 99062: There is no information in the registry key.
 [Explanation] An error occurred while the Environment information was stored to the registry.
 [User response] The space of the drive where Windows(R)/Windows NT(R) system exists may be insufficient.
 Check the available space.

 99063: The area for storing the information of the registry key is insufficient.
 [Explanation] An error occurred while the Environment information was stored to the registry.
 [User response] The space of the drive where Windows(R)/Windows NT(R) system exists may be insufficient.
 Check the available space.

 99065: Can't set NULL value to Item which attribute is NOT NULL.
 Please reset the format or refer other Item.
 [Explanation] Although it is a non-NULL attribute, NULL has been specified.
 [User response] Select a format other than 'NULL'.

 99066: Item which attribute is NOT NULL is set to no format. Would you set no format? 
 Item Name: 
 [Explanation] The generation format list includes a NOT NULL attribute. Are you sure to complete without
 specifying the format?
 [User response] When you are sure to complete without specifying the format, click "Yes". Otherwise, click "No"
 and return the previous screen to specify the format. 

 99068: The error has occurred during accessing the internal information.
 Please shut this process using cancel process.
 [Explanation] An internal process error occurred due to some reason.



 [User response] Contact a Fujitsu service engineer (SE).

 99069: Can't refer Item because Item has not decimal part.
 [Explanation] When the attribute of the reference source has the decimal part, the attribute of the reference target
 must also have the decimal part.
 [User response] Specify a reference target whose attribute has the decimal part.

 99070: Difference between Item information and the format information. format information file has been deleted.
 [Explanation] The content of the format information file does not match with the attributes of the data to be
 generated.
 [User response] You need to re-create the format information file. When you want to delete the format information
 file, click "Yes". Otherwise, click "No".

 99071: The content of Item information and the content of format information are different. 
 The format information file was deleted.
 [Explanation] The content of the format information does not match with the attributes of the data to be generated.
 [User response] Confirm if there is a difference between the created format information and the attributes of the
 generatable data. When you want to close the screen, click "Cancel".

 99072: The specified Item does not exist.
 Please reset the name of Item.
 [Explanation] The specified name does not exist.
 [User response] Specify an existing name.

 99073: No number is set.
 Please check the format.
 [Explanation] Although the attribute is 'Numeric', a non-numeric value has been specified as the fixed part.
 [User response] Specify a numeric value as the fixed part.

 99074: There is no item to be used as a reference.
 [Explanation] The specified reference target does not exist.
 [User response] Specify an existing item or change the format.

 99075: There are some Item being not able to generate correct format.
 [Explanation] An attribute which is not supported for data generation is included in the format list. (Specification)
 [User response] Delete the format of the corresponding item.
 Even though it is not a correct value, data generation is possible.

 99076: Can't create the data which size exceeds 2GB. The data up to 2GB was created.
 [Explanation] The data which will be generated is larger than the maximum size (2 GB) that is ensured by Data
 Editor. (Specification).
 [User response] None

 99078: The level item information corresponding to the item does not exist.
 [Explanation] The information on the levels at which repeat is performed failed to be expanded.
 [User response] Retry. If it does not work, contact a Fujitsu service engineer (SE).

 99079: Data generation was aborted. The data file was not created.
 [Explanation] Notification message: 
 This message will be displayed when "Cancel" is clicked during the progress level D.
 [User response] None

 99101: Item failed to be registered. LWListCtrlColumnInit
 [Explanation] Notification message: 
 A column or item failed to be registered.
 [User response] None



 99102: 0 cannot be specified as the level at which repeat is performed. Specify another level.
 [Explanation] 0 cannot be specified as the level at which repeat is performed.
 [User response] Specify another level.

 99103: 0 cannot be specified as the number of repeats. Specify another number.
 [Explanation] 0 cannot be specified as the number of repeats.
 [User response] Specify another number.

 99104: Repeat is already specified for the same level. Specify another level.
 [Explanation] Repeat is already specified for the same level.
 [User response] Specify another level.

 99105: The format information has been changed. Save the change?
 [Explanation] The format information has been changed.
 [User response] Do you want to save the change?

 99106: The format information has been changed. Cancel the change?
 [Explanation] The format information has been changed.
 [User response] Do you want to cancel the change?

 99107: The format example list has been changed. To save the change, click "OK".
 [Explanation] The format example list has been changed.
 [User response] When you want to save the change, select "Yes" and click "OK" to close the dialog box.

 99108: The starting Item of the repeat is not specified. 1 must be specified as the level of the starting Item of the
 repeat.
 [Explanation] The level 1 is not specified as the level of the starting point of the repeat.
 [User response] Specify the level 1 to the starting column or item of the repeat.

 99109: The specified number of repeats is larger than the upper limit. The maximum value that can be specified as
 the number of repeats is %ld.
 [Explanation] The specified number of repeats is larger than the upper limit.
 [User response] Specify a value less than upper limit, then retry.

 99110: The number of data items which will be generated through repeat is larger than the specified number %ld
 data items will be generated. Do you want to generate data items up to the specified number?
 [Explanation] The number of data items which will be generated through repeat is larger than the specified number
 [User response] When you want to generate data items up to the specified number, click "Yes".

 99111: The target file is not assigned the required access. Contact the system administrator.
 [Explanation] The specified file path is not assigned write access.
 [User response] Ask the administrator to assign the access.

 99112: The target folder does not exist.
 [Explanation] The target folder does not exist.
 [User response] Specify an existing folder.

 99113: You do not have access to delete files created in the target folder. Ask the system administrator.
 [Explanation] You do not have access to delete files created in the target folder
 [User response] Ask the administrator to assign the access.

 99114: The target file does not exist.
 [Explanation] The target file does not exist.
 [User response] Specify an existing file.

 99115: The target file is exclusively controlled. Stop the application operating the target file, then retry.
 [Explanation] The target file is exclusively controlled.



 [User response] Stop the application operating the target file, then retry.

 99116: The target file is not assigned write access. Assign write access to the target file, then retry.
 [Explanation] The target file is not assigned write access.
 [User response] Assign write access to the target file, then retry.

 99121: The enumeration file failed to be opened.
 [Explanation] The enumeration file failed to be opened.
 [User response] Check the enumeration file, then retry.

 99122: The enumeration file failed to be read.
 [Explanation] The enumeration file failed to be read.
 [User response] Check the enumeration file, then retry.

 99123: The error output file of enumeration data failed to be opened. Stop the application opening the error output
 file, then retry.
 [Explanation] The error output file of enumeration data failed to be opened.
 [User response] Stop the application opening the error output file, then retry.

 99124: The error output file of enumeration data failed to be written.
 [Explanation] The same as above.
 [User response] None

 99125: Data longer than Item has been defined.
 [Explanation] Data longer than the column or the item of the enumeration file has been defined.
 [User response] Modify the enumeration file, then retry.

 99126: The Japanese word Item is including a non-fullwidth character.
 [Explanation] A character other than fullwidth characters has been specified for a column or an item of the
 enumeration file which has 'Japanese' attribute.
 [User response] Modify the enumeration file, then retry.

 99127: The numeric value data Item is including a non-numeric value.
 [Explanation] A value other than numeric values has been specified for a column or an item of the enumeration file
 which has 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.

 99128: The numeric value data Item is including two signs.
 [Explanation] Two signs have been specified for a column or an item of the enumeration file which has 'Numeric'
 attribute.
 [User response] Modify the enumeration file, then retry.

 99129: A sign in the middle of the numeric value data Item.
 [Explanation] A sign has been specified in the middle of a column or an item of the enumeration file which has
 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.

 99130: The numeric value Item which should not have signs is including a sign.
 [Explanation] A sign has been specified for a column or an item of the enumeration file which has 'Numeric without
 Sign' attribute.
 [User response] Modify the enumeration file, then retry.

 99131: The numeric value data Item is including two decimal points.
 [Explanation] Two decimal points have been specified in the middle of a column or an item of the enumeration file
 which has 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.



 99132: The numeric value Item is including the decimal part which should not be specified.
 [Explanation] The decimal part which should not be specified is existing in a data of the enumeration file which has
 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.

 99133: The numeric value Item is including the integer part which should not be specified.
 [Explanation] The integer part which should not be specified is existing in a data of the enumeration file which has
 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.

 99134: The numeric value Item is including the decimal part which should not be specified.
 [Explanation] The decimal part which should not be specified is existing in a data which has 'Numeric' attribute.
 [User response] Modify the enumeration file, then retry.

 99135: An error occurred while data of the enumeration file is checked. Correct the erroneous data, then retry.
 [Explanation] An error occurred while data of the enumeration file is checked.
 [User response] Correct the erroneous data, then retry.

 99136: The enumeration file does not include any data. Describe data in the enumeration file.
 [Explanation] No data is described in the enumeration file.
 [User response] Describe data in the enumeration file.

 99137: This attribute does not allow the enumeration type. Select another generation type.
 [Explanation] The enumeration type cannot be specified to this attribute.
 [User response] Select another generation type.

 99138: No enumeration file. Specify a file name.
 [Explanation] No enumeration file is specified.
 [User response] Specify a file name.



Data Generation - Formats and Setting Examples

Format specification rules

The format of data consists of a variable part and a fixed part. You can specify any number of fixed or variable parts.

Variable
 part

The variable part begins with a "%" character (percent sign), followed by the number of characters, and ends with the format
 letter.

Example: %9D

Number of characters You can specify the number of characters within the range allowed for the data item attribute. When
 more than one variable part is specified, the total number of characters must be within the range
 allowed for the data item attribute. If a fixed part is also specified, the number of characters for the
 fixed part must also be considered.

Format letter

D

Signed numbers.

 The range of specifiable values is -9 to +9.
 Up to 18 characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item)
 and the numeric type (e.g. external decimal item).

U

Unsigned numbers.

 The range of specifiable values is 0 to 9.
 Up to 18 characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item)
 and the unsigned numeric type (e.g. external decimal item).

s

 ASCII lowercase alphabetic characters.

 The range of specifiable values is a to z. If an increment is specified, it is added to the entire
 character string.
 Up to 5 characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item).

S

 ASCII uppercase alphabetic characters.

 The range of the specifiable values is A to Z. If an increment is specified, it is added to the
 entire character string.
 Up to 5 characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item).

YMD

Date (valid dates only).

 The value represents an actual date.
The range of specifiable values is 19700101 to 20380119.
 Four or two characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item).

YMA

Date (unvalidated).

 The value can be a date that may or may not actually exist.
 The range of specifiable values is 19700101 to 20380119 (it is assumed that every month has
 31 days).
 Four or two characters are allowed in the variable part.

 The specifiable item attributes include the character type (e.g. alphanumeric character item).

T

Time.

Data including hour, minute, and second specifications.
 The range of specifiable values is 000000 (0:0:0) to 235959 (23:59:59).
 The number of characters cannot be specified for the variable part.

The specifiable item attributes include the time type and the character type.

Date and time.



TS

Data including year, month, day, hour, minute, and second specifications.
 The range of specifiable values is 19700101 090000 (9:00:00, January 1, 1970) to 20380119
 031407 (3:14:7, January 19, 2038).
 The number of characters cannot be specified for the variable part.

The specifiable item attributes include the time type and the character type.

Fixed
 part

Enclose the character string in single quotation marks.

Example: '9999'

Examples of settings

       l Format: D (signed numbers)

Examples of using format D are given below.
 Example 1: To generate 100 records, having values "101" to "200", for an item defined by S9(5), specify the following:

Format %5D
Start Value +00101 (you can specify 101 instead)
End Value +00200 (you can specify 200 instead)
Increment 1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "50" to "-49", for an item defined by S9(5), specify the following:

Format %5D
Start Value +00050 (you can specify 50 instead)
End Value -00049 (you can specify -49 instead)
Increment -1
Number of
 records
 processed

100

       l Format: U (unsigned numbers)

Examples of using format U are given below.
 Example 1: To generate 100 records, having values "101" to "200", for an item defined by 9(5), specify the following:

Format %5U
Start Value 00101 (you can specify 101 instead)
End Value 00200 (you can specify 200 instead)
Increment 1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "ABCDE00001" to "ABCDE00100", for an item defined by X(10), specify the
 following:

Format 'ABCDE'%5U
Start Value 00001 (you can specify 1 instead)
End Value 00100 (you can specify 100 instead)
Increment 1
Number of
 records
 processed

100

       l Format: s (ASCII lowercase alphabetic characters)

Examples of using format s are given below.
 Example 1: To generate 100 records, having values "aaaaa" to "aaadv", for an item defined by X(5), specify the following:

Format %5s



Start Value aaaaa
End Value aaadv
Increment 1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "aaaaa10cc" to "aaadv10fx", for an item defined by X(10), specify the following: 

Format %5s'10'%2s
Start Value aaaaa,cc
End Value aaadv,zz
Increment 1
Number of
 records
 processed

100

       l Format: S (ASCII uppercase alphabetic characters)

Examples of using format S are given below.
 Example 1: To generate 100 records, having values "ZZZZZ" to "ZZZWE", for an item defined by X(5), specify the following:

Format %5S
Start Value ZZZZZ
End Value ZZZWE
Increment -1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "NoAAAAAAAA" to "NoAAADVADV", for an item defined by X(10), specify the
 following:

Format 'No'%5S%3S
Start Value AAAAA,AAA
End Value AAADV,ADV
Increment 1
Number of
 records
 processed

100

      l Format: YMD (valid dates only)

Examples of using format YMD are given below.
 Example 1: To generate 100 records, having values "20000101" to "20000410", for an item defined by X(8), specify the following:

Format %4YMD
Start Value 20000101
End Value 20000410
Increment 1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "000101" to "000410", for an item defined by X(6), specify the following:

Format %2YMD
Start Value 000101
End Value 000410
Increment 1
Number of
 records
 processed

100



       l Format: YMA (unvalidated)

Examples of using format YMA are given below.
 Example 1: To generate 100 records, having values "20000101" to "20000407" (including incorrect values as dates), for an item defined
 by X(8), specify the following:

Format %4YMA
Start Value 20000101
End Value 20000407
Increment 1
Number of
 records
 processed

100

Example 2: To generate 100 records, having values "990701" to "991007" (including incorrect values as dates), for an item defined by
 X(6), specify the following:

Format %2YMD
Start Value 990701
End Value 991007
Increment 1
Number of
 records
 processed

100

       l Format: T (time)

An example of using format T is given below.
 Example 1: To generate 100 records, having values "100001" to "100140", for an item defined by X(6), specify the following:

Format %T
Start Value 100001
End Value 100140
Increment 1
Number of
 records
 processed

100

       l Format: TS (date + time)

An example of using format TS is given below.
 Example 1: To generate 100 records, having values "20000101 100001" to "20000407 100140", for an item defined by X(8), specify the
 following:

Format %TS
Start Value 20000101 100001
End Value 20000407 100140
Increment 1
Number of
 records
 processed

100



For Initial Data File Use with Data Editor

1. When a file specified in the New Data File dialog is used with Data Editor for the first time, the Data File Setup dialog is displayed.

2. Specify each item in the dialog.

2-1. Input the COBOL Library or the layout definition file using the Specifying Format Files dialog box.

 Note:  See the Precautions with Copy Libraries

2-2. Select the organization of the data file. For existing indexed data files, it is not necessary to set "2-3" >> "2-6".

2-3. Select the record format of the data file.

2-4. Specify the record length (maximum) of the data file.

2-5.  For new indexed files and variable length records, specify the minimum record length of the data file.

    The following key information is set automatically:

2-6. For new indexed files, specify the record key information on the data file.

2-7. Select the code system of the data file.

2-8. Input a comment (optional).

3. When all the settings are completed, click the OK button. The Select Data File dialog box is displayed.

4. Specify each item in the dialog box.

4-1. When existing data is used, select the edit mode of the data file.

4-2. When existing data is used, specify the extraction condition of the data file.

4-3. When an indexed file is used, record key information can be referred to (optional).

5. When all the settings are complete, click the OK button. This displays the Record Format View (for update/add mode) or the Table Format View (for
 view mode).



For Data Files Previously Used with Data Editor

1. When a file specified in the Open Data File dialog box has previously been used with Data Editor, the Select Data File dialog is displayed.

2. The previous settings are displayed in the dialog box. To change the settings, click the Data File Setup button. The Data File Setup dialog is displayed. 
 
    The following information is input in this dialog box.

2-1. When existing data is used, select the edit mode of the data file.

2-2. When existing data is used, specify the extraction condition of the data file.

2-3. For indexed files, record key information can be referred to (optional).

3. When all of the settings have been input, click OK. This displays the Record Format View (for update/add mode) or the Table Format View (for view
 mode).



Update

You can edit the data in an existing file, and you can add, update, and delete the existing file.

View

You can view the content of the existing data file.

Add

You can add records to an existing file. When the data file is created, it is automatically set to Add mode. When Add is selected, the extraction condition
 cannot be selected.



Record Format - Supported Functions

Add and Update Mode

 The following functions are available in the Record Format View when Update/Add is selected in the Data File Edit Mode of the Select Data File dialog
 box.  When Add is selected, the default setting has only one new record.

   - Editing Data Items

   - Editing Hexadecimal

   - Editing Unicode

   - Undoing Changes

   - Inserting, Adding Records (initial value)

   - Insert/Add the Record (generate data) (Sequential/Line Sequential)

   - Copy Record (Usually)

   - Copy Record (Part is substituted for the generated data) (Sequential/Line Sequential)

   - Deleting Records

   - Restore the Deletion Record

   - Substituting the Data of One Item for Generated Data.

   - Altering Record Lengths for Variable Length Files

   - Saving Changes

   - Discarding Changes

   - Linking to Data Converter (Import)

View Mode

 The following functions are available in the Record Format View when View is selected in the Data File Edit Mode of the Select Data File dialog box.

   - Display the Hexadecimal Number Data Content (Record Format View)

   - Exit

Edit Mode Common Functions

 The following functions are available regardless of the setting of Edit mode of the data file.

   - Display a Target Record

   - Method of Setting Item

   - Linking to Data Converter (Export)

   - Setup Print Page

   - Performing Print Preview

   - Printing Files

   - Other Functions



Key operation explanation (Record Format View)

  Listed below are the basic key operations available in the Record Format View.

 Keyboard Operation

Key Name Explanation

 Enter  Accept the input data and move to the next data item

 Esc  Cancel the input data

 Tab  Move to the next data item

 Shift + Tab  Move to the previous data item

 Cursor Key Up  Move to the previous data item

 Cursor Key Down  Move to the next data item

 Cursor Key Left  Move to the left one character

 Cursor Key Right  Move to the right one character

 Insert Switch between overwrite and insert

 Delete  Delete one character

 Home  Move to the data beginning position

 End  Move to the data ending position

 Shift + Home  Select data from the beginning to the current cursor position

 Shift + End  Select data from the current cursor position to the end

Mouse Operation

Mouse Operation Explanation

Click the item data  Accept the input data and move to the clicked data item

Click the length of the
 record

 Move to the length of the record (or additional record of variable-length format)

Right Button Display the pop-up menu



Table Format - Supported Functions

Add and Update mode

 The following functions are available in the Table Format View when Update/Add is selected in the Data File Edit Mode of the Select Data File dialog
 box.  When Add is selected, the default setting has only one new record.

   - Editing Data Items

   - Editing Hexadecimal

   - Editing Unicode

   - Method of Replacing Hexadecimal Data

   - Saving Changes

   - Discarding Changes

   - Linking to Data Converter (Import)

View mode

 The following functions are available in the Table Format View when View is selected in the Data File Edit Mode of the Select Data File dialog box.

   - Displays the Hexadecimal Number Data Contents (Table Format View)

   - Exit

Edit Mode Common Functions

 The following functions are available regardless of the setting of Data File Edit Mode".

   - Linking to Data Converter (Export)

   - Setup Print Page

   - Performing Print Preview

   - Print Operations

   - Search Operation

   - Search Operation for Hexadecimal Data

   - Search for Item Name Operation

   - Other Functions



Key operation explanation (Table Format View)

 Listed below are the basic key operations available in the Table Format View.

 Keyboard Operation

Navigation between items in list; when the item has been selected:

Key Name Explanation

 Enter  Transfer to data edit mode

 Cursor Key Up  Move to the previous data item

 Cursor Key
 Down

 Move to the next data item

 Cursor Key
 Left

 Move to the previous data item

 Cursor Key
 Right

 Move to the next data item

When the item is ready to be edited:

Key Name Explanation

 Enter  Accept the data edited in the list and move to the next record in the list

 Shift + Enter  Accept the data edited in the list and move to the previous record in the list

 Tab  Accept the data edited in the list and move to the next item in the list

 Shift + Tab  Accept the data edited in the list and move to the previous item in the list

Operation in Edit control (Data Edit Region, Edit region commonality in list):

Key Name Explanation

 Enter  Accept the input data

 Esc  Cancel the input data

 Cursor Key
 Left

 Move to the left one character

 Cursor Key
 Right

 Move to the right one character

 Insert Switch between overwrite and insert

 Delete  Delete one character

 Home  Move to the data beginning position

 End  Move to the data ending position

 Shift + Home  Select data from the beginning to the current cursor position

 Shift + End  Select data from the current cursor position to the end

Mouse Operation

Mouse
 Operation

Explanation

Click the data
 item

 Accept the input data and move to the clicked data item

Right Button Display the pop-up menu
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